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KATA SAMBUTAN

Peran Guru Profesional dalam proses pembelajaran sangat penting sebagai kunci keberhasilan
belajar siswa. Guru profesional adalah guru yang kompeten membangun proses pembelajaran
yang baik sehingga dapat menghasilkan pendidikan yang berkualitas. Hal tersebut menjadikan
guru sebagai komponen yang menjadi fokus perhatian pemerintah pusat maupun pemerintah daerah
dalam peningkatan mutu pendidikan terutama menyangkut kompetensi guru.

Pengembangan profesionalitas guru melalui program Guru Pembelajar merupakan upaya
peningkatan kompetensi untuk semua guru. Sejalan dengan hal tersebut, pemetaan kompetensi  guru
telah dilakukan melalui uji kompetensi guru (UKG) untuk kompetensi pedagogik dan
profesional pada akhir tahun 2015. Hasil UKG menunjukkan peta kekuatan dan kelemahan
kompetensi guru dalam penguasaan pengetahuan. Peta kompetensi guru tersebut
dikelompokkan menjadi 10 (sepuluh) kelompok kompetensi. Tindak lanjut pelaksanaan UKG
diwujudkan dalam bentuk pelatihan guru paska UKG melalui program Guru Pembelajar.
Tujuannya untuk meningkatkan kompetensi guru sebagai agen perubahan dan sumber belajar
utama bagi peserta didik. Program Guru Pembelajar dilaksanakan melalui pola tatap muka,
daring (online), dan campuran (blended) tatap muka dengan online.

Pusat Pengembangan dan Pemberdayaan Pendidik dan Tenaga Kependidikan (PPPPTK),

Lembaga Pengembangan dan Pemberdayaan Pendidik dan Tenaga Kependidikan Kelautan
Perikanan Teknologi Informasi dan Komunikasi (LP3TK KPTK), dan Lembaga Pengembangan
dan Pemberdayaan Kepala Sekolah (LP2KS) merupakan Unit Pelaksana Teknis di lingkungan
Direktorat Jenderal Guru dan Tenaga Kependidikan yang bertanggung jawab dalam
mengembangkan perangkat dan  melaksanakan peningkatan  kompetensi  guru  sesuai
bidangnya. Adapun perangkat pembelajaran yang dikembangkan tersebut adalah modul
untuk program Guru Pembelajar tatap muka dan Guru Pembelajar daring untuk semua mata
pelajaran dan  kelompok kompetensi. Dengan modul ini diharapkan program Guru
Pembelajar memberikan sumbangan yang sangat besar dalam peningkatan kualitas kompetensi guru.

Mari kita sukseskan program Guru Pembelajar ini untuk mewujudkan Guru Mulia Karena Karya.

Jakarta, Februari2016

Sumii'r/n;;S:ui'q_ anata, Ph.D
NIP-195908011985032001
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KATA PENGANTAR

Kebijakan Kementerian Pendidikan dan Kebudayaan dalam meningkatkan kompetensi
guru secara berkelanjutan, diawali dengan pelaksanaan Uji Kompetensi Guru dan
ditindaklanjuti dengan Program Guru Pembelajar. Untuk memenuhi kebutuhan bahan
ajar kegiatan tersebut, Pusat Pengembangan dan Pemberdayaan Pendidik dan
Tenaga Kependidikan Taman Kanak-Kanak dan Pendidikan Luar Biasa (PPPPTK TK
dan PLB), telah mengembangkan Modul Guru Pembelajar Bidang Pendidikan Luar
Biasa yang merujuk pada Peraturan Menteri Pendidikan Nasional Nomor 32 Tahun
2008 tentang Standar Kualifikasi Akademik dan Kompetensi Guru Pendidikan Khusus.

Kedalaman materi dan pemetaan kompetensi dalam modul ini disusun menjadi
sepuluh kelompok kompetensi. Setiap modul meliputi pengembangan materi
kompetensi pedagogik dan profesional bagi guru Sekolah Luar Biasa. Modul
dikembangkan menjadi 5 ketunaan, vyaitu tunanetra, tunarungu, tunagrahita,
tunadaksa dan autis. Setiap modul meliputi pengembangan materi kompetensi
pedagogik dan profesional. Subtansi modul ini diharapkan dapat memberikan
referensi, motivasi, dan inspirasi bagi peserta dalam mengeksplorasi dan mendalami
kompetensi pedagogik dan profesional guru Sekolah Luar Biasa.

Kami berharap modul yang disusun ini dapat menjadi bahan rujukan utama dalam
pelaksanaan Guru Pembelajar Bidang Pendidikan Luar Biasa. Untuk pengayaan
materi, peserta disarankan untuk menggunakan referensi lain yang relevan. Kami
mengucapkan terimakasih kepada semua pihak yang telah berperan aktif dalam
penyusunan modul ini.

@“0\D|K4~0 '
71 angung, Februari 2016
5 eppla,
w T ——
Z,

S
“‘4\" Drs. Sam Yhon, M.M.
* NIP.195812061980031003
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PENDAHULUAN

A. Latar Belakang

Penilaian hasil pembelajaran adalah satu komponen utama dalam kegiatan
pembelajaran yang harus dipahami, direncanakan, dan dilaksanakan dalam
upaya mendukung keberhasilan pembelajaran.Dalam konteks kegiatan
pembelajaran, penilaian dilakukan untuk mendukung upaya peningkatan mutu
pembelajaran. Selain itu, penilaian juga direncanakan, dilaksanakan dan
dikomunikasikan sedemikian rupa sehingga menjadi motivasi bagi peserta didik

untuk meningkatkan prestasi belajarnya.

Penilaian, selain direncanakan dan dilaksanakan dengan baik, hasilnya
harus diolah dan diadministrasikan dengan cermat dan tepat oleh guru. Saat
ini, dengan kemajuan teknologi melalui bantuan program-program yang ada
di komputer, hasil penilaian dapat diolah dengan lebih mudah dan lebih

cermat.

Namun menurut berbagai penelitian, penggunaan Teknologi Informasi dan
Komunikasi (TIK) masih menjadi isu dan masalah bagi guru di Indonesia,
masih banyak guru di Indonesia yang belum menguasai TIK. Kemudahan-
kemudahan yang ada pada fasilitas TIK belum bisa digunakan oleh guru
untuk mebantu tugasnya, salah satunya membantu kegiatan penilaian. Untuk
itu melalui modul ini akan dijelaskan tentang TIK dan penggunaannya dalam

pembelajaran terutama dalam membantu penilaian.

Modul ini terdiri dari dua bagian yaitu yang membahas kompetensi
pedagogik mengenai pemanfaatan penilaian dan evaluasi hasil belajar, serta
kompetensi professional mengenai penggunaan perangkat lunak. Modul ini
terdiri atas 7 (tujuh) materi pokok danuntuk masing-masing materi pokok,
akan disajikan aktivitas pembelajaran, latihan, rangkuman, serta tindak

lanjutnya.

PPPPTK TK DAN PLB BANDUNG
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B. Tujuan

Secara umum tujuan yang diharapkan dicapai pada diklat ini pada
kompetensi pedagogis adalah memahami bagaimana memanfaatkan hasil
penilaian dan evaluasi untuk perbaikan pembelajaran. Sedangkan pada
kompetensi profesional tujuan yang diharapkan adalah guru dapat
menggunakan Teknologi Informasi dan Komunikasi untuk membantu
kegiatan pembelajaran dalam rangka pengembangan diri dan
profesionalisme mereka.

Secara lebih spesifik tujuan yang diharapkan setelah mengikuti diklat ini
adalah Anda dapat:
1. memahami bagaimana memanfaatkan hasil penilaian dan evaluasi untuk
perbaikan pembelajaran.
menyusun perencanaan pembelajaran remedial dan pengayaan.
menyusun laporan hasil pencapaian kompetensi peserta didik.
memahami pengoperasian komputer dengan menggunakan Operating
System Windows 7
memanfaatkan program perangkat lunak pengolah kata
menggunakan perangkat lunak pengolah presentasi

memanfaatkan program pengolah angka dalam penilaian

. Peta Kompetensi
Standar Kompetensi Guru Kelas SDLB/MILB

1. Kompetensi Pedagogik

No. | Kompetensi Inti Kompetensi

9. Memanfaatkan hasil 9.1 Menggunakan informasi hasil
penilaian dan evaluasi untuk penilaian dan evaluasi untuk
kepentingan pembelajaran menentukan ketuntasan belajar

9.2 Menggunakan informasi hasil
penilaian dan evaluasi untuk

merancang program remedial

PPPPTK TK DAN PLB BANDUNG
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dan pengayaan

9.3 Mengkomunikasikan hasil
penilaian dan evaluasi kepada

pemangku kepentingan

9.4 Memanfaatkan informasi hasil
penilaian dan evaluasi
pembelajaran untuk
meningkatkan kualitas

pembelajaran

2. Kompetensi Profesional

No. | Kompetensi Inti

Kompetensi

24. | Memanfaatkan teknologi
informasi dan komunikasi
untuk berkomunikasi dan

mengembangkan diri

24.2 Memanfaatkan teknologi
informasi dan komunikasi

untuk berkomunikasi
24.2 Memanfaatkan teknologi

informasi dan komunikasi

untuk pengembangan diri.

D. Ruang Lingkup

1. Pemanfaatan Hasil Penilaian dan Evaluasi

a. Penilaian Hasil Belajar oleh Pendidik

b. Pentingnya Memanfaatkan Hasil Penilaian dan Evaluasi

c. Manfaat Hasil Penilaian dan Evaluasi

2. Program Pembelajaran Remedial dan Pengayaan:

a. Program Pembelajaran Remedial

b. Program Pembelajaran Pengayaan

3. Laporan Hasil Pencapaian Kompetensi Peserta Didik

a. Pengolahan Hasil Capaian

b. Penyusunan Laporan Hasil Pencapaian Kompetensi

4. Pengoperasian komputer dengan Sistem Operasi Windows 7;

PPPPTK TK DAN PLB BANDUNG
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a. Konsep Sistem Operasi Komputer

b. Macam-macam Sistem Operasi
c. Dasar-dasar Penggunaan Windows 7

5. Penggunaan Perangkat Lunak Pengolah Kata;

a. Konsep Dasar Pengolah Kata

b. Pengoperasian MS Word 2010

c. Pengenalan Bagian-bagian MS Word 2010

d. Pembuatan Dokumen dengan MS Word 2010
e. Format Dokumen dengan MS Word 2010

6. Penggunaan Perangkat Lunak Pengolah Presentasi;

a. Langkah-langkah menjalankan MS PowerPoint 2010
b. Bagian-bagian pada MS PowerPoint 2010
c. Prinsip-Prinsip dalam Pembuatan Dokumen Presentasi

d. Latihan Pembuatan Dokumen Presentasi

7. Penggunaan Perangkat Lunak Pengolah Angka;

a. Dasar-dasar MS Excel 2010
b. Teknik Penggunaan MS Excel 2010

E. Cara Penggunaan Modul

1. Bacalah terlebih dahulu judul modul dan daftar isi modul yang akan Anda

pelajari. Tujuannya ialah agar Anda mengetahui modul apa yang akan
Anda baca dan pokok-pokok materi yang terdapat di dalam modul
tersebut.

Bacalah petunjuk penggunaan modul serta bagian Pendahuluan sebelum
masuk pada pembahasan materi pokok.

Pelajarilah modul ini secara bertahap dimulai dari kegiatan pembelajaran
1 sampai tuntas, termasuk di dalamnya latihan dan evaluasi sebelum
melangkah ke materi pokok berikutnya.

Lakukanlah berbagai latihan sesuai dengan petunjuk yang disajikan pada
masing-masing materi pokok. Demikian pula dengan kegiatan evaluasi
dan tindak lanjutnya. Disarankan tidak melihat kunci jawaban terlebih
dahulu agar evaluasi yang dilakukan dapat mengukur tingkat penguasaan

peserta terhadap materi yang disajikan.
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5. Catatlah semua kesulitan Anda dalam mempelajari modul ini untuk

ditanyakan pada fasilitator/instruktur pada saat tatap muka. Bacalah
referensi lain yang ada hubungannya dengan materi modul ini agar Anda

mendapatkan pengetahuan tambahan.
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KEGIATAN PEMBELAJARAN 1
PEMANFAATAN HASIL PENILAIAN DAN EVALUASI

A. Tujuan
Setelah mempelajari kegiatan pembelajaranl, diharapkan Anda dapat
memahami bagaimana memanfaatkan hasil penilaian dan evaluasi untuk

perbaikan pembelajaran.

B. Indikator Pencapaian Kompetensi
Setelah mempelajari kegiatan pembelajaranl, diharapkan Anda dapat:
1. Menjelaskan fungsi penilaian hasil belajar
2. Menjelaskan penetapan kriteria ketuntasan minimal
3. Menjelaskan manfaat hasil penilaian dan evaluasi evaluasi.
4

Menjelaskan bagaimana melakukan refleksi pelaksanaan evaluasi.

C. Uraian Materi

1. Penilaian Hasil Belajar oleh Pendidik

a. Pengertian
Penilaian Hasil Belajar oleh Pendidik adalah proses pengumpulan
informasi/bukti tentang capaian pembelajaran peserta didik dalam
kompetensi sikap spiritual dan sikap sosial, kompetensi pengetahuan,
dan kompetensi keterampilan yang dilakukan secara terencana dan
sistematis, selama dan setelah proses pembelajaran.Penilaian Hasil
Belajar oleh pendidik memiliki fungsi untuk memantau kemajuan
belajar, memantau hasil belajar, dan mendeteksi kebutuhan perbaikan

hasil belajar peserta didik secara berkesinambungan.

b. Fungsi
Berdasarkan fungsinya, penilaian hasil belajar oleh pendidik meliputi:
1) formatif yaitu memperbaiki kekurangan hasil belajar peserta didik

dalam sikap, pengetahuan, dan keterampilan pada setiap kegiatan
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penilaian selama proses pembelajaran dalam satu semester,
sesuai dengan prinsip Kurikulum 2013 agar peserta didik tahu,
mampu dan mau. Hasil dari kajian terhadap kekurangan peserta
didik digunakan untuk memberikan pembelajaran remedial dan
perbaikan RPP serta proses pembelajaran yang dikembangkan
guru untuk pertemuan berikutnya; dan

2) sumatif yaitu menentukan keberhasilan belajar peserta didik pada
akhir semester, satu tahun pembelajaran, atau masa pendidikan di
satuan pendidikan. Hasil dari penentuan keberhasilan ini
digunakan untuk menentukan nilai rapor, kenaikan kelas dan

keberhasilan belajar satuan pendidikan seorang peserta didik.

Tujuan

Tujuan penilaian hasil belajar oleh pendidik adalah sebagai berikur:

1) Mengetahui tingkat penguasaan kompetensi dalam sikap,
pengetahuan, dan keterampilan yang sudah dan belum dikuasai
seorang/sekelompok peserta didik untuk ditingkatkan dalam
pembelajaran remedial dan program pengayaan.

2) Menetapkan ketuntasan penguasaan kompetensi belajar peserta
didik dalam kurun waktu tertentu, yaitu harian, tengah semesteran,
satu semesteran, satu tahunan, dan masa studi satuan
pendidikan.

3) Menetapkan program perbaikan atau pengayaan berdasarkan
tingkat penguasaan kompetensi bagi mereka yang diidentifikasi
sebagai peserta didik yang lambat atau cepat dalam belajar dan
pencapaian hasil belajar.

4) Memperbaiki proses pembelajaran pada semester berikutnya.
Karakteristik Penilaian
Penilaian dalam Kurikulum Pendidikan Khusus 2013 memiliki

karakteristik sebagai berikut:

1) Belajar Tuntas

| | PPPPTK TK DAN PLB BANDUNG
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2)

3)

4)

5)

Asumsi yang digunakan dalam belajar tuntas adalah peserta didik

dapat mencapai kompetensi yang ditentukan, asalkan peserta
didik mendapat bantuan yang tepat dan diberi waktu sesuai
dengan yang dibutuhkan. Peserta didik yang belajar lambat perlu
diberi waktu lebih lama untuk materi yang sama, dibandingkan
peserta didik pada umumnya. Untuk kompetensi pengetahuan dan
keterampilan (KI-3 dan Kl-4), peserta didik tidak diperkenankan
mengerjakan pekerjaan atau kompetensi berikutnya, sebelum
mampu menyelesaikan pekerjaan dengan prosedur yang benar
dan hasil yang baik.

Autentik

Memandang penilaian dan pembelajaran sebagai dua hal yang
saling berkaitan.Penilaian Autentik harus mencerminkan masalah
dunia nyata, bukan dunia sekolah. Menggunakan berbagai cara
dan kriteria holistik (kompetensi utuh merefleksikan pengetahuan,
keterampilan, dan sikap). Penilaian Autentik tidak hanya
mengukur apa yang diketahui oleh peserta didik, tetapi lebih
menekankan mengukur apa yang dapat dilakukan oleh peserta
didik.

Berkesinambungan

Penilaian berkesinambungan dimaksudkan sebagai penilaian
yang dilakukan secara terus menerus dan berkelanjutan selama
pembelajaran  berlangsung.Tujuannya adalah untuk
mendapatkan gambaran yang utuh mengenai perkembangan
hasil belajar peserta didik, memantau proses, kemajuan, dan
perbaikan hasil terus menerus dalam bentuk penilaian proses,
dan berbagai jenis ulangan secara berkelanjutan (ulangan
harian, ulangan tengah semester, ulangan akhir semester, atau
ulangan kenaikan kelas).

Menggunakan teknik penilaian yang bervariasi

Teknik penilaian yang dipilih dapat berupa tertulis, lesan, produk,

portofolio, unjuk kerja, projek, pengamatan, dan penilaian diri.

Berdasarkan acuan kriteria
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Penilaian hasil belajar oleh pendidik menggunakan  Acuan
Kriteria yang  merupakan penilaian kemajuan peserta didik
dibandingkan dengan kriteria capaian kompetensi (KCK) yang
ditetapkan. Skor yang diperoleh dari hasilsuatu penilaian baik
yang formatif maupun sumatif seorang peserta didiktidak
dibandingkan dengan skor peserta didik lainnya namun
dibandingkan dengan penguasaan kompetensi yang
dipersyaratkan, hal ini dijelaskan dalam Permendikbud Nomor 104
Tahun 2014. Bagi yang belum berhasil mencapai kriteria, diberi
kesempatan mengikuti pembelajaran remedial yang dilakukan
setelah suatu kegiatan penilaian (bukan di akhir semester) baik
secara individual, kelompok, maupun kelas. Bagi mereka yang
berhasil dapat diberi program pengayaan sesuai dengan waktu
yang tersedia baik secara individual maupun kelompok. Program
pengayaan merupakan pendalaman atau perluasan dari
kompetensi yang dipelajari.

Peserta didik yang berdasarkan hasil asesmen tidak mampu
menggunakan kurikulum standar pendidikan khusus, dapat
menggunakan program pembelajaran individual (PPI). Kriterianya

ditetapkan secara individual sesuai karakteristik peserta didik.

e. Prinsip

Prinsip Penilaian Hasil Belajar oleh Pendidik meliputi prinsip umum

dan prinsip khusus. Prinsip umum dalam Penilaian Hasil Belajar oleh

Pendidik adalah sebagai berikut.

1)

2)

3)

Sahih, berarti penilaian didasarkan pada data yang mencerminkan
kemampuan yang diukur.

Objektif, berarti penilaian didasarkan pada prosedur dan kriteria
yang jelas, tidak dipengaruhi subjektivitas penilai.

Adil, berarti penilaian tidak menguntungkan atau merugikan
peserta didik karena berkebutuhan khusus serta perbedaan latar
belakang agama, suku, budaya, adat istiadat, status sosial

ekonomi, dan gender.
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4)

5)

6)

7

8)

9)

Terpadu, berarti penilaian oleh pendidik merupakan salah satu
komponen yang tak terpisahkan dari kegiatan pembelajaran.
Terbuka, berarti prosedur penilaian, kriteria penilaian, dan dasar
pengambilan keputusan dapat diketahui oleh pihak yang
berkepentingan.

Holistik dan berkesinambungan, berarti penilaian oleh pendidik
mencakup semua aspek kompetensi dan dengan menggunakan
berbagai teknik penilaian yang sesuai dengan kompetensi yang
harus dikuasai peserta didik.

Sistematis, berarti penilaian dilakukan secara berencana dan
bertahap dengan mengikuti langkah-langkah baku.

Akuntabel, berarti penilaian dapat dipertanggungjawabkan, baik
dari segi teknik, prosedur, maupun hasilnya.

Edukatif, berarti penilaian dilakukan untuk kepentingan dan

kemajuan peserta didik dalam belajar.

Prinsip khusus dalam Penilaian Hasil Belajar oleh Pendidik berisikan

prinsip-prinsip Penilaian Autentik sebagai berikut.

1)
2)
3)
4)
5)
6)
7

8)
9)

Materi penilaian dikembangkan dari kurikulum.

Bersifat lintas muatan atau mata pelajaran.

Berkaitan dengan kemampuan peserta didik.

Berbasis kinerja peserta didik.

Memotivasi belajar peserta didik.

Menekankan pada kegiatan dan pengalaman belajar peserta didik.
Memberi kebebasan peserta didik untuk mengkonstruksi
responnya.

Menekankan keterpaduan sikap, pengetahuan, dan keterampilan.

Mengembangkan kemampuan berpikir divergen.

10) Menjadi bagian yang tidak terpisahkan dari pembelajaran.

11) Menghendaki umpan balik yang segera dan terus menerus.

12) Menekankan konteks yang mencerminkan dunia nyata.

13) Terkait dengan dunia kerja.

14) Menggunakan data yang diperoleh langsung dari dunia nyata.

15) Menggunakan berbagai cara dan instrumen.
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Kriteria Ketuntasan Minimal

Ketuntasan Belajar terdiri atas ketuntasan penguasaan substansi dan
ketuntasan belajar dalam konteks kurun waktu belajar. Ketuntasan
penguasaan substansi yaitu ketuntasan belajar KD yang merupakan
tingkat penguasaan peserta didik atas KD tertentu pada tingkat
penguasaan minimal atau di atasnya, sedangkan ketuntasan belajar
dalam konteks kurun waktu belajar terdiri atas ketuntasan dalam

setiap semester, setiap tahun ajaran, dan tingkat satuan pendidikan.

Ketuntasan Belajar dalam satu semester adalah keberhasilan peserta
didik menguasai kompetensi dari sejumlah mata pelajaran yang
diikutinya dalam satu semester. Ketuntasan Belajar dalam setiap
tahun ajaran adalah keberhasilan peserta didik pada semester ganijil
dan genap dalam satu tahun ajaran. Ketuntasan dalam tingkat satuan
pendidikan adalah keberhasilan peserta didik menguasai kompetensi
seluruh mata pelajaran dalam suatu satuan pendidikan untuk

menentukan kelulusan peserta didik dari satuan pendidikan.

KKMditetapkan dengan mempertimbangkan tingkat kemampuan rata-
rata peserta didik, kompleksitas kompetensi, serta kemampuan
sumber daya pendukung meliputi warga sekolah, sarana dan
prasarana dalam penyelenggaraan pembelajaran. Satuan pendidikan
diharapkan meningkatkan kriteria ketuntasan belajar secara terus

menerus untuk mencapai kriteria ketuntasan ideal.

Pentingnya Memanfaatkan Hasil Penilaian dan Evaluasi

Salah satu manfaat hasil penilaian dan evaluasi adalah untuk
memberikan umpan balik (feedback) kepada semua pihak yang terlibat
dalam pembelajaran, baik secara langsung maupun tidak langsung.
Menurut QCA (2003, dalam Arifin, 2010:285) “feedback is the mean by
whichh teachers enable children to close the gap in order to take

learning forward and improve children’s performance.” Umpan balik
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dapat dijadikan sebagai alat bagi guru untuk membantu peserta didik

agar kegiatan belajarnya menjadi lebih baik dan meningkatkan
prestasinya. Peserta didik akan dapat mengukur sejauh mana tingkat
penguasaannya terhadap materi, jika hasil pekerjaan mereka mendapat
umpan balik dari gurunya. Umpan balik tersebut dapat dilakukan secara

langsung, tertulis, atau demonstrasi.

Ketika seorang pendidik memberikan umpan baik, hendaknya
memperhatikan  kualitas pekerjaan peserta didik dan tidak
membandingkannya dengan hasil pekerjaan peserta didik lainnya.
Karena ketika pendidik membanding-bandingkan maka peserta didik
yang memiliki kemampuan kurang akan merasa terkecilkan. Umpan
balik seharusnya memberikan saran dan perbaikan sehingga dapat
memotivasi peserta didik untuk memperbaiki dan meningkatkan kualitas

proses belajar serta hasil pekerjaannya.

Crook (2001, dalam Arifin, 2010:285) menyimpulkan bahwa agar umpan

balik dapat bermanfaat untuk memotivasi peserta didik, maka harus

difokuskan pada:

a.

Kualitas pekerjaan peserta didik dan bukan membandingkannya
dengan hasil pekerjaan peserta didik yang lain.

Cara-cara yang spesifik sehingga pekerjaan peserta didik dapat
ditingkatkan.

Peningkatan pekerjaan peserta didik yang harus dibandingkan

dengan pekerjaan sebelumnya.

Apa yang dikemukakan oleh Crooks di atas, lebih menekankan pada

kualitas pekerjaan peserta didik sebagai faktor utama dalam menentukan

jenis umpan balik yang diberikan, bukan membandingkan hasil pekerjaan

peserta didik yang satu dengan lainnya. Sehubungan dengan hal

tersebut, ada enam prinsip yang harus diperhatikan dalam memberikan

umpan balik, yaitu:
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Umpan balik harus fokus pada tugas-tugas yang sesuai dengan
tujuan pembelajaran, dan bukan membandingkan dengan anak yang
lain.

Guru menggunakan bahasa verbal dan non-verbal serta memberikan
pesan yang baik pada peserta didik tentang kemampuan yang
mereka peroleh.

Penilaian setiap bagian pekerjaan dapat mengarah pada penurunan
moril bagi peserta didik yang mencapai prestasi rendah dan kepuasan
bagi peserta didik yang mencapai prestasi tinggi.

Peserta didik perlu diberi kesempatan untuk meningkatkan kualitas

pekerjaan

Berikut ini akan dipaparkan beberapa manfaat hasil penilaian dan

evaluasi dalam hubungannya dengan pembelajaran, yaitu:

a. Untuk Perbaikan Rencana Pelaksanaan Pembelajaran

Perencanaan merupakan bagian yang sangat penting dalam
melaksanakan kegiatan pembelajaran. Rencana Pelaksanaan
Pembelajaran (RPP) ini sekaligus menjadi pedoman dan panduan
bagi pendidik dalam melaksanakan kegiatan pembelajaran. Hasil
belajar peserta didik dipengaruhi oleh berbagai faktor, salah satu di
antaranya adalah perencanaan pembelajaran. Namun RPP saja
tidaklah cukup karena selain itu masih diperlukan kesungguhan
pendidik untuk mengorganisasi RPP, melaksanakan pembelajaran,

dan melakukan evaluasi pembelajaran.

RPP berperan sebagai skenario proses pembelajaran yang akan
dilaksanakan oleh pendidik sehingga harus disusun secara fleksibel
dan memungkinkan guru untuk melakukan penyesuaian-penyesuaian
dengan kondisi yang ditemukan saat proses pembelajaran. Kekeliruan
pada tahap perencanaan akan mengakibatkan kekeliruan dalam
melaksanakan pembelajaran. Jika pada evaluasi sudah dapat
diidentifikasi kesalahannya, maka guru dapat berupaya untuk mencatri

solusi memperbaiki RPP tersebut.
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Memperbaiki RPP dapat dilakukan dengan jalan memeriksa

kelengkapan komponen-komponennya, kesesuaian antarkomponen,
kemungkinan proses pelaksanaan, apakah indikator dapat diukur,
apakan indikator sudah sesuai dengan kompetensi dasar, apakan
metode, media dan sumber belajar serta teknik penilaian yang dipilih
sudah tepat. Untuk memeriksa kelengkapan komponen RPP, dapat
merujuk ke Permendikbud Nomor 103 Tahun 2014 tentang
Pelaksanaan Pembelajaran yang di dalamnya termuat komponen
RPP. Komponen RPP yang ada dalam Permendikbud adalah standar
minimal, artinya jika diperlukan guru dapat menambahkan

komponennya, tetapi jangan mengurangi yang sudah ditetapkan.

Untuk Mengoptimalkan Proses Pembelajaran

Ada beberapa cara yang dapat dilakukan oleh guru agar proses
pembelajaran berjalan optimal. Yang pertama adalah dengan
melakukan evaluasi diri. Evaluasi diri terhadap semua aspek
pembelajaran harus dilakukan oleh guru dengan teliti dan jujur. Kedua
adalah dengan mengidentifikasi adakah faktor-faktor penyebab
kegagalan dan keberhasilan pembelajaran. Melalui kedua cara
tersebut di atas guru dapat menindaklanjuti dengan menyusun
rancangan baik itu rancangan pembelajaran individual, maupun
rancangan pembelajaran remedial. Dengan kata lain, dengan
melakukan pembelajaran remedial dan pengayaan, diharapkan

proses pembelajaran dapat berjalan dengan lebih optimal.

Julian C. Stanley (1964, dalam Arifin, 2010: 287) menyatakan, “just
what is to be done, of course, depends on the purpose of the
program.” Artinya bahwa pemanfaatan hasil evaluasi akan sangat
tergantung pada tujuan evaluasi. Sementara itu, Hamalik (1989,
dalam Arifin, 2010:288) menyebutkan bahwa “penggunaan hasil
evaluasi dapat mengacu pada fungsi evaluasi itu sendiri, yaitu fungsi
instruktisonal,  fungsi  administratif, dan fungsi bimbingan.”
Dalamkonteks fungsi instruksional, guru dapat menggunakan hasil

evaluasi untuk memperbaiki sistem pembelajaran. Begitu juga dalam
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fungsi administratif, guru dapat membuat laporan perkembangan
pencapaian kompetensi peserta didik. Dalam fungsi bimbingan, guru
dapat memberikan bimbingan kepada peserta didik yang mengalami
kesulitan dalam belajar.

Evaluasi formatif  bertujuan untuk  memperbaiki kegiatan
pembelajaran. Perbaikan tersebut dilakukan atas dasar hasil
monitoring kemajuan belajar peserta didik. Hasil monitoring ini dapat
dimanfaatkan sebagai umpan balik baik bagi guru maupun peserta
didik untuk mengetahui materi mana yang sudah dikuasai dengan
baik dan materi mana yang masih memerlukan pengulangan atau
pendalaman. Hasil evaluasi formatif juga dapat dimanfaatkan untuk
mereview pelajaran, memperbaiki strategi pembelajaran yang
digunakan, atau memantapkan guru untuk melanjutkan pembelajaran.
Sementara, evaluasi sumatif bertujuan untuk memberikan nilai
sebagai dasar untuk menentukan apakah peserta didik dapat naik

kelas atau lulus dari jenjang satuan pendidikan.

3. Manfaat Hasil Penilaian dan Evaluasi

Pada umumnya guru memanfaatkan hasil evaluasi hanya untuk mengisi

buku rapor dan laporan kepada orangtua peserta didik. Jika demikian,

berarti guru kurang atau tidak memahami pemanfaatan hasil evaluasi

secara menyeluruh. Sebenarnya, guru dapat meninjau pemanfaatan hasil

evaluasi dari berbagai pihak yang berkepentingan, yaitu:

a. Bagi peserta didik

Bagi perserta didik, hasil evaluasi dapat dimanfaatkan untuk:

1) Membangkitkan minat dan motivasi belajar. Hal ini dapat
dilakukan jika peserta didik mengetahui hasil evaluasi yang
dicapainya,  mengetahui  kekurangan-kekurangannya  dan
bagaimana solusinya.

2) Membentuk sikap positif terhadap mata pelajaran, juga sikap
positif terhadap guru, proses pembelajaran, lingkungan dan

evaluasi pembelajaran.

| | PPPPTK TK DAN PLB BANDUNG

© 2016




3)
4)

5)

Membantu pemahaman peserta didik menjadi lebih baik.

Membantu peserta didik dalam memilih metode dan teknik belajar
yang baik dan benar. Hasil evaluasi dapat digunakan oleh peserta
didik untuk mengetahui apakan teknik atau cara belajar yang
digunakan selama ini sudah baik atau belum. Misalnya melakukan
kegiatan belajar hanya saat akan ujian, atau mengerjakan tugas
dengan menyalin hasil pekerjaan teman, dan sebagainya. Teknik
belajar seperti ini dapat merugikan peserta didik, baik fisik maupun
mental yang pada gilirannya dapat mempengaruhi prestasi
belajar.

Mengetahui kedudukan peserta didik dibandingkan terhadap

standar atau kompetensi yang harus dicapainya.

Bagi guru

Bagi guru, hasil evaluasi dapat dimanfaatkan untuk:

1)
2)

3)

4)

5)

6)

7

Promosi peserta didik, seperti kenaikan kelas atau kelulusan.
Mendiagnosis peserta didik yang memiliki kelemahan atau
kekurangan, baik secara perseorangan maupun kelompok.
Menentukan pengelompokan dan penempatan peserta didik
berdasarkan pencapaian masing-masing.

Umpan balik dalam melakukan perbaikan terhadap sistem
pembelajaran.

Menyusun laporan kepada orangtua guna menjelaskan
pertumbuhan dan perkembangan peserta didik. Hal ini
dimaksudkan agar orangtua mengetahui sejauhmana kemajuan
dan prestasi yang dicapai oleh peserta didik.

Dijadikan dasar pertimbangan dalam membuat perencanaan
pembelajaran.

Menentukan perlu tidaknya pembelajaran remedial dan

pengayaan.

Bagi orangtua

Bagi orangtua, hasil evaluasi dapat dimanfaatkan untuk:

1)

Mengetahui kemajuan belajar peserta didik.
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2) Membimbing kegiatan belajar peserta didik di rumabh.

3) Menentukan tindak lanjut pendidikan yang sesuai dengan
kemampuan anaknya. Memperkirakan kemungkinan berhasil
tidaknya anak tersebut dalam bidang pekerjaannya.

d. Bagi administrator sekolah
1) Menentukan penempatan peserta didik.

2) Menentukan kenaikan kelas atau kelulusan.

D. Aktivitas Pembelajaran

Setelah membaca materi yang ada pada kegiatan pembelajaran 1, buatlah
tabel yang berisi komponen apa saja yang harus diamati saat melakukan
evaluasi pembelajaran. Lakukan refleksi diri, apakah langkah-langkah
evaluasi pembelajaranyang selama ini dilakukan sudah tepat? Lalu

bagaimana Anda memanfaatkan hasil evaluasi pembelajaran selama ini?

. Latihan/Kasus/Tugas

Pilihlah jawaban yang benar dengan cara memberi tanda silang (X) pada

huruf A, B, C, atau D yang mewakili jawaban yang paling benar!

1. Penilaian hasil belajar oleh pendidik dilakukan ....

A. sesudah proses pembelajaran berlangsung

B. sebelum dan sesudah proses pembelajaran berlangsung
C. selama dan sesudah proses pembelajaran berlangsung
D

. sebelum, selama dan sesudah proses pembelajaran berlangsung

2. Penilaian hasil belajar menggunakan Penilaian Acuan Kriteria, hal ini
berarti bahwa kedudukan relatif peserta didik dibandingkan dengan....
A. Kriteria Ketuntasan Minimal
B. peserta didik lain di dalam kelompok
C. peserta didik lain di dalam kelas
D

. standar yang telah ditetapkan
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3. Penilaian yang bertujuan untuk memperbaiki proses pembelajaran

adalah....

A. penilaian harian
B. penilaian formatif
C. penilaian sumatif

D. penilaian sikap

4. Ketika ada peserta didik yang menunjukkan sikap kurang baik maka
langkah yang dilakukan guru adalah melakukan....
A. remedial
B. pengayaan
C. pembinaan
D

. kegiatan latihan

5. Kiriteria Ketuntasan Minimal di sekolah luar biasa didasarkan kepada....
A. kemampuan dasar anak, kompleksitas, daya dukung
B. kemampuan dasar anak, harapan orangtua, dan kompleksitas
C. kemampuan dasar anak, kedalaman materi, dan harapan masyarakat
D

. harapan anak, kemampuan dasar anak, dan kedalaman materi

F. Rangkuman

1. Penilaian Hasil Belajar oleh Pendidik adalah proses pengumpulan
informasi/bukti tentang capaian pembelajaran peserta didik dalam
kompetensi sikap spiritual dan sikap sosial, kompetensi pengetahuan,
dan kompetensi keterampilan yang dilakukan secara terencana dan
sistematis, selama dan setelah proses pembelajaran.

2. Penilaian Hasil Belajar oleh pendidik memiliki fungsi untuk memantau
kemajuan belajar, memantau hasil belajar, dan mendeteksi kebutuhan
perbaikan hasil belajar peserta didik secara berkesinambungan.

3. Kriteria Ketuntasan Minimal (KKM) ditetapkan dengan memperhatikan

kemampuan rata-rata siswa, kompleksitas dan daya dukung.
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4. Hasil penilaian dan evaluasi dapat digunakan untuk memperbaiki
rencana pelaksanaan pembelajaran dan mengoptimalkan proses
pembelajaran.

5. Hasil penilaian dan evaluasi dapat memberikan manfaat pada peserta
didik, guru, orangtua dan administrator sekolah.

G. Umpan Balik dan Tindak Lanjut

Cocokkanlah jawaban Anda dengan kunci jawaban yang terdapat di bagian
akhir modul ini.Hitunglah jawaban Anda yang benar,kemudian gunakan
rumus di bawah ini untuk mengetahui tingkat penguasaan Anda terhadap

materi kegiatan belajar ini.

Jumlah jawaban Anda yang benar
X
5

Tingkat Penguasaan =

Arti tingkat penguasaan yang Anda capai:
90 — 100 % = Baik sekali

80 — 89 % = Baik

70 — 79 % = Cukup

<70 % = Kurang

Apabila tingkat penguasaan Anda mencapai 80% ke atas, bagus! Anda
cukup memahami kegiatan belajar ini. Anda dapat meneruskan dengan
kegiatan belajar berikutnya. Tetapi bila tingkat penguasaan Anda masih di
bawah 80%, Anda harus mengulangi kegiatan belajar ini, terutama bagian

yang belum Anda kuasai.
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KEGIATAN PEMBELAJARAN 2

PEMBELAJARAN REMEDIAL DAN PENGAYAAN

A. Tujuan

Setelah mempelajari kegiatan pembelajaran2,diharapkan Anda dapatmenyusun

perencanaan pembelajaran remedial dan pengayaan.

. Indikator Pencapaian Kompetensi

Setelah mempelajari kegiatan pembelajaran2, diharapkan Anda dapat:

1. Menjelaskan pengertian pembelajaran remedial

2. Menjelaskan pengertian pembelajaran pengayaan

3. Menjelaskan langkah-langkah penyusunan pembelajaran remedial dan
pengayaan

4. Menyusun program pembelajaran remedial dan pengayaan.

. Uraian Materi

Dalam Peraturan Menteri Pendidikan dan Kebudayaan No. 66 Tahun 2013 tentang
Standar Penilaian, setiap pendidik hendaknya memperhatikan prinsip perbedaan
individu (kemampuan awal, kecerdasan, kepribadian, bakat, potensi, minat, motivasi
belajar, gaya belajar). Dalam pembelajaran akan ditemukan peserta didik yang lebih
lambat dan lebih cepat dalam menguasai target kompetensi yang ditetapkan.
Pembelajaran Remedial dan Pengayaan merupakan tindak lanjut guru terhadap
penilaian proses dan hasil belajar peserta didik. Jika dari hasil penilaian diperoleh
informasi bahwa kompetensi dasar yang manjadi target belum dicapai oleh peserta
didik, maka kompetensi tersebut harus dituntaskan terlebih dahulu sebelum
melangkah pada kompetensi berikutnya. Demikian pula sebaliknya. Jika peserta
didik menunjukkan pencapaian yang melebihi target maka peserta didik dapat

mengikuti program pengayaan untuk memperluas wawasan dan pemahaman.

Pembelajaran remedial dan pengayaan harus mempertimbangkan dengan cermat

perbedaan individual peserta didik. Dalam hal ini, prinsip ketuntasan belajar

PPPPTK TK DAN PLB BANDUNG
© 2016




memungkinkan peserta didik mencapai kompetensi yang sama, sekalipun

memerlukan waktu yang berbeda. Peserta didik yang belajar lebih lambat
memerlukan waktu lebih lama untuk menguasai materi yang sama dibandingkan
peserta didik pada umumnya. Untuk peserta didik yang lambat, diperlukan langkah-
langkah dan pemberian materi serta penanganan yang berbeda dengan peserta
didik yang cepat. Peserta didik yang lebih cepat belajar juga perlu penanganan

dalam bentuk pengayaan sehingga memenuhi prinsip keadilan.

Penentuan apakah seorang peserta didik termasuk ke dalam kategori normal,
lambat, atau cepat dalam pembelajaran adalah berdasarkan pada kecepatan
penguasaan suatu kompetensi yang tertuang dalam satu subpokok bahasan.
Apabila di akhir pembelajaran subpokok bahasan peserta didik mampu menguasai
kompetensi yang jadi target pada subpokok bahasan tersebut, maka peserta didik
tersebut termasuk kategori normal. Apabila di akhir subpokok bahasan tertentu
ternyata belum mampu menguasai kompetensi yang ditetapkan, maka peserta didik
tersebut termasuk kategori mengalami hambatan dalam belajar sehingga
memerlukan program pembelajaran remedial. Sebaliknya apabila seseorang
peserta didik ternyata lebih cepat menguasai suatu kompetensi pada satu subpokok
bahasan tertentu sebelum subpokok bahasan tersebut berakhir maka peserta didik
tersebut perlu diberikan program pengayaan dan atau pendalaman untuk memenuhi

tuntutan kecepatan belajarnya.

Implikasi terhadap kecepatan penguasaan kompetensi peserta didik pada suatu

subpokok bahasan tertentu tersebut tertuang pada diagram berikut:
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Diberi materi tambahan

Lebih cepat yang lebih menantang
dalam

penguasan
kompetensi

Diarahkan mengikuti
pendidikan inklusi

Kecepatan
penguasaan
kompetensi

Peserta Didik

Sama
dengan RPP
(Normal)

Pembelajaran normal sesuai
dengan Buku Siswa

Diberi pembelajaran
tambahan untuk materi yang
sama
Lebih lambat
dalam Dijelaskan dengan cara

penguasaan berbeda
kompetensi

Dapat dilaksanakan untuk
kelas di bawahnya

Diagram 2. 1Skema Implikasi Kecepatan Penguasaan Kompetensi Peserta Didik
Dalam Belajar
(Sumber: Direktorat PKLK, 2015)

1. Program Pembelajaran Remedial

a. Pengertian
Menurut Sobri (2009: 164), pembelajaran remedial adalah suatu bentuk
pembelajaran yang bersifat menyembuhkan atau membetulkan supaya
menjadi lebih baik. Proses pembelajaran ini bersifat lebih khusus karena
disesuaikan dengan jenis dan sifat kesulitan belajar yang dihadapi siswa.
Proses bantuan lebih ditekankan pada usaha perbaikan cara-cara belajar,
cara membelajarkan, penyesuaian materi pelajaran, perbaikan segala
hambatan yang dihadapi. Dalam pedoman teknis yang dikeluarkan oleh
Direktorat PKLK disebutkan bahwa program pembelajaran remedial adalah
program pembelajaran yang diberikan kepada peserta didik yang belum

mencapai kompetensi minimalnya dalam satu kompetensi dasar
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tertentu.Dengan demikian dapat disimpulkan bahwa pembelajaran remedial

pada hakikatnya adalah pemberian bantuan bagi peserta didik yang
mengalami kesulitan atau kelambatan belajar. Pemberian pembelajaran
remedial meliputi dua langkah pokok, yaitu mendiagnosis kesulitan belajar

dan memberikan perlakuan(treatment) pembelajaran remedial.

Penting untuk dipahami bahwa remedial bukan mengulang tes (ulangan
harian) dengan materi yang sama, tetapi guru memberikan perbaikan
pembelajaran pada kompetensi yang belum dikuasai oleh peserta didik
melalui upaya tertentu. Setelah perbaikan pembelajaran dilakukan, guru
melakukan penilaian ulang untuk mengetahui apakah peserta didik telah

memenuhi kompetensi minimal yang telah ditetapkan.

Prinsip-prinsip Program Remedial

Prinsip yang perlu diperhatikan dalam pembelajaran remedial sesuai dengan

sifatnya sebagai pelayanan khusus antara lain:

1) Adaptif;pembelajaran remedial hendaknya memungkinkan peserta didik
untuk belajar sesuai dengan daya tangkap, kesempatan, dan gaya belajar

masing-masing.

2) Interaktif; pembelajaran remedial hendaknya melibatkan keaktifan guru
untuk secara intensif berinteraksi dengan peserta didik dan selalu
memberikan monitoring dan pengawasan agar mengetahui kemajuan

belajar peserta didiknya.
3) Fleksibilitas dalam metode pembelajaran dan penilaian

Pembelajaran remedial perlu menggunakan berbagai metode
pembelajaran dan metode penilaian yang sesuai dengan karakteristik

peserta didik.
4) Pemberian umpan balik sesegera mungkin

Umpan balik berupa informasi yang diberikan kepada peserta didik
mengenai kemajuan belajarnya perlu diberikan sesegera mungkin agar

dapat menghindari kekeliruan belajar yang berlarut-larut.
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5) Pelayanan sepanjang waktu

Pembelajaran remedial dilakukan secara berkesinambungan dan harus

selalu tersedia programnya agar

setiap saat peserta didik dapat

mengaksesnya sesuai dengan keperluannya masing-masing.

c. Langkah-langkah Pembelajaran Remedial

Identifikasi Permasalahan

Pembelajaran

Melakukan Perencanaan

v
Pelaksanaan Remedial

A

B

C

Permasalahan
pada Keunikan
Peserta Didik

Permasalahan
pada Materi Ajar
(KD)

Permasalahan
pada Strategi
Pembelajaran

Dilakukan dalam jam

Belajar Efektif

Dilakukan di Luar Jam

Belajar Efektif

Menyesuaikan
dengan
keunikan
Peserta Didik

Menyiapkan
alternatif
contoh?2 terkait
materi ajar

Menyesuaian
Strategi
Pembelajaran

v

Identifikasi Keberhasilan

Identifikasi Keberhasilan

Diagram 2. 2Skema Prosedur Pembelajaran Remedial
(Sumber: Direktorat PKLK, 2015)

1) Identifikasi Permasalahan Pembelajaran

Penting untuk memahami bahwa “tidak ada dua individu yang persis
sama di dunia ini”, begitu juga penting untuk memahamibahwapeserta
didik pun memiliki beragam variasi baik kemampuan,kepribadian, tipe

dan gaya belajar maupun latar belakang sosial-budaya.Oleh

karenanya guru perlu melakukanidentifikasi terhadap keseluruhan

permasalahan pembelajaran.

Secara umum identifikasi awal dapat dilakukan melalui:
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a)
b)
c)

Observasi selama proses pembelajaran

Penilaian autentik

Wawancara

Permasalahan pembelajaran dapat dikategorikan ke dalam tiga fokus

perhatian:

a)

b)

Permasalahan pada keunikan peserta didik

(1) Keberagaman individu dapat membedakan hasil belajar dan
permasalahan belajar pada peserta didik.Ada peserta didik yang
cenderung lebih aktif dan senang praktik secara langsung, ada yang
cenderung mengamati, ada yang lebih tenang dan suka membaca.Di
kelas, guru juga perlu memiliki wawasan lebih menyeluruh mengenai
latar belakang keluarga dan sosial budaya.Peserta didik yang
dibesarkan dalam keluarga pedagang, tentu memiliki keterampilan
berbeda dengan keluarga petani atau nelayan.

(2) Peserta didik yang berasal dari keluarga yang terpecah (tidak
harmonis), mungkin berbeda dengan peserta didik yang berasal

dari keluarga harmonis dan mendukung kegiatan belajar.

Permasalahan pada materi ajar

Rancangan pembelajaran telah disiapkan dalam buku guru dan buku
siswa. Pada praktiknya, tidak semua yang disajikan dalam materi ajar,
sesuai dengan kompetensi peserta didik. Guru bisa saja menemukan
bahwa materi ajar (KD) yang disajikan dalam buku terlalu tinggi bagi
peserta didik tertentu disebabkan keunikan peserta didik. Oleh karena
itu perlu disiapkan berbagai alternatif contoh aktivitas pembelajaran
yang dapat digunakan guru untuk mengatasi permasalahan
pembelajaran (contoh dan alternatif aktivitas untuk siswa yang merasa
kesulitan terhadap materi ajardapat dilihat dalam buku “Panduan

Teknis Penggunaan Buku Guru dan Siswa”)

Permasalahan pada strategi pembelajaran
Dalam proses pembelajaran, guru sebaiknya tidak hanya terpaku

pada satu strategi atau metode pembelajaran saja, karena tipe dan
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gaya belajar peserta didik sangat bervariasi termasuk juga minat dan

bakatnya, sehingga guru perlu mengidentifikasi apakah kesulitan
peserta didik dalam menguasai materi disebabkan oleh strategi atau
metode belajar yang kurang sesuai.

2) Perencanaan Remedial

Setelah melakukan identifikasi awal terhadap permasalahan belajar
peserta didik, berarti guru telah memperoleh pengetahuan yang utuh
tentang peserta didik dan mulai untuk membuat perencanaan.Dengan
melihat bentuk kebutuhan dan tingkat kesulitan yang dialami peserta
didik, guru akan dapat merencanakan kapan waktu dan cara yang tepat

untuk melakukan pembelajaran remedial.

Pembelajaran remedial dapat dilakukan:

a) Didalam jam belajar efektif atau terintegrasi dalam pembelajaran.
Segera setelah guru mengidentifikasi kesulitan peserta didik dalam
proses pembelajaran guru dapat secepatnya mengambil tindakan
untuk memberikan pembelajaran remedial untuk peserta didik yang
teridentifikasi dan pelaksanaannya terintegrasi dalam proses
pembelajaran. Strategi yang di gunakan meliputi diskusi kelompok,

tanya jawab, dan tutor sebaya.

b) Menetapkan waktu khusus di luar jam belajar efektif.
Dalam perencanaaan guru perlu menyiapkan hal-hal yang mungkin
diperlukan dalam pelaksanaan pembelajaran remedial, seperti:
(1) Menyiapkan media pembelajaran
(2) Menyiapkan contoh-contoh dan alternatif aktivitas
(3) Menyiapkan materi-materi dan alat pendukung
Pembelajaran Remedial di luar jam pelajaran ini dapat melibatkan

orang tua di rumah.

3) Pelaksanaan Remedial

Setelah perencanaan disusun, langkah selanjutnya adalah melaksanakan

program pembelajaran remedial sesuai dengan perencanaan remedial
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4)

yang telah dibuat. Pelaksanaan remedial dapat dilakukan secara

individual, kelompok, maupun klasikal.

a) Remedial secara individual dilakukan jika hasil penilaian dalam satu
rombongan belajar, menunjukkan satu atau beberapa orang peserta
didik (biasanya tidak lebih dari 15% dari jumlah peserta didik di
kelasnya) mengalami kesulitan terhadap materi atau KD dalam
subtema tertentu (biasanya ditunjukkan dalam pencapaian KD yang
kurang dari KKM), atau menunjukkan perilaku khas yang perlu
penanganan secara individual.

b) Remedial yang dilakukan secara kelompok didasarkan pada
pertimbangan bahwa sejumlah peserta didik dalam satu rombongan
belajar menunjukkan kesulitan yang relatif sama pada materi atau KD
dalam subtema tertentu.

c) Remedial secara klasikal dilakukan jika sebagian besar atau sekitar

75% siswa mengalami kesulitan.

Beberapa metode pembelajaran yang dapat digunakan dalam
pelaksanaan pembelajaran remedial yaitu: pembelajaran individual,
pemberian tugas, diskusi, tanya jawab, kerja kelompok, dan tutor
sebaya.Aktivitas guru dalam pembelajaran remedial, antara lain:
memberikan tambahan penjelasan atau contoh, menggunakan strategi
pembelajaran yang berbeda dengan sebelumnya, mengkaji ulang

pembelajaran yang lalu, menggunakan berbagai jenis media.

Dalam pelaksanaannya, berdasarkan hasil identifikasi
permalasalahannya, strategi pembelajaran remedial ditekankan pada: (1)
keunikan peserta didik, (2) alternatif contoh dan aktivitas terkait materi
ajar, dan (3) strategi/metode pembelajaran. Pembelajaran remedial dapat
dilakukan secara terintegrasi dalampembelajaran,dilakukanbersamaan

dengan kegiatan pembelajaran, atau dilakukan di luar jam pelajaran.

Identifikasi Keberhasilan
Identifikasi keberhasilan dilakukan setelah pembelajaran remedial

selesaidilaksanakan. Bila peserta didik belum mencapai kompetensi
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minimal (tujuan) yang ditetapkan guru, maka guru perlu meninjau kembali

strategi pembelajaran remedial yang diterapkannya atau melakukan
identifikasi (analisa kebutuhan) terhadap peserta didik dengan lebih
seksama dan kemudian melaksanakan pembelajaran remedial lagi.
Program pembelajaran remedial dilaksanakan sampai peserta didik
menguasai kompetensi dasar yang diharapkan (tujuan tercapai). Ketika
peserta didik telah mencapai kompetensi minimalnya (setelah program
pembelajaran remedial dilakukan), maka pembelajaran remedial tidak

perlu dilanjutkan.

Apabila ternyata ditemukan kasus khusus di luar kompetensi guru, guru
dapat menkonsultasikan dengan orang tua untuk selanjutnya dilakukan

konsultasi dengan ahli.

Dalam program pembelajaran remedial guru akan membantu peserta didik,
untuk memahami kesulitan belajar yang dihadapinya, mengatasi kesulitannya
tersebut dengan memperbaiki cara belajar dan sikap belajar yang dapat

mendorong tercapainya hasil belajar yang optimal.

. Contoh Rancangan Pelaksanaan Remedial

Contoh I: Pembelajaran Remedial Terkait Dengan Keunikan Peserta Didik.

Identifikasi :

Hasil penilaian di kelas | SDLB Tunanetra tema Diriku, subtema 1. Aku dan
Teman Baru dengan indikator muatan pelajaran Kompetensi Dasar
Matematika adalah 1) Menunjukkan berbagai bentuk bangun datar yang ada
di sekolah, 2) Membuat bentuk baru dengan cara menyusun berbagai
bangun datar, menunjukkan satu orang peserta didik belum dapat
menunjukkan bangun datar yang ada di sekolah dan belum mampu
menggambar dan cara menyusunnya. Melalui hasil identifikasi awal
(observasi selama proses pembelajaran dan pengujian sederhana terhadap

indera penglihatan peserta didik), guru menemukan bahwa peserta didik
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tersebut memiliki jarak penglihatan yang terbatas serta sulit dalam mengenali

bentuk yang dilihatnya.

Berdasarkan contoh kasus di atas, maka pembelajaran remedial yang dapat
dilakukan tidak hanya difokuskan pada substansi materi yang tidak dikuasai
peserta didik, akan tetapi dalam pelaksanaannya, guru dapat melakukan
pendekatan pribadi, memberikan motivasi terkait dengan kondisi penglihatan
peserta didik, serta penanganan yang mungkin berbeda dengan siswa lain
yang memiliki kesulitan substansi yang sama. Di samping itu, guru
melakukan komunikasi dengan orangtua berkenaan dengan masalah yang
dihadapi siswa, serta upaya-upaya yang sebaiknya dilakukan orangtua

berkenaan dengan masalah keterbatasan penglihatan anaknya.

Sementara itu, untuk Pembelajaran Remedial pada indikator yang terdeteksi,

guru dapat merancang rencana sebagai berikut.

Kon;z::nsi Indikator Pelaksanaan Remedial
3.2 Mengenal 3.2.1Menunjukkan | Metode :
bangun datar berbagai Melakukan penjelasan ulang dan
dan bangun bentuk memberikan contoh-contoh yang
ruang bangun datar | lebih kongkrit yang ada di sekitar
menggunakan yang ada di anak dengan pendekatan keunikan
benda-benda sekolah individu (menyentuh, meraba,
yang ada di membentuk).
sekitar rumah, [3.2.2Membuat Perencanaan :
sekolah, atau bentuk baru Dilakukan di luar jam belajar
tempat dengan cara | efektif.
bermain. menyusun Menyiapkan media dan alat
berbagai pendukung.
bangun datar. | Proses Pelaksanaan:
¢ Guru memulai pembelajaran
dengan mengajak peserta didik
bermain bentuk dengan bantuan
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Kompetensi

Dasar

Indikator

Pelaksanaan Remedial

tanah liat atau plastisin.

Setelah peserta didik merasa
nyaman dan terlibat dengan
kegiatan, kemudian guru masuk
ke dalam materi ajar (bangun
datar).

Langkah selanjutnya,guru
memberikan penjelasan ulang
dengan jarak yang lebih dekat
dan menggunakan benda-benda
disekitar yang berbentuk bangun
datar (segiempat-segitiga-
lingkaran, dan bentuk-bentuk
bangun datar lainnya).

Peserta didik dapat menyentuh,
meraba dan melihat dari jarak
dekat benda bangun datar
sambil guru menjelaskan ulang
akan konsep bangun datar agar
peserta didik dapat
memahaminya dengan lebih
baik.

Guru meminta peserta didik
untuk membuat gambar bangun-
bangun datar tersebut, mulai
dari bangun datar yang
sederhana (lingkaran) sampai
yang lebih kompleks (segi lima).
Membantu peserta didik
menamakan bentuk-bentuk
bangun datar yang dibuatnya.
Peserta didik membuat bentuk

bangun datar dengan
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Kompetensi

Dasar

Indikator

Pelaksanaan Remedial

menggunakan alat bantu
lidi/lkawat lentur, dan

sebagainya.

Penilaian:

e Guru melakukan identifikasi

keberhasilan secara langsung
terhadap pemahaman peserta
didik, selama pelaksanaan
pembelajaran remedial dengan
menanyakan:

“Apa yang tadi kita lakukan?”
“Apa saja yang telah digambar
olehmu”

“Jadi apakah nama-nama
bangun datar ini?”
“Bagaimana ciri-cirinya?”
“Sebutkan benda-benda di
sekitarmu yang bentuknya

segitiga?”

Apabila peserta didik berhasil
memenuhi kompetensi yang
diharapkan, beri penguatan: non
verbal (senyuman, acungan
jempol, tepuk tangan), verbal
(“bagus”, “hebat”) atau
pemberian reward (benda-
benda yang menyenangkan bagi
peserta didik atau benda seperti
pensil,dil).

Guru melakukan penilaian

melalui tes/ulangan terkait




Kompetensi :
> Indikator Pelaksanaan Remedial

Dasar

dengan materi.

Contoh lIPembelajaran Remedial Terkait Dengan
Strategi/MetodePembelajaran

Identifikasi :

Setelah melakukan analisis hasil ulangan harian siswa kelas IV SDLB
Tunarungu pada tema Hidup Bersih dan Sehat, subtema Hidup Bersih dan
Sehat di Rumah, dengan indikator muatan pelajaran pada Kompetensi Bahasa
Indonesia: 1) Mengidentifikasi berbagai kegiatan di lingkungan sekitar, 2)
Menulis cerita narasi sederhana tentang kegiatan di lingkungan sekitar dengan
EYD yang benar, serta observasi selama proses pembelajaran, guru
menemukan bahwa peserta didik belum dapat fokus dalam kegiatan dan tidak
dapat menjelaskan dalam bentuk tulisan tentang kegiatan di lingkungan sekitar
sehingga dalam kegiatan pembelajaran di kelas peserta didik cenderung

mengganggu, tidak terlibat dalam kegiatan sehingga tidak memahami materi.

Berdasarkan permasalahan tersebut, guru dapat membuat rencana

pembelajaran remedial sebagai berikut.

KompetensiDasar Indikator Pelaksanaan Remedial

3.2 Mengenal teks 3.2.1Mengidentifikasi | Strategi:
cerita narasi berbagai Aktivitas di luar kelas,
sederhana kegiatan di secara berkelompok
kegiatan dan lingkungan
bermain di sekitar Perencanaan:
lingkungan 3.2.2Menulis cerita Dilakukan di luar jam
dengan bantuan narasi pelajaran efektif.
guru atau teman sederhana
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Pelaksanaan Remedial

KompetensiDasar Indikator
dalam bahasa tentang Guru menyiapkan media
lisan dan tulis kegiatan di pendukung terkait materi
yang dapat diisi lingkungan pembelajaran kreatif dan
dengan kosa kata sekitar dengan merencanakan aktivitas di
bahasa daerah EYD yang benar | luar kelas.

untuk membantu

pemahaman Pelaksanaan:

¢ Peserta didik diajak untuk
keluar kelas melihat-lihat
kegiatan yang ada sambil
bermain.

e Guru mengajak peserta
didik untuk menceritakan
apa yang dilihatnya dan
apa yang dirasakannya.
Apa saja kegiatan-
kegiatan yang dilihatnya,
dan pernahkah peserta
didik melakukannya.

e Guru memberikan
motivasi atau memancing
peserta didik agar dapt
menceritakan apa yang
dilihat dan dirasakan,
mendorong anak agar
selalu bertanya.

e Guru menyiapkan
beberapa gambar tentang
kegiatan lingkungan
sekitar, peserta didik
disuruh menceritakan

kepada temannya.

e Guru menyiapkan lembar
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KompetensiDasar

Indikator

Pelaksanaan Remedial

kertas untuk peserta didik
supaya menulis cerita
tentang kegiatan yang
dilihatnya.

e Guru memberikan
bimbingan kepada
peserta didik tentang
cerita narasi sederhana
kegiatanlingkungan

sekitar.

Penilaian:

e Peserta didik diminta
untuk membacakan cerita
narasi tentang kegiatan
lingkungan sekitar.

¢ Apabila peserta didik
berhasil memenuhi
kompetensi yang
diharapkan, memberi
penguatan: non verbal
(senyuman, acungan
jempol, tepuk tangan),
verbal (“bagus”, “hebat”)
atau pemberian reward
(benda-benda yang
menyenangkan bagi
peserta didik atau benda
seperti permen,
pensil,dll).

e Peserta didik juga
dijelaskan kembali

bagaimana cara
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KompetensiDasar Indikator Pelaksanaan Remedial

menuliskan cerita narasi
hasil pengamatan.

e Guru melakukan
penilaian melalui
tes/ulangan terkait

dengan materi.

Contoh Il

Pembelajaran Remedial Terkait Keunikan Peserta Didik

Identifikasi :

Setelah melakukan analisis hasil ulangan harian siswa kelas IV SDLB Tunarungu
pada tema Hidup Bersih dan Sehat, subtema “Hidup Bersih dan Sehat di
Rumah,” dengan indikator muatan pelajaran pada Kompetensi Dasar PPKn: (1)
Menyebutkan beberapa aturan yang berlaku dalam kehidupan sehari-hari di
rumah, serta observasi selama proses pembelajaran, guru menemukan bahwa
ada peserta didik yang selalu minta diulang-ulang dalam pembelajaran. Guru

menilai peserta didik ini kurang mampu dalam membaca bibir (lip reading).

KompetensiDasar Indikator Pelaksanaan Remedial
3.2 Memahami 3.2.1Menyebutkan | Strategi:
tata tertib dan beberapa Diskusi atau percakapan setelah
aturan yang aturan yang mengamati gambar tentang kegiatan
berlaku dalam berlaku dalam | di rumah atau tata tertib, tentang
kehidupan kehidupan aturan-aturan yang berlaku di rumah.
sehari-hari di sehari-hari di | Perencanaan:
rumah dan rumah. Dilakukan langsung saat proses
sekolah. pembelajaran. Dengan mengadakan
percakapan.
Guru menyiapkan media-media
gambar dan tata tertib.
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KompetensiDasar Indikator Pelaksanaan Remedial

Seluruh peserta didik ikut terlibat.

Pelaksanaan:

e Kegiatan mengamati gambar
tentang kegiatan di rumah atau tata
tertib di kelas.

e Setelah itu guru memancing
peserta untuk mengadakan
percakapan. Gunakan bahasa
Indonesia yang baik tapi tidak
terkesan formal atau menggurui.

e Guru mendekati secara individu
pada peserta didik agar
memperhatikan ujaran lawan
bicaranya.

¢ Ajak seluruh peserta didik untuk
ikut terlibat dalam percakapan.

¢ Diakhir percakapan lakukan refleksi
tentang aturan yang berlaku dalam
kehidupan sehari-hari.

¢ Pada saat pembelajaran, guru
mengadakan observasi dengan
menggunakan skala sikap (K1 dan
K2) .

Penilaian:

e Guru mengajukan  pertanyaan-
pertanyaan lisan yang lebih bersifat
refleksi hasil percakapan seperti,
“Siapakah yang harus dihormati
kalau kamu di rumah?”

“Apa yang kamu kerjakan bila kamu
melihat halaman rumah kotor?”

e Untuk selanjutnya guru dapat
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KompetensiDasar Indikator

Pelaksanaan Remedial

melihat perilaku-perilaku peserta
didik dalam kehidupan sehari-

harinya.

2. Program Pembelajaran Pengayaan

a. Pengertian

Dalam kurikulum dirumuskan secara jelas Kompetensi Inti (KI) dan
Kompetensi Dasar (KD) yang harus dikuasai peserta didik sesuai dengan
alokasi waktu yang sudah ditentukan. Penguasaan Kl dan KD setiap peserta
didik diukur dengan menggunakan sistem Penilaian Acuan Kriteria (PAK).
Jika seorang peserta didik mencapai standar tertentu maka peserta didik
tersebut dipandang telah mencapai ketuntasan. Oleh karena itu program
pengayaan dapat diartikan sebagai kegiatan tambahan yang diberikan
kepada peserta didik yang telah mencapai ketentuan dalam belajar yang
dimaksudkan untuk menambah wawasan atau memperluas pengetahuannya
dalam materi pelajaran yang telah dipelajarinya. Disamping itu pembelajaran
pengayaan bisa diartikan memberikan pemahaman yang lebih dalam

daripada tuntutan yang ada dalam kurikulum

Lalu mengapa diperlukan program pengayaan?Kurikulum 2013 Sekolah
Dasar menganut sistem pembelajaran berbasis aktivitas atau kegiatan,
sistem pembelajaran tuntas serta memperhatikan dan melayani perbedaan
individual peserta didik.Dengan memperhatikan prinsip perbedaan individu
(kemampuan awal, kecerdasan, kepribadian, bakat, potensi, minat, motivasi
belajar, gaya belajar) tersebut, maka program pengayaan dilakukan untuk

memenuhi kebutuhan/hak anak.

Kegiatan pengayaan dilaksanakan dengan tujuan memberikan kesempatan
kepada siswa untuk memperdalam penguasaan materi pelajaran yang

berkaitan dengan materi pelajaran yang sudah dipelajari dan yang akan
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dipelajarii sehingga tercapai tingkat perkembangan yang optimal sesuai

dengan kemampuannya.

Metode yang digunakan bervariasi sesuai dengan bahan kajian, muatan
pelajaran yang dipelajari peserta didik. Dalam program pengayaan, media
belajar harus betul-betul disiapkan guru agar dapat memfasilitasi peserta
didik untuk memperkaya pengetahuan, melatih keterampilan dan membentuk

sikap yang baik

Guru melakukan program pengayaan sesuai dengan bahan kajian, muatan
pelajaran yang sedang dipelajari, seperti membaca materi diikuti dengan
menulis laporan, melakukan percobaan dan menjadi tutor sebaya bagi teman
yang memerlukan pembelajaran remedial.Guru mengembangkan latihan
praktis dari materi yang sedang dibahas, membuat hasil karya, melakukan
suatu proyek, membahas masalah, atau mengerjakan permainan yang harus
diselesaikan siswa. Apapun kegiatan yang dipilih guru, hendaknya kegiatan
pengayaan tersebut menyenangkandanmengembangkan kemampuan

peserta didik.

. Jenis-jenis Program Pengayaan

1) Kegiatan eksploratoriyang masih terkait dengan KD yang sedang
dilaksanakan yang dirancang untuk disajikan kepada peserta didik. Sajian
yang dimaksud contohnya: dapat berupa peristiwa sejarah, buku,
narasumber, penemuan, uji coba, yang secara regular tidak tercakup
dalam kurikulum.

2) Keterampilan proses yang diperlukan oleh peserta didik agar berhasil
dalam melakukan pendalaman dan investigasi terhadap topik yang
diminati dalam bentuk pembelajaran mandiri.

3) Pemecahan masalah yang diberikan kepada peserta didik yang memiliki
kemampuan belajar lebih tinggi berupa pemecahan masalah nyata
dengan menggunakan pembelajaranpemecahan masalah, penemuan,
proyek dan penelitian ilmiah.

Pemecahan masalah ditandai dengan:

(a) Identifikasi bidang permasalahan yang akan dikerjakan;
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C.

(b) Penentuan fokus masalah/problem yang akan dipecahkan;

(c) Penggunaan berbagai sumber;

(d) Pengumpulan data menggunakan teknik yang relevan;
(e) Analisis data;

() Penyimpulan hasil investigasi.

Prinsip-prinsip Program Pengayaan

Prinsip-prinsip yang perlu diperhatikan dalam merencanakan program

pengayaan menurut Khatena (1992, dalam Direktorat PKLK, 2015):

1)

2)

3)

Inovasi

Guru perlu menyesuaikan program yang diterapkannya dengan kekhasan
peserta didik, karakteristik kelas serta lingkungan hidup dan budaya
peserta didik.

Kegiatan yang memperkaya

Dalam menyusun materi dan mendisain pembelajaran pengayaan,
kembangkan dengan kegiatan yang menyenangkan, membangkitkan
minat, merangsang pertanyaan, dan sumber-sumber yang bervariasi dan
memperkaya.

Merencanakan metodologi yang luas dan metode yang lebih bervariasi
Misalnya dengan memberikan project, pengembangan minat dan
aktivitas-akitivitas menggugah (playful).Menerapkan informasi terbaru,

hasil-hasil penelitian atau kemajuan program-program pendidikan terkini.

Passow (1993, dalam Direktorat PKLK, 2015) menyarankan bahwa dalam

merancang program pengayaan, penting untuk memperhatikan tiga hal, yaitu:

1)

Keluasan dan kedalaman dari pendekatan yang digunakan. Pendekatan
dan materi yang diberikan tidak hanya berisi yang luarnya (kulit-kulitnya)
saja tetapi diberikan dengan lebih menyeluruh dan lebih mendalam.
Contoh: membahas mengenai prinsip Phytagoras, tidak hanya
memberikan rumus dan pemecahan soal saja tetapi juga memberikan
pemahaman yang luas dari mulai sejarah terbentuknya hukum-hukum
Phytagoras dan bagaimana penerapan prinsip tersebut dalam kehidupan

sehari-hari.
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2) Tempo dan kecepatan dalam membawakan program.

Sesuaikan cara pemberian materi dengan tempo dan kecepatan peserta
didik dalam menangkap materi yang diajarkan. Hal ini berkaitan dengan
kecepatan daya tangkap yang dimiliki peserta didik sehingga materi dapat
diberikan dengan lebih mendalam dan lebih dinamis. Hal ini untuk
menghindari kebosanan karena peserta didik yang telah menguasai

materi pelajaran yang diberikan di kelas.

3) Memperhatikan isi dan tujuan dari materi yang diberikan

Hal ini bertujuan agar kurikulum yang dirancang lebih tepat guna dan
responsif terhadap kebutuhan peserta didik. Renzulli menyatakan bahwa
program pengayaan berbeda dengan program akselerasi karena
pengayaan dirancang dengan lebih memperhatikan keunikan dan

kebutuhan individual dari peserta didik.

d. Langkah-langkah Program Pengayaan

Identifikasi Awal

Melakukan Perencanaan :

Pelaksanaan Pengayaan:

Penilaian autentik

Identifikasi Minat dan Gaya
Belajar Peserta Didik

Penekanan pada Penekanan Penekanan
KI'l dan KI 2 pada Kl 3 pada Kl 4

Dilaksanakan dalam pembelajaran sesuai
perencanaan dengan memperhatikan gaya dan
minat belajar

Penilaian Autentik

Diagram 2. 3Skema Prosedur Pembelajaran Pengayaan
(Sumber: Direktorat PKLK, 2015)
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Langkah-langkah dalam program pengayaan diawali dengan kegiatan

identifikasi, kemudian perencanaan, dan pelaksanaan. Guru tidak perlu
menunggu diperolehnya penilaian autentik terhadap kemampuan peserta
didik. Apabila melalui observasi dalam proses pembelajaran, peserta didik
sudah terindikasi memiliki kemampuan yang lebih dari teman lainya, dapat
ditandai dengan penguasaan materi yang cepat dan membutuhkan waktu
yang lebih singkat sehingga peserta didik seringkali memiliki waktu sisa yang
lebih banyak, dibutuhkan kepekaan guru dalam merencanakan dan

memutuskan untuk melaksanakan program pengayaan.

Guru diharapkan lebih peka dalam mengenali peserta didik yang memiliki
karakteristik ini, dikarenakan mereka memiliki kebutuhan yang juga berbeda

dibandingkan dengan teman-temannya.

1) Identifikasi Awal
Sebelum pengayaan diberikan, guru harus melakukan identifikasi awal
terhadap minat dan gaya belajar peserta didik yang bersangkutan. Halini
dimaksudkan agar pengayaan diberikan dengan tepat sehingga peserta

didik merasa senang dengan program pengayaan yang diberikan.

2) Perencanaan Pengayaan
Setelah identifikasi awal dilakukan guru membuat perencanaan sesuai
dengan minat dan gaya belajar anak. Hal-hal yang perlu disiapkan dalam
perencanaan adalah alternatif kegiatan apa yang akan diberikan untuk
dilakukan peserta didik. Guru menentukan berdasarkan kebutuhan
pengayaan anak, apakah aktivitas yang dipilih penekanannya pada K1
dan K2, K3 atau K4. Penentuan fokusini dapat pula ditentukan dengan
berdiskusi atau menanyakan pada peserta didik yang bersangkutan. Guru
harus selalu menyiapkan program pengayaan dengan menyiapkan materi

pengayaan danalat atau perangkat pendukung aktivitas pengayaan.

3) Pelaksanaan Pengayaan
Program pengayaan dilakukan dalam proses pembelajaran dilaksanakan

sesuai perencanaan dengan memperhatikan gaya dan minat belajar.
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Pengayaan dilakukan saat proses pembelajaran selain untuk melayani

kebutuhan pengembangan potensi peserta didik juga dimaksudkan agar
peserta tersebut tidak merasa jenuh sehingga dapat berperilaku
mengganggu proses pembelajaran yang sedang berlangsung.

4) Penilaian
Penilaian hasil belajar kegiatan pengayaan, tentu tidak sama dengan
kegiatan pembelajaran biasa. Setelah pelaksanaan program pengayaan
guru melakukan penilaian sesuai dengan jenis kegiatan dan aktivitas
pengayaan tersebut misalnya mereview hasil karangan, membuat
rekaman atau dokumen proses aktivitas peserta didik, membuat deskripsi

kemajuan, dan portofolio., tetapi cukup dalam bentuk portofolio.

e. Contoh Rancangan Program Pengayaan

Contoh 1
Program Pengayaan Terkait KI-3

Identifikasi:

Melalui hasil identifikasi awal di kelas IV SDLB Tunarungu, pada tema Hidup
Bersih dan Sehat, subtema “Hidup Bersih dan Sehat di Rumah,” dengan
indikator muatan pelajaran pada Kompetensi Dasar Matematika: Menentukan
unsur-unsur yang membentuk bangun datar yaitu sudut dan ruas garis (sisi).
Guru menemukan peserta didik yang dapat menuntaskan materi ajar dengan
cepat dan baik. Peserta didik menunjukkan kemampuan berpikir kritis,
menjawab pertanyaan dengan baik, mengajukan pertanyaan yang relevan

dan kritis, melakukan analisis ruas garis atau sisi pada bangun datar.

Berdasarkan kondisi tersebut, guru dapat merancang rencana program

pengayaan sebagai berikut.

Pelaksanaan Program

Kompetensi :
P Indikator Pengayaan

Dasar
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Pelaksanaan Program

unsur-unsur
yang
membentuk
segi tiga, segi
empat, dan segi
enam

beraturan.

unsur-unsur
yang
membentuk
bangun datar

yaitu sudut dan

ruas garis (sisi).

Kompetensi .
Besa Indikator Pengayaan
3.8Mengidentifikasi | 3.8.1Menentukan Metode :

Guru melakukan program

pengayaan dengan membuat

alternatif program pengayaan
yaitu dengan metode
penugasan.

Perencanaan:

e Peserta didik diminta untuk
menuliskan dan atau
menggambarkan bangun-
bangun datar yang dia
ketahui, kemudian
mendiskusikan dengan
teman-temannya yang
berhubungan dengan sudut
dan ruas garis (sisi) dan
hasilnya supaya ditulis dan
digambar.

e Guru menyiapkan media
pendukung pengayaan.

e Guru membuat
dokumentasi/mengumpulka
n hasil kerja (portofolio).

Pelaksanaan :

¢ Dilakukan langsung saat
proses pembelajaran.

¢ Guru menugaskan kepada
peserta didik untuk
menuliskan dan
menggambarkan bangun-
bangun datar yang dia

ketahui, kemudian
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Pelaksanaan Program

Kompetensi .
P Indikator Pengayaan

Dasar

mendiskusikan dengan
teman-temannya yang
berhubungan dengan sudut
dan ruas garis (sisi) dan
hasilnya supaya ditulis dan

digambar.

Penilaian:

Penilaian dilakukan dengan
mereview hasil kerja yang

dilakukan oleh peserta didik

dan mendokumentasikannya

Contoh Il

Program Pengayaan Terkait KI-4

Identifikasi:

Melalui hasil identifikasi awal di kelas IV SDLB Tunarungu, pada tema Hidup
Bersih dan Sehat, subtema “Hidup Bersih dan Sehat di Rumah,” dengan
indikator muatan pelajaran pada Kompetensi Dasar Matematika: “Mengenal
unsur-unsur bangun ruang sederhana dari benda-benda di sekitar,” guru
menemukan peserta didik yang mampu menyebutkan dan menunjukkan
bangun bangun ruang dengan sangat baik. la mampu menyebutkan dan
menunjukkan contoh bangun ruang yang ada di sekitarnya dengan tepat.
Peserta didik tersebut juga selalu menyelesaikan tugasnya dengan lebih

cepat.

Berdasarkan kondisi tersebut, guru dapat merancang rencana program

pengayaan sebagai berikut.
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Kompetensi Dasar

Indikator

Pelaksanaan Program

Pengayaan

4.6Mengenal
bangun datar dan
bangun ruang
serta
mengelompokkan
berdasarkan sifat

geometrisnya

4.6.1Mengurai
unsur-unsur
bangun ruang
yaitu sisi,
sudut, dan

rusuk.

Metode :

Guru melakukan program

pengayaan dengan metode

Diskusi

Perencanaan:

Peserta didik diminta untuk
melakukan diskusi dengan
teman-temannya tentang
unsur-unsur bangun ruang dan
macamnya.

Peserta didik diberi
kesempatan untuk bertanya
pada orang lain selain gurunya.
Guru memerintahkan pada
peserta didik untuk menuliskan
hasilnya.

Selama kegiatan pembelajaran

Guru melakukan penilaian.

Pelaksaanaan :

Dilakukan langsung saat
proses pembelajaran.

Guru memberikan
kesempatan untuk bertanya
pada orang lain, atau ke
perpustakaan sekolah.
Guru menyiapkan media yang
dibutuhkan (sedotan, kawat,
lidi, karet, karton)

Guru memberikan contoh
bangun ruang berbentuk

rumah yang terdiri dari dua
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Kompetensi Dasar

Indikator

Pelaksanaan Program

Pengayaan

bangun ruang, yaitu kubus
dan limas, dan serta

menjelaskan unsur-unsurnya.

Penilaian:

Penilaiandilakukan dengan
merefleksi hasil diskusi yang
dilakukan oleh peserta didik baik
secara tertulis maupun

perbuatan.

D. Aktivitas Pembelajaran

Setelah mempelajari materi pada kegiatan pembelajaran 2, buatlah sebuah contoh

perencanaan pembelajaran

remedial

dan pembelajaran pengayaan dengan

mengacu pada kompetensi dasar yang sedang dilaksanakan di sekolah. Lakukan

diskusi dengan rekan sejawat untuk mendapatkan banyak contoh kegiatan yang

dapat dilakukan untuk program remedial dan pengayaan.

E. Latihan/Kasus/Tugas

Pilinlah jawaban yang benar dengan cara memberi tanda silang (X) pada huruf A, B,

C, atau D yang mewakili jawaban yang paling benar!

1. Langkah paling tepat yang dilakukan guru bagi peserta didik yang memiliki

kecepatan menuntaskan kompetensi

adalah....

dengan RPP yang disusun

A. memberikan materi tambahan yang lebih menantang

. melaksanakan pembelajaran sesuai buku siswa

B
C. memberi pembelajaran tambahan untuk materi yang sama
D

. memberi materi yang sama dengan cara yang berbeda
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2. Urutan yang tepat dalam melaksanakan pembelajaran remedial adalah....
A.

melakukan perencanaan, identifikasi, melaksanakan remedial, melakukan

penilaian

. identifikasi, melakukan perencanaan, melaksanakan remedial, melakukan

penilaian

. melakukan penilaian, identifikasi, melakukan perencanaan, melaksanakan

remedial,
melakukan penilaian, melakukan perencanaan, identifikasi, melaksanakan

remedial

3. Pembelajaran remedial hendaknya memungkinkan peserta didik untuk belajar

sesuai dengan daya tangkap, kesempatan, dan gaya belajar masing-masing, hal

ini sesuai dengan prinsip....

A.

fleksibilitas

B. interaktif
C.
D

. umpan balik segera

adaptif

4. Ketika seorang peserta didik teridentifikasi mengalami kesulitan dalam

menguasai materi KD yang sedang berlangsung, tindakan paling tepat dilakukan

guru adalah....

A.
B.
C.

segera melaksanakan tes dan melihat hasil tes tersebut
terus menyelesaikan materi sampai tuntas baru melakukan remedial
melakukan perbaikan pembelajaran sesuai dengan kesulitan peserta didik

tersebut

. melakukan pembelajaran remedial setelah peserta didik melaksanakan tes

5. Program pembelajaran pengayaan dimaksudkan untuk....

A.

memperkaya materi bagi peserta didik yang dirasakan kurang menguasai
materi yang diberikan

mengisi waktu yang dimiliki peserta didik yang telah menyelesaikan materi
sebelum waktunya selesai

memberi pembelajaran tambahan untuk materi yang sama

PPPPTK TK DAN PLB BANDUNG

© 2016



D. menambah wawasan atau memperluas pengetahuan dalam materi pelajaran

yang telah dipelajari

F. Rangkuman

1. Program pembelajaran remedial adalah program pembelajaran yang diberikan
kepada peserta didik yang belum mencapai kompetensi minimalnya dalam satu
kompetensi dasar tertentu.

2. Langkah-langkah pembelajaran remedial meliputi a) identifikasi; b) melakukan
perencanaan; c) melaksanakan remedial; d) melakukan penilaian.

3. Program pembelajaran pengayaan adalahprogram pembelajaran yang diberikan
kepada peserta didik yang telah mencapai ketentuan dalam belajar yang
dimaksudkan untuk menambah wawasan atau memperluas pengetahuannya
dalam materi pelajaran yang telah dipelajarinya.

4. Langkah-langkah pembelajaran pengayaan meliputi a) identifikasi; b) melakukan
perencanaan; c) melaksanakan pengayaan; d) melakukan penilaian.

G. Umpan Balik dan Tindak Lanjut
Cocokkanlah jawaban Anda dengan kunci jawaban yang terdapat di bagian akhir
modul ini.Hitunglah jawaban Anda yang benar,kemudian gunakan rumus di bawah

ini untuk mengetahui tingkat penguasaan Anda terhadap materi kegiatan belajar ini.

Jumlah jawaban Anda yang benar

Tingkat Penguasaan = 5 x 100

Arti tingkat penguasaan yang Anda capai:
90 — 100 % = Baik sekali

80 — 89 % = Baik

70 — 79 % = Cukup

<70 % = Kurang

Apabila tingkat penguasaan Anda mencapai 80% ke atas, bagus! Anda cukup
memahami kegiatan belajar ini. Anda dapat meneruskan dengan kegiatan belajar
berikutnya. Tetapi bila tingkat penguasaan Anda masih di bawah 80%, Anda harus

mengulangi kegiatan belajar ini, terutama bagian yang belum Anda kuasai.
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KEGIATAN PEMBELAJARAN 3
LAPORAN HASIL PENCAPAIAN KOMPETENSI
PESERTA DIDIK

A. Tujuan
Setelah mempelajari kegiatan pembelajaran3, diharapkan Anda dapat

memahami bagaimana melaporkan hasil pencapaian kompetensi peserta
didik kepada orangtua.

B. Indikator Pencapaian Kompetensi

Setelah mempelajari kegiatan pembelajaran3, diharapkan Anda dapat:

1. Mengolah hasil capaian kompetensi sikap, pengetahuan, dan
keterampilan.

2. Menyusun laporan hasil pencapaian kompetensi peserta didik.

C. Uraian Materi

1. Pengolahan Hasil Capaian

Hamalik (1986, dalam Arifin, 2010: 291) menjelaskan, “tujuan dari
pelaporan adalah untuk mengikhtisarkan, mengorganisasikan, dan
menafsirkan hasil tes sehingga dapat memberikan gambaran tentang
status dan kemajuan perorangan siswa, kelas, dan sekolah”. Bentuk
laporan dapat dilakukan secara tertulis mapun lisan. Laporan lisan
dimaksudkan agar terjadi komunikasi secara efektif antara sekolah
dengan pihak yang menerima laporan, danjuga membentuk hubungan
emosional yang lebih kental antara walikelas dan orangtua peserta didik.
Laporan tertulis dimaksudkan agar dapat memberikan petunjuk yang
permanen. Laporan tertulis dapat didokumentasikan dan pada waktunya

dapat dijadikan sebagai data untuk dianalisis lebih lanjut.
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Peraturan Menteri Pendidikan dan Kebudayaan Republik Indonesia No 66

Tahun 2013 tentang Standar Penilaian Pendidikan menyebutkan bahwa
hasil penilaian oleh pendidik dan satuan pendidikan dilaporkan dalam
bentuk nilai dan deskripsi pencapaian kompetensi kepada orangtua dan
Pemerintah. Pengembangan Laporan Hasil Pencapaian Kompetensi

Peserta Didik pada dasarnya merupakan wewenang sekolah.

Pada pembelajaran ini akan dibahas mengenai bagaimana melakukan
pengolahan nilai sikap, pengetahuan, dan keterampilan yang kemudaian
direkapitulasi dan dituangkan ke dalam rapor yang akan dilaporkan
kepada orangtua peserta didik. Selain rapor ini, guru juga dapat
memberikan laporan lain kepada orangtua terkait ketercapaian program
pembelajaran individual peserta didik yang telah disusun dan disepakati

antara guru dan orangtua di awal semester.

a. Pengolahan Nilai Sikap
Penilaian aspek sikap diperoleh dengan menggunakan instrumen: (1)
observasi; (2) Penilaian diri sendiri; (3) Penilaian antarteman; dan (4)
jurnal catatan guru. Hasil penilaian sikap yang menggunakan
instrumen observasi dan jurnal catatan guru digunakan untuk mengisi
buku rapor, sedangkan hasil penilaian sikap yang diperoleh dari
penilaian diri sendiri dan antarteman digunakan sebagai bahan

konfirmasi.

Pada kolom deskripsi diisi oleh guru dalam kalimat positif tentang:

1) Apa yang menonjol terkait dengan kemampuan pada aspek sikap
anak pada Kompetensi Inti 1 dan 2 (KI-1 dan KI-2).

2) Usaha pengembangan kemampuan pada aspek sikap anak untuk
mencapai Kompetensi Inti 1 dan 2 (KI-1 dan KI-2) pada kelas yang

diikutinya.

Deskripsi tersebut merupakan ringkasan dan intisari dari penilaian
yang sudah dilakukan oleh guru dengan berbagai alat penilaian yang

dilakukan secara terus menerus, dan bukan menggambarkan kondisi
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akhir saja. Dengan demikian, untuk aspek sikap diambil dari kriteria

sikap yang paling sering muncul.

Pengolahan Nilai Pengetahuan

Meskipun nilai aspek pengetahuan diolah secara kuantitatif, tetapi
yang dicantumkan di buku rapor adalah deskripsi kualitatif.
Penghitungan nilai pencapaian kompetensi peserta didik secara
kuantitatif,dilakukan ~ untuk  mengetahui ketercapaian kriteria
ketuntasan minimal (KKM), sebagai pertimbangan untuk melakukan
program remedial. Penghitungan nilai capaian kompetensi peserta
didik dalam satu semester secara kuantitatif, dilakukan dengan

langkah-langkah sebagai berikut:

1) Menghitung Nilai Harian (NH)
NH diperoleh dari hasil penilaian harian, yang dilaksanakan
melalui tes tulis, tes lisan, dan penugasan serta ulangan yang
dilaksanakan pada setiap akhir satu subtema pembelajaran sesuai

dengan kebutuhan guru.

2) Menghitung Nilai Ulangan Tengah Semester (NUTS)
NUTS diperoleh dari hasil tes tulis dan/atau praktek yang
dilaksanakan pada tengah semester. Materi Ulangan Tengah
Semester mencakup seluruh kompetensi yang telah dibelajarkan

sampai dengan saat pelaksanaan UTS.

3) Menghitung Nilai Ulangan Akhir Semester (NUAS)
NUAS diperoleh dari hasil tes tulis dan/atau praktik yang
dilaksanakan di akhir semester. Materi UAS mencakup seluruh

kompetensi pada semester tersebut.

Nilai pengetahuan diperoleh dengan rumus sebagai berikut:

NH + NUTS + NUAS
A= 3
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Atau menggunakan rumus yang disepakati di satuan pendidikan.

Penghitungan  nilai  pengetahuan dilakukan dengan cara
menggunakan skala nilai 0 s.d.100. Penghitungan nilai pengetahuan
dilakukan untuk tiap KD pada masing-masing muatan pelajaran.

Pada kolom deskripsi diisi oleh guru dalam kalimat positif tentang:

1) Apa yang menonjol terkait dengan kemampuan pada aspek
pengetahuan anak dalam tiap muatan pelajaran yang ada pada
kompetensi inti 3 (KI 3).

2) Usaha pengembangan kemampuan pada aspek pengetahuan
anak dalam tiap muatan pelajaran untuk mencapai kompetensi inti

3 (Kl 3) pada kelas yang diikutinya.

Perhatikan tabel hasil rekap penilaian pengetahuan berikut!

KD Tema | Tema | Tema | Tema | UTS | UAS NILAI
1 2 3 4 AKHIR
3.1 70 - 70 70 60 65 65
3.4 - 85 85 - 90 80 85
3.5 60 80 - 70 80 80 76,67
Ao NH + NUTS + NUAS
B 3
NA KD 3.1 = (70+60+70)/3) + 60 + 70
3
=65
NA KD 3.4 = (80+85)/2) + 90 + 80
4
=85
NA KD 3.5 = (60+80+70)/3) + 80 + 80
4
= 76,67
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Jika rumusan KD nya adalah sebagai berikut:

KD 3.1 Mengenal teks deskriptif tentang anggota tubuh dan
pancaindra, wujud dan sifat benda, serta peristiwa siang dan malam
dengan bantuan guru atau teman dalam bahasa Indonesia lisan dan
tulis yang dapat diisi dengan kosakata bahasa daerah untuk
membantu pemahaman.

KD 3.4 Mengenal teks cerita diri/personal tentang keberadaan
keluarga dengan bantuan guru atau teman dalam bahasa Indonesia
lisan dan tulis yang dapat diisi dengan kosakata bahasa daerah untuk
membantu pemahaman.

KD 3.5 Mengenal teks diagram/label tentang anggota keluarga dan
kerabat dengan bantuan guru atau teman dalam bahasa Indonesia
lisan dan tulis yang dapat diisi dengan kosakata bahasa daerah untuk

membantu pemahaman.

Maka laternatif rumusan deskripsi nilai pengetahuan untuk Radit

adalah sebagai berikut..

-

Radit sudah mengenal teks ceritn divi tentang keberadaan
keluarga dengan baik; masih perlu bimbingan dalom mengenal
teks deskriptif tentang anggota tubuh dan pancaindra.

\_

Pengolahan Nilai Keterampilan

Penilaian aspek keterampilan dapat diperoleh dari nilai praktik, nilai

projek, dan nilai portofolio.Pada kolom deskripsi diisi oleh guru dalam

kalimat positif tentang:

1) Apa yang menonjol terkait dengan kemampuan pada aspek
keterampilan anak dalam tiap muatan pelajaran yang ada pada
kompetensi inti 4 (KI-4).

2) Usahapengembangan kemampuan pada aspek keterampilan anak
dalam tiap muatan pelajaran untuk mencapai kompetensi inti 4

(KI-4) pada kelas yang diikutinya.
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Perhatikan dan lengkapi rekap nilai keterampilan berikut ini.

KD Praktik Proyek Portofolio NILAI AKHIR
4.1 60 _ 70 65
4.5 70 80 : 75

NA KD 4.1 =60 + 70
2
=65
NA KD 4.4 = 90 + 90
2
=90
NA KD 4.5 =70+ 80
2
=75

Jika rumusan KD nya adalah sebagai berikut:

KD 4.1 Mengamati dan menirukan teks deskriptif tentang anggota tubuh
dan pancaindra, wujud dan sifat benda, serta peristiwa siang dan malam
secara mandiri dalam bahasa Indonesia lisan dan tulis yang dapat diisi

dengan kosakata bahasa daerah untuk membantu penyajian.

KD 4.4 Menyampaikan teks cerita diri/personal tentang keluarga secara
mandiri dalam bahasa Indonesia lisan dan tulis yang dapat diisi dengan

kosakata bahasa daerah untuk membantu penyajian.

KD 4.5 Membuat teks diagram/label tentang anggota keluarga dan
kerabat secara mandiri dalam bahasa Indonesia lisan dan tulis yang

dapat diisi dengan kosakata bahasa daerah untuk membantu penyajian.

Maka alternatif rumusan deskripsi nilai keterampilan untuk Radit adalah

-

Radit sudah dapat menyampaikan teks cerita divi tentang keluargn
secara mandirt dalam bahasa indonesia lisan dan tulis dengan balk;
masth perlu bimbingan dalam mengamatt dan menirukan teks

deskriptif tentang anggota tubuh dan pancainoera.
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Penyusunan Laporan Hasil Pencapaian Kompetensi

Setelah guru mendapatkan rekap hasil penilaian kompetensi peserta didik
selama satu semester, selanjutnya guru menuangkan hasilnya pada buku
rapor. Berikut disajikan buku rapor Kurikulum 2013 dan contoh pengisiannya
sesuai Panduan Teknis Penilaian dan Pengisian Rapor Kurikulum
Pendidikan Khusus 2013 Pendidikan Dasar (Direktorat Pembinaan PK-LK,

2015)

Nama Peserta Didik : Raditya Ananda Kelas 1A
Nomor Induk . 2211045 Semester ;1 (satu)
Nama Sekolah . SDLB Kasih Ibu Tahun Pelajaran : 2015/2016
Alamat Sekolah . JI. Rerekaan Bandung
A. Sikap

Aspek Deskripsi

Menerima dan menjalankan

ajaran agama yang dianutnya

Adit sudah sangat baik dalam menunjukkan
perilaku syukur, masih perlu bimbingan dalam
beribadah.

Menunjukkan perilaku jujur,
disiplin, tanggung jawab, santun,
peduli, percaya diri, dalam
berinteraksi dengan keluarga

dan guru

Sangat baik dalam percaya diri dan bekerja
sama, masih perlu ditanamkan sikap teliti ketika

mengerjakan tugas.
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B. Pengetahuan

Aspek

Deskripsi

Mengingat dan memahami o

pengetahuan faktual dan

konseptual berdasarkan rasa

ingin tahu tentang: o

e dirinya,

¢ makhluk ciptaan Tuhan dan
kegiatannya

¢ benda-benda lain di sekitarnya

Sangat baik dalam mengenal huruf-huruf
hijaiyyah, masih perlu bimbingan dalam
mengenal tata cara bersuci.

Sangat baik mengenal simbol-simbol sila
Pancasila dalam lambang negara “Garuda
Pancasila”, masih perlu ditingkatkan dalam
mengenal arti bersatu dalam keberagaman di
rumah dan sekolah.

Sangat baik dalam mengenal teks deskriptif
tentang anggota tubuh dan pancaindra,
wujud dan sifat benda, serta peristiwa siang
dan malam menggunakan bahasa Indonesia
lesan dan tulis. Masih perlu ditingkatkan
dalam mengenal teks cerita diri tentang
keluarga.

Sangat baik mengenal bilangan asli sampai
99 dengan menggunakan benda-benda yang
ada di

sekitar rumah, sekolah, atau tempat bermain,
masih perlu bimbingan untuk mengenal
bangun datar dan  bangun ruang
menggunakan benda-benda yang ada di
sekitar rumah, sekolah atau tempat bermain.
Sangat baik dalam mengenal karya seni
budaya benda dan bahasa daerah setempat.
Masih perlu bimbingan dalam Mengenal pola
irama lagu bervariasi menggunakan alat

musik ritmis.
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C. Keterampilan

Aspek

Deskripsi

Menyajikan kemampuan

mengamati, menanya, dan

mencoba dalam :

- bahasa yang jelas, logis, dan
sistematis

- karya yang estetis

- gerakan anak sehat

- tindakan anak beriman dan
berakhlak mulia

Sangat baik dalam melafalkan huruf-huruf
hijaiyah, surat alfatihah, surat an-naas dan
surat al-falag. Masih perlu bimbingan dalam
mempraktikkan tata cara bersuci.

Sangat baik dalam menceritakan perilaku
dan mengaitkannya dengan pengamalan
sila Pancasila. Masih perlu bimbingan dalam
melaksanakan tata tertib di sekolah.

Sangat baik dalam menirukan teks deskriptif
tentang anggota tubuh dan pancaindra,
wujud dan sifat benda, serta peristiwa siang
dan malam menggunakan bahasa Indonesia
lesan dan tulis. Masih perlu ditingkatkan
dalam menyampaikan teks cerita diri
tentang keluarga.

Sangat baik mengurai sebuah bilangan asli
sampai dengan 99 sebagai hasil
penjumlahan atau pengurangan dua buah
bilangan asli lainnya dengan berbagai
kemungkinan jawaban, perlu bimbingan
membentuk dan menggambar bangun baru
dari bangun-bangun datar atau pola bangun
datar yang sudah ada

Sangat baik dalam membuat karya
kerajinan bahan alam dengan menempel.
Masih perlu bimbingan dan latihan dalam

menyanyikan dan memahami isi lagu.
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D. Ekstra Kurikuler

Kegiatan
No _ Keterangan
Ekstrakurikuler

1. Pendidikan Kepramukaan | e Menunjukkan kesungguhan dalam
mengikuti kegiatan, terampil dalam

baris berbaris.
2. Diisi jenis ekstra kurikuler | e ... ...
pilihan yang diikuti Siswa | ...

E. Saran-saran

Radittelah mampu menunjukkan keterlibatan dalam kegiatan pembelajaran

dan ekstra kurikuler dengan baik. Perlu pembinaan lebih lanjut dan

kerjasama orang tua dalam membimbing aktivitas pembelajaran di rumah

F. Perkembangan Fisik/Kesehatan

No Aspek Yang Dinilai Semester
1 2
1 | Tinggi 120 cm 125 cm
2 | Berat Badan 35 kg 35kg
G. Kondisi Kesehatan
No Aspek Fisik Keterangan
1. | Pendengaran Baik
2. | Penglihatan Tunanetra, dengan glaukoma,
sering nyeri pada mata
Gigi Baik, tetapi kotor
4. | Lainnya
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H. Catatan Prestasi

No Jenis Prestasi Keterangan
1. Juara | Menyanyi Kegiatan dilaksanakan dalam rangka HUT RI Ke
tingkat SDLB 70 diBandung
Kabupaten
2. e
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D. Aktivitas Pembelajaran

Setelah mempelajari materi yang ada pada kegiatan pembelajaran 3,

amatilah rekap hasil penilaian peserta didik selama satu semester. Apa yang

dapat Anda peroleh dari hasil rekap tersebut? Cobalah berlatih untuk

merekap dan mendapatkan nilai akhir capaian kopetensi peserta didik lalu

deskripsikan hasil capaian kompetensi belajar peserta didik tersebut!

E. Latihan/Kasus/Tugas

Pilihlah jawaban yang benar dengan cara memberi tanda silang (X) pada

huruf A, B, C, atau D yang mewakili jawaban yang paling benar!

1. Hasil akhir penilaian kompetensi sikap diperoleh dengan melihat pada....

A.

B
C.
D

modus

. mean

median

. optimum

2. Hasil akhir penilaian kompetensi pengetahuan diperoleh dengan melihat

pada....

A.

B
C.
D

nilai harian

. nilai ulangan tengah semester

nilai ulangan akhir semester

. rata-rata dari NH, NUTS, dan NUAS

3. Laporan capaian kompetensi peserta didik dilaporkan kepada orangtua

peserta didik dalam bentuk....

A.

B.
C.
D.

nilai 1-4
nilai 1-100
huruf A-D
deskripsi
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4. Perhatikan tabel hasil rekapitulasi penilaian pengetahuan berikut.

Tema | Tema | Tema | Tema UTS | UAS | NILAI

KD | 1 2 3 4 AKKIR
31 70 . 60 70 60 | 70
3.4 i 90 85 - 9 | 80
3.5 60 80 i 70 80 | 80

Berapakah nilai akhir yang diperoleh untuk KD 3.47?
A. 65,83

B. 71,25
C. 85,83
D. 86,25

Hasil akhir penilaian kompetensi keterampilan diperoleh dengan melihat
pada....

A. modus

B. mean
C. median
D

. optimum

F. Rangkuman

1. Tujuan dari pelaporan adalah untuk mengikhtisarkan,

mengorganisasikan, dan menafsirkan hasil tes sehingga dapat
memberikan gambaran tentang status dan kemajuan perorangan siswa,
kelas, dan sekolah.

Penilaian Hasil Belajar oleh Pendidik berfungsi untuk memantau
kemajuan belajar, memantau hasil belajar, dan mendeteksi kebutuhan
perbaikan hasil belajar peserta didik secara berkesinambungan.

Modus untuk ketuntasan kompetensi sikap ditetapkan dengan predikat

Baik. Skor rerata untuk ketuntasan kompetensi pengetahuan ditetapkan
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paling kecil 2,67.Capaian optimum untuk ketuntasan kompetensi

keterampilan ditetapkan paling kecil 2,67.

G. Umpan Balik dan Tindak Lanjut

Cocokkanlah jawaban Anda dengan kunci jawaban yang terdapat di bagian
akhir modul ini.Hitunglah jawaban Anda yang benar,kemudian gunakan
rumus di bawah ini untuk mengetahui tingkat penguasaan Anda terhadap

materi kegiatan belajar ini.

Jumlah jawaban Anda yang benar

Tingkat Penguasaan = 5 x 100

Arti tingkat penguasaan yang Anda capai:

90 - 100 % = Baik sekali
80 -89 % = Baik
70-79% = Cukup
<70% = Kurang

Apabila tingkat penguasaan Anda mencapai 80% ke atas, bagus! Anda
cukup memahami kegiatan belajar ini. Anda dapat meneruskan dengan
kegiatan belajar berikutnya. Tetapi bila tingkat penguasaan Anda masih di
bawah 80%, Anda harus mengulangi kegiatan belajar ini, terutama bagian

yang belum Anda kuasai.
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KEGIATAN PEMBELAJARAN 4
PENGOPERASIAN KOMPUTER DENGAN SISTEM

OPERASI WINDOWS 7

A. Tujuan
Tujuan pokok pada kegiatan pembelajaran 4 ini adalah mempelajari tentang:
1. Konsep Sistem Operasi Komputer
2. Macam-macam Sistem Operasi

3. Dasar-dasar Penggunaan Windows 7

B. Indikator Pencapaian Kompetensi
Setelah mempelajari materi pokok 4 tentang Konsep ICT dalam Membantu
Kepentingan Pembelajaran, diharapkan Anda dapat:
1. Menjelaskan Sistem Operasi Komputer
2. Merinci Macam-macam Sistem Operasi

3. Menggunakan operasi dasar pada Windows 7

C. Uraian Materi

1. Konsep Sistem Operasi Komputer
Sistem Operasi atau Operating system (OS) adalah suatu perangkat
lunak yang bertugas untuk melakukan kontrol dan manajemen hardware
serta operasi-operasi dasar sistem termasuk menjalankan software
aplikasi. Sistem Operasi merupakan software pada lapisan pertama yang
dimasukkan pada memori komputer pada saat komputer dinyalakan.
Menurut American National Standart Institute (ANSI), sistem operasi
adalah software yang mengontrol pelaksanaan program-program
komputer dengan mengatur waktu proses, pengecekan kesalahan,
mengontrol input dan output, melakukan perhitungan, kompilasi,
penyimpanan, pengolahan data serta layanan-layanan lainnya yang

terkait.
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2. Macam-Macam Sistem Operasi

Pada saat ini, di pasaran dunia terdapat berbagai macam sistem operasi.
Semua sistem operasi tersebut masing-masing mempunyai kelebihan
dan.Beberapa sistem operasi yang ada di pasaran saat ini antara lain : DOS
(Disk Operating System), Microsoft Windows, Macintosh Operating System,

Sistem Operasi UNIX, Sistem Operasi Linux, Sistem Operasi Android

3. Dasar-dasar Penggunaan Windows 7
Pada materi ini kita akan membahas penggunaan sistem operasi
windows 7, ada beberapa hal mendasar yang perlu Anda kuasai ketika
mempelajari sistem operasi windows (Windows 7), antara lain; teknik
mengaktifkan dan mematikan komputer dengan prosedur yang benar,
manajemen File, membuat Folder, mengganti Nama File atau Folder,

memindahkan File atau Folder, dan menghapus File atau Folder

a. Manajemen File
Seringkali kita mengalami kesulitan untuk mencari atau menemukan file
yang telah kita simpan dalam komputer. Hal ini bisa terjadi salah satunya
karena kita tidak menyimpan file-file tersebut pada suatu direktori(root)
atau subdirektori (folder) khusus. Untuk mengatasinya kita perlu membuat
dan menyusun folder-folder tertentu yang khusus digunakan untuk

menyimpan file-file hasil kerja kita.

Pada Sistem Operasi Windows (Windows 98, Windows 2000, Windows
ME, Windows NT, Windows XP, Windows7) ada salah satu fasilitas yang
dapat digunakan untuk mengatur susunan file-file dan folder-folder pribadi

kita. Fasilitas tersebut adalah Windows Explorer.

Ada dua cara yang sering digunakan untuk membuka Widows Explorer,
yaitu melalui menu Pull-Down Start dan menu Pop-Up Start. Langkah
membuka fasilitas Windows Explorer melalui menu Pull-Down Start

adalah sebagai berikut:

1) Klik kiri pada tombol Start
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2) pilih All Program

3) cari dan pilih Windows Explorer (fasilitas Windows Explorer sering
terdapat di dalam folder Accessories).

Sedangkan langkah melalui toolbar lebih sederhana, yaitu::

1) cari dan klik kiri ikon Windows Explorer (biasanya ada bagian bawah
dekstop)
 Ikon Windows Explarer

Gambar 4. 1likon Windows Explorer

2) muncul tampilanWindows Explorer
Dari gambar di atas dapat dilihat susunan direktori dan sub direktori
dari suatu komputer. Jendela sebelah kiri menunjukkan susunan
direktori dan sub direktori, jendela sebelah kanan menunjukkan isi

dari direktori atau sub direktori yang dipilih.

Ada banyak fungsi dari Windows Explorer, diantaranya untuk
mencari keberadaan suatu file, membuat dan menyusun folder,
mengganti nama file, memindahkan file atau folder, menggandakan
file, menghapus file atau folder, menyembunyikan file atau folder, dan

masih banyak lainnya.

b. Membuat Folder
Pembuatan suatu folder penyimpanan file sangat diperlukan agar kita
tidak mengalami kesulitan pada saat mencari suatu file. Sebaiknya folder
yang kita buat berisi file-file yang sejenis. Adapun langkah pembuatan

folder adalah sebagai berikut:

1) tentukan letak folder baru yang akan kita buat dengan memilih salah
satu direktori atau subdirektori yang ada
2)  cari dan klik kiri ikon New Folder pada Toolbar (biasanya di atas)
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3)
4)

atau
1)
2)
3)

4)
5)

€

—

\ /}v 4 » Computer » HERU (D) »
anize

rga - Include n bbraey » Share with Bam New folde

Slagu Karacke

4 _y Libracies 3. 470086018304 cab8 T8I 930638054
& Apps ) 4180b1d7HdT5 4088
* Documents ARSIP LAMA
Downloads BAHAN AJMR
o' Music 8ahan Paparan kunkulum PLB
Musics CAMPURSAR]
Pictures D ads
weo DUPAK TERBARU
EMBUMH
« W Computer KELUARGA
& wWINTR2 (C) MASTER
« HERU (D:) Pictures
» LAIN-LAIN (E:) Sygic 14_remo-xp.com

8 tes kd.pdf

Gambar 4. 2220 Folder
tuliskan nama folder yang dikehendaki
tekan ENTER

tentukan letak folder baru yang akan kita buat dengan memilih salah
satu direktori atau subdirektori yang ada

arahkan cursor pada bidang yang kosong di jendela sebelah kanan
klik New - Folder

tuliskan nama folder yang dikehendaki

tekan ENTER
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@,Q‘;‘lt_-u v Computer » HERU (D:) »

Organize » Include in library « Share with « Burn Mew folder
v Favorites Mame . Date modified Type Size
@lagu Karacke 3/3/201510:14 AM  File folder
. Libraries 0. 4f100fobcl83dd4 cabB278fa930638a84 1 Folder
& Apps 4. 41a8f0bl d7ffd75c4088 STl Shortcut
| Documents ARSIP LAMAZ 1
Downloads BAHAN AJAR 1 |I_|] Microsoft Access Database

-, Music Bahan Paparan kurikulum PLB 1 @ Eimaplinaie
Musics CAMPURSARI 1 B CorelDRAW X5 Graphic
Pictures Downloads 1E5 Contact
Videos O . a Corel PHOTO-PAINT X5 Image
Uiz i’ IEL] Microseft Word Document
1M Computer ST ' %| Journal Document
&, wWiNT32 () Sl ' MQL4 Source File
. HERU (D) Een=h il MetaQuotes Book
—a LAIN-LAIN (E) Customize this folder... Ill] Microsoft PowerPoint Presentation
N = Paste ﬁ Adobe Photoshop Image 55 11
€M Network L i [E]] Microsoft Publisher Document
Paste shortcut
Undo Rename Ctrl+Z E WinRAR archive
| TextDocument
Share with D |Z_|] Microsoft Excel Worksheet
5| Shared Folder Synchronization 3 E WinRAR ZIP archive
New 4 Ej Briefcase
Properties

Gambar 4.3Langkah membuat folder baru

c. Mengganti Nama File atau Folder
Terkadang karena alasan tertentu kita mesti mengganti nama dari suatu
file atau folder yang telah ada. Berikut adalah salah satu langkah-
langkahnya:
1) pilih file atau folder yang akan diganti namanya
2) klik kanan
3) pilih Rename
4) ketikkan nama baru yang diinginkan
5) tekan ENTER
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o0-

» Computer » HERU (D:) » BAHAN AJAR »

Organize v @ Open ~ Print Burn New folder
-
. Name =
{ F it 0
evorites 1CT 586 MEDIA pen
o Identifikasi 8 Asesy =2
IJ_‘ |Arar|es kumpulan materi & (=
& 5
h,. [ Media Pembelajara Lk
£| Decuments
media pembelajara 7 Convert to Adobe PDF
Downloads .
. . media pembelajara % Convert to Adobe PDF and EMail
o' Music MODUL 2013 #5  Combine supported files in Acrobat...
M
e MODUL SKG 2015 | € Publish DWF
LTS Modul MPICT Ings % Publish DWF and Email
Videos L
Optomalisasi Diri | @l Scan with AVG

Pembelajaran Berb| 7 Permanently shred with AVG

M Computer
: P Pengembangan Int Open with L

&, win32 ()
s HERU (D)
a LAIN-LAIN (E:)

Pengembangan Int
PPL

Program Khusus sl|

Acronis Recovery

Add to archive...

Add to "HAMBATAN PERKEMBANGAN ANAK.rar”

Cornpress and email...

Compress to "HAMBATAN PERKEMBANGAN AMAK.rar" and email

@ Network psikologi pendidiks
sumber
tunagrahita

] HAMBATAN PERKE

@ Mengajar Bayi And

& MODUL BINA POTI

& W W W

Include in Monstop Backup

Scan With Smadav

Restore previous versions

8] Motivasi dan kreati Send to 3
@ pendidikan Karakte Cut

[

] PERVASIVE DEVELQ B

@ PRE test motivasi d

] PRE TEST PENDIKA Create shortcut

(] psikologi pendidiks Delete
w! HAMBATAN PERKEMBANGAN ANAK.C Eegane
e Microsoft Word Document T

Gambar 4. 4Langkah mengganti nama file

d. Memindahkan File atau Folder
1) pilih file atau folder yang akan dipindahkan
2) Drag dan arahkan pada direktori atau sub direktori yang diinginkan
sebagai tempat yang baru

3) Lepaskan mouse

Atau

1)
2)
3)

pilih file atau folder yang akan dipindahkan
klik kanan
pilih Cut
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@G)vl » Computer + HERU (D) » BAHANAJAR »

Organize @ Open ~ Print Burn Mew folder

=
Name

I Favorites 1CT SBG ME Open
. Identifikasi =03
w4l Libraries kumpulan Mew
& Apps
-_. DF‘F‘ Media Pem [
£| Documents
T ot media pem| % Convert to Adobe PDF
. DW_" oads media pem| & Convert to Adobe PDF and EMail
@ mus'c wMoDUL 201 % Combine supported files in Acrobat...
ustes MODUL SK( & Publish DWF
Bictures Modul_MP] € Publish DWF and Email
Videos -
Optornalisa W Scan with AVG
- . Pembelajar{ i Permanently shred with AVG
omputer
o Pengembar| o] ith
& WINT32 (C) Panzembar Apen "MR
. HERU (D) cronis Recovery
PRI B Addto archive...

- LAIN-LAIN (E5)

sikologip¢ B  Compress and email...
€ Network i oh

tunagrahita {ij Include in Nonstop Backup
] HAMBATAI
] Mengajar B
& MoDUL BIN
B Motivasi da Send to
] pendidikan

Scan With Smadav

Restare previous versions

@ Cut

lel] PERVASIVE

2 Copy
@ PRE test md
IE_] PRE TEST P| Create shortcut
(1] psikologi pi Delete

(w! HAMBATAN PERKEMBAMGAN 4 [Hzpr

Microsoft Word Document Properties

Program KH B  Add to "HAMBATAN PERKEMBANGAM ANAK.rar”

sumber B Compress to "HAMBATAN PERKEMBANGAN ANAK.rar” and email

H [Clel= I

4) klik kanan pada direktori atau sub direktori yang diinginkan sebagai

tempat yang baru.
5) Pilih Paste

Menggandakan File atau Folder

1) pilih file atau folder yang akan digandakan
2) klik kanan

3) pilih Copy

4) klik kanan pada direktori atau sub direktori yang diinginkan sebagai

tempat untuk file/folder yang digandakan
5) pilih Paste

Menghapus File atau Folder

1) pilih file atau folder yang akan dihapus
2) klik kanan

3) pilih Delete

4) muncul menu konfirmasi penghapusan file
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5) tekan Yes

atau

1) pilih file atau folder yang akan dihapus

2) tekan tombol Delete pada keyboard

3) muncul menu konfirmasi penghapusan file
4) tekan Yes

@Qv' V Computer » HERU (D) » BAHANAJAR » sumber »

Organize v (w] Open =

¢ Favorites R}

i Libraries
& Apps
&| Documents
Downloads
o Music
Musics
Pictures
Videos

M Computer
& wing32 (C)
s HERU (D)
= LAIN-LAIN (E)

€ Network

L EEEC D

w Apakah gangguan er|
= Microsoft Word Docun|

> &

Print

IR 20 @

i

Bum New folder

Open
Edit

New

Print

Convert to Adobe PDF

Convert to Adobe PDF and EMail
Combine supported files in Acrobat...

Publish DWF
Publish DWF and Email

Scan with AVG

Permanently shred with AVG

Open with

Acronis Recovery

Add to archive...

Add to "Apakah gangguan emosi.rar”
Compress and email...

Compress to "Apakah gangguan emosirar” and email
Include in Nonstop Backup

Scan With Smadav
Restore previous versions

Send to
Cut
Copy

Create shortcut
Delete

Rename

Properties

pe
e folde
e folde
e folde
e folde
e folde
e folde
e folde
e folde
E folde
E folde
E folde
E folde
E folde
E folde
E folde
E folde
F File

F File

F File

it Doc
lcrosof
lcrosof
lcrosof
InRAR
F File

lcrosof

11012:

Gambar 4. 5Langkah menghapus file

Kedua cara di atas digunakan untuk membuang file atau folder ke Recycle

Bin (tempat pembuangan sementara). File atau folder tersebut masih bisa

diambil kembali dengan menggunakan fasilitas Restore.

* Perintah delete yang dikombinasikan dengan penekanan tombol Shift akan
membuat file atau folder dihapus secara permanen dan tidak dapat diambil kembali
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D. Aktivitas Pembelajaran

Ada beberapa kegiatan pembelajaran yang dapat Anda lakukan untuk

memperdalam penguasaan materi pada materi pokok 4 ini, yaitu:

1. Langkah 1 : Cari dan amati dengan seksama berbagai peralatan yang
dijelaskan ketika mempelajari materi ini .

2. Langkah 2 : Coba Anda aktifkan komputer mengikuti prosedur yang
dijelaskan

3. Langkah 3 : buatlah folder baru dengan nama “folder latihan” di folder My
Document.

4. Langkah 4 : pindahkan folder yang sudah Anda buat tadi ke Directory: D,

Langkah 5 : Ubah nama folder tersebut dengan nama “ Latihan”

E. Latihan/Kasus/Tugas
Untuk memperdalam pemahaman anda terhadap materi pokok
Pengoperasian Sistem Operasi Windows 7, kerjakan latihan dibawah ini:

Sebutkan nama peralatan di bawah ini beserta fungsinya:

Gambar 4. 6peralatan periferal
sumber :Modul TIK Prodep 2014.

0 Nama Peralatan Fungsi

o|u|s|wNk|=

Mouse
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F. Rangkuman

1. Fungsi sistem Operasi adalah untuk melakukan kontrol dan manajemen
hardware serta operasi-operasi dasar sistem termasuk menjalankan
software aplikasi.

2. Contoh sistem operasi antara lain PC DOS, Microsoft Windows, UNIX,
LINUX, Android, dan lain-lain.

3. Periferal komputer merupakan peralatan tambahan yang disambungkan
pada suatu komputer yang untuk keperluan-keperluan tertentu.

4. Contoh peralatan periferal diantaranya printer, scanner, modem, dan lain
sebagainya.

5. Salah satu tujuan dari manajemen file adalah untuk memudahkan
pencarian file atau dokumen yang telah disimpan dalam komputer.

G. Umpan Balik dan Tindak Lanjut

Cocokkanlah tugas yang telah Anda kerjakan pada bagian E dengan
jawaban yang terdapat pada bagian H. Apabila tugas Anda sudah sesuai
dengan kunci jawaban, silahkan Anda lanjutkan ke kegiatan pembelajaran
berikutnya. Apabila hasilnya masih belum sesuai, sebaiknya Anda perbaiki

dulu tugas tersebut.
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KEGIATAN PEMBELAJARAN 5
PENGGUNAAN PERANGKAT LUNAK

PENGOLAHKATA

A. Tujuan

Materi pokok pada Kegiatan Pembelajaran 5 tentang Penggunaan Perangkat

Lunak Pengolah Kata ini meliputi:

1.

a > w N

Konsep Dasar Pengolah Kata

Pengoperasian MS Word 2010

Pengenalan Bagian-bagian MS Word 2010
Pembuatan Dokumen dengan MS Word 2010
Format Dokumen dengan MS Word 2010

B. Indikator Pencapaian Kompetensi

Setelah mempelajari materi pokok 5 ini, Anda diharapkan mampu:

1.

o M 0N

Menjelaskan Konsep Dasar Pengolah Kata

Melakukan pengoperasian MS Word 2010

Mengenal bagian-bagian pada MS Word 2010

Membuat dokumen dengan MS Word 2010

Menggunakan Fasilitas Format Dokumen dengan MS Word 2010

C. Uraian Materi

1) Konsep Dasar Pengolah Kata

Microsoft Word atau biasa disebut MS Word merupakan salah satu
program aplikasi komputer keluaran Microsoft yang digunakan untuk
pengolahan kata. Aplikasi ini sangat populer karena relatif mudah
digunakan apabila dibandingkandengan aplikasi pengolah kata lainnya
(Word Star, Chi Writer, Corel Word Perfect, Lotus Amipro dan dan lain-

lain).

Ada berbagai macam versi MS Word dari semenjak pertama Kali

diluncurkan (tahun 1983) hingga sekarang. MS word keluaran terbaru
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untuk saat ini adalah MS Word 2010 untuk sistem operasi Windows dan
MS Word 20011 untuk sistem operasi Mac.

Ada berbagai macam dokumen yang dapat dibuat dengan menggunakan
MS Word, diantaranya dokumen surat menyurat, laporan, buku, skripsi,

tesis, desertasi, kartu undangan, kartu nama, dan lain-lain.

2) Pengoperasian MS Word 2010

Untuk menjalankan MS WORD ada beberapa cara yang dapat dilakukan,
salah satunya yaitu: melalui tombol start pilih menu program - pilih sub

menu Microsoft Word.

QD = |- z
P B @ F o o
Google  GoogleEarth  Corel Adobe FXCM ImTOO
Chrome PHOTO-P... Conte... Tradi... Downlo..:

Sy @ =
=, L | Z5)

Yahoo! Nero Corell\ Waon
Messenger.  StartSm... - CONNECT. Tim

HP
IBM SPSS Statistics

1612 - Covert Strike pengguna
ImTOO
Java Documents

KaraFun Player 2
K-Lite Codec Pack Pictures
Maintenance

Microsoft Office

(A] Microsoft Access 2010

(3] Microsoft Excel 2010

(T Microsoft InfoPath Designer 2010
(T Microsoft InfoPath Filler 2010
(N] Microsoft OneNote 2010
0] Microsoft Outlook 2010
(2] Microsoft PowerPoint 2010
[P] Microsoft Publisher 2010
(5] Microsoft SharePoint Workspace 201 Help and Support

(W] Microsoft Word 2010

Microsoft Offil Create and edit professional-looking documents such as letters, papers,
reports, and booklets by using Microsoft Word.

Music

Computer

Control Panel

Bl Devices and Printers

Default Programs

Back

Gambar 5. 1Menu Start

3) Pengenalan Bagian-bagian MS WORD 2010

Ada beberapa bagian ada dan ditampilkan ketika program MS Word
dijalankan, diantaranya area kerja, title bar, menu bar, toolbar, ruler dan
scrolbar. Sebagian dari bagian-bagian tersebut bisa diatur sesuai dengan

kebutuhan kita.
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a. Area Kerja

Adalah suatu bidang untuk menampilkan dan mengolah teks, gambar
atau objek lain yang telah dimasukkan atau diproses.

[ Ikon: simbol-simbol yang berisi suatu perintah tertentu ]

Gambar 5. 2lkon: simbol-simbol yang berisi suatu perintah tertentu

ange

AREA KERJA

b. Title Bar
Adalah papan baris yang terletak di bagian paling berisi nama dokumen,
nama program (Microsoft Word) dan tombol Minimaze, Restore, serta
Close.

Save: menyimpan file Nama dokumen Minimize Close

@' L'l/‘ -0 ko Eocumentz - microsoftWord ll\":’ | [ﬁ

~~~

) Restore
Undo: Membatalkan Redo: mengulang
. . ! . Down
perintah terakhir perintah terakhir

c. Tab
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Adalah papan yang menampung menu File, Home, Insert, Page Layout,

dan seterusnya, lengkapnya bisa Anda lihat di gambar bawah ini.

File Haome Insert Page Layout References Mailings Review Wiewy Add-Ins Acrabat

d. Tab File

Grup File terdiri dari sub-sub file sebagai berikut:

Wl - O | Sub Menu Fungsi
Home Insert -
e Save Menyimpan dokumen yang
i save sedang diedit
Bl Save As :
e Save As Menyimpan dokumen dengan
Save as Adobe PDF nama atau tipe yang baru
7 Open
e Save as | Menyimpan dokumen dalam
| Cl
g Close Adobe format pdf (tool tambahan)
e Info Melihat informasi tentang
Recent .
dokumen yang sedang kita
New buka
Print ¢ Recent Melihat dokumen yang baru
saja dibuka dengan MS Word
Save & Send
e New Membuat dokumen MS Word
Help yang baru
:] Options e Print Mencetak dokumen
Exit
= e Save & | Menyimpan dan mengirim
Send dokumen via e-mail
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e Help

Melihat informasi

program dan bantuan pada

tentang

MS Word yang digunakan

e Options

mengatur properti dan
tampilan program MS Word

yang digunakan

e Exit

Menutup program MS Word

e. Tab Home

mm)

|sign

2

P

Arial

iste
< Farmat Fainter i

Clipboard

v AT T - AR [
Ar A %) iz £ :!l ol &aBhCeDd AaBl ' ‘&_ﬂw

A EIEIEE I;, @,_

A

# Find -

= b Replare
TCaption  ead? '_Change

Sylef— Select~
s Lditing
r el

Tab Home terdiri dari grup-grup berikut ini: Clipboard, Font, Paragraph,

Styles dan Editing:

1) Grup Clipboard

Nama Grup Ikon Fungsi
s e Cut Memotong isi dari dokumen
Paste Fromthiner | Copy Menggandakan isi dari dokumen
Clipboard
¢ Paste Memunculkan dan menempatkan objek hasil
pemotongan (cut) atau penggandaan (copy),
jlka tanda panah ke bawah diklik akan
muncul beberapa pilihan paste
e Format Digunakan untuk menyamakan format objek
Painter yang satu dengan yang lain
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2) Grup Font
1 2 3 4 5
il WAL A Y
BI U-aex X .ab/,é.
6 | 7 | 8
Gambar 5. 3Grup Font

Ikon Fungsi
1. Font untuk menentukan jenis huruf
2. Font Size untuk mengatur ukuran huruf
3. Grow Shrink | untuk memperbesar memperkecil ukuran

Font huruf dengan cepat
4. Change Case | untuk mengubah status huruf kapital/huruf

kecil

5. Clear untuk menghapus pemformatan teks

Formatting
6. Bold untuk menebalkan teks
7. ltalic untuk memiringkan Teks
8. Underline untuk memberikan garis bawah pada teks
9. Strikethrough | memberikan tanda coret padateks
10. Superscript untuk mengetik karakter pemangkatan

Nama masing-m
ikon tersebut

3)

asing ikon akan muncul jika kursor kita arahkan tepat di atas

Grup paragraph
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r iz v Nz EEEE AL qr
=E=E= 1= - -
Paragraph

Grup paragraph terdiri dari menu-menu sebagai berikut:

a.

b.

Bullets : untuk memberikan tanda bullet di tiap paragraf

Numbering : untuk memberikan format penomoran di tiap paragraf

terpilih
Decrease Indent : untuk menggeser paragraf ke Kiri
Increase Indent : untuk menggeser paragraf ke kanan

Left-to-Right : untuk menjadikan arah teks berjalan dari kiri ke kanan

(format Latin)

Show Paragraph Marks : untuk menampilkan / menyembunyikan

tanda koreksi paragraf

Align Text Left : untuk mengatur teks rata Kiri
Center : untuk mengatur teks rata tengah

Align Text Right : untuk mengatur teks rata kanan
Justify : untuk mengatur teks rata kanan-kiri

Line Spacing : untuk mengatur jarak antar baris teks
Shading : untuk mengatur warna latar teks

Border : untuk mengatur garis tepi pada paragraf.

4) Grup Styles
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As
AaBhCeDd agsbceor AaBbCe A. AaBEb AaBiCel AaBbCel 1. AaBl tﬁg
T Caption Emphazis  THeadiin... Headingé Heading& mHead1P... mHeadz | _ Chanae

T Stylef—
Styles ]

Grup Styles terdiri dari dua menu. Yaitu:

a. Heading Styles : berisi pilihan format paragraf
b. Change Styles : berisi pilihan pengaturan tema paragraph

5) Grup Editing
3 Find -~
Jac Peplace

lg Select -
Editing

Gambar 5. 4Grup Editing
grup Editing terdiri dari Find, Replace, dan Select. fungsinya adalah:

a. Find : untuk mencari kata tertentu berdasarkan input kata tertentu
dalam suatu file

b. Replace : untuk mengganti kata dengan kata tertentu dalam suatu
file

c. Select : digunakan untuk memilih objek atau teks tertentu di dalam

suatu file

f. Tab Insert

W) o 5 Decument! - Micruseft Word o W
Hame I i I Page Layout Nefesenrtey Aaangy Hevlew Yiw A0ddm
) Cover Puge = e ) W, et ] Heante A | o Quuick Parts + R Signatuey Line * R touiton +
) Blank Page ij 8 S soimn | Fovter A worsaa v 5, 00te & Ty {2 Symbol

Table  Rdure O Dapes Smattet Chart Lacenshat Tedd

V5 Page Bonk M . =) Cronteeference o] Pogt mber = poy e '8 Object

Pagn Tubie udrabom um Heyde & Tuolm

Secara umum perintah yang terdapat di tab Insert terdiri dari 7 Grup yaitu:

Pages, Tables, lllustrations, Links, Header & Footer, Text, dan Symbols.
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Ikon-ikon di tab Insert pada umumnya berfungsi untuk menyisipkan objek

ke suatu file dokumen yang sedang dibuka. Objek tersebut bisa berupa
objek gambar, tabel, Shape, dan karakter khusus (Symbols) dan bahkan
juga bisa tautan ke internet.

Berikut ini penjelasan

1) Grup Pages

B0E

Cower  Blank  Page
Page~ Page Break

Pages

a) Cover Page: digunakan untuk menyisipkan serta memilih halaman
sampul. Cover Page dibutuhkan saat user ingin membuat halaman
sampul dari suatu file yang sedang digarap, merupakan salah satu
fitur terbaru pada program MS.Word. Pengguna dapat memilih model
sampul dan melakukan pengaturan seperlunya.

b) Blank Page: untuk menyisipkan halaman kosong dalam suatu file
dokumen. Fasilitas ini sangat membantu pengguna saat pengelolaan
dokumen harus pindah ke halaman baru, padahal baru setengah
halaman yang terisi teks, pengguna tidak perlu susah-susah
menekan banyak tombol Enter mendapatkan halaman baru.

c) Break Page: untuk memisah suatu halaman file dokumen. Break
Page sangat dibutuhkan saat pengguna ingin memisahkan beberapa
paragraf menjadi dua halaman. sebagai ilustrasi, dalam suatu
dokumen terdiri dari 10 paragraf yang berjejal di satu halaman saja,
kemudian pengguna ingin menjadikannya sebagai dua halaman,
maka pengguna cukup meletakkan kursor di bagian akhir paragraf
yang ingin dijadikan halaman pertama, kemudian Klik icon Break
page, maka paragraf sesudah tanda kursor tadi akan berpindah ke

halaman berikutnya. Bila dalam hal ini pengguna menggunakan icon
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2)

3)

Blank Page, maka antara paragraf sebelum kursor dan setelahnya

akan terpisah dengan satu halaman kosong.

Grup Tables

Table

w

Tables

a) Insert Table:untuk menyisipkan tabel.

b) Draw Table: untuk menyisipkan tabel dengan cara menggambar
di halaman dokumen.

c) Convert Text to Table: untuk memindahkan secara otomatis teks
ke dalam tabel.

d) Excel Spreadsheet: untuk menyisipkan tabel dalam bentuk
lembar kerja Excel.

e) Quick Tables: untuk menyisipkan tabel dengan cepat tabel-tabel
bawaan MS.Word 2010

Grup lllustrations

| -
b B2 @ 2 il
Picture Clip  Shapes Smartdqrt Chart Screenshot
At - -

Ilustrations

a) Picture: untuk menyisipkan gambar yang tersimpan di komputer.

b) Clip Art: digunakan untuk menyisipkan gambar-gambar ilustrasi
yang tersedia di library program.

c) Shapes: digunakan untuk menyisipkan berbagai bentuk objek.

d) SmartArt: digunakan untuk menyisipkan berbagai bentuk alur,
diagram, matrik atau yang lainnya.

e) Chart: digunakan untuk menyisipkan berbagai bentuk grafik.
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f) Screenshot: digunakan untuk memasukkan gambar tangkapan

layar.

4) Grup Links

- =
E::-::.JI 3 —ﬁ
Hyperlink Bookmark Cross-reference

Links

a) Hyperlink: digunakan untuk menghubungkan teks dengan teks di file
yang sama, di file lain, atau bahkan menautkan dengan bagian
tertentu di situs web.

b) Bookmark: digunakan membuat penanda buku atau sebagai
halaman favorit.

c) Cross-reference: digunakan untuk membuat referensi atau rujukan

antar file.

5) Grup Header & Footer

1 8 =

Header Footer  Page
v v Mumber~

Header & Footer

a) Header: untuk mengatur kepala halaman suatu file.
b) Footer: digunakan untuk mengatur atau catatan di kaki halaman
suatu file.

c¢) Page Number: digunakan untuk mengatur nomor halaman.

6) Grup Text
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u J A‘l A= [&signature Line =

51 Date & Time
Text  Quick WardArt Drop

Box~ Parts~ v Cap T "9e Object -

Text

Text Box: digunakan untuk menyisipkan kotak teks.

Quick Parts: digunakan untuk menyisipkan dengan cepat teks
tentang bagian-bagian penting dari suatu dokumen.

WordArt: untuk menyisipkan teks dengan format yang artistik.

Drop Cap: digunakan untuk menyisipkan huruf kapital besar pada
awal paragraf.

Signature Line: digunakan untuk menyisipkan tanda tangan digital.
Date & Time: untuk menyisipkan tanggal dan waktu dengan berbagai
jenis gaya penulisan.

Object: digunakan untuk menyisipkan objek dengan ekstensi
OLE (Object Linking Embedded)

7) Grup Symbols

TT Q2

Equation Symbol

b)

- -

Symboals

Equation: digunakan untuk menyisipkan simbol-simbol persamaan, terutama
dalam bidang matematika.
Symbol: digunakan untuk menyisipkan simbol khusus yang tidak terdapat

pada keyboard.

8) Ruler

Adalah mistar yang terletak secara horizontal dan vertikal

3‘|-2‘|‘1-|-§-w1‘|‘2-|-3‘|-4-|-5-w6‘|‘7-|-s‘|-9-|-10‘\‘11‘|-12-|-13-|-14-\-150\‘16

4. Pembuatan Dokumen dengan MS Word 2010
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Kemampuan awal yang perlu dikuasai dalam bekerja dengan MS word adalah

membuat, menyimpan, membuka dan menutup dokumen. Berikut ini akan

diuraikan langkah-langkahnya.

a.

b.

Membuat dokumen baru

1) nyalakan komputer anda
2) Kklik tombol start > pilih menu Program - Microsoft Word
3) Anda dapat mulai bekerja dengan MS Word 2010.

Menyimpan File (Save)
1) ketiklah naskah berikut ini:

Tanggung jawab kita yang pertama sebagai pemakai
program/piranti  lunak  komputer ialah membeli hanya
program/piranti lunak komputer ASLI untuk pemakaian kita
sendiri. Jika kita membeli program/piranti lunak komputer untuk
keperluan usaha kita, setiap unit komputer yang ada di tempat
usaha kita masing-masing harus memiliki sendiri seperangkat
program/piranti lunak komputer ASLI berikut buku pedoman
penggunaannya.

Jika kita hanya membeli satu program/piranti lunak komputer
ASLI untuk digunakan/dimasukkan ke dalam lebih dari satu unit
komputer atau meminjamkan, menyalin atau mengedarkan
program/ piranti lunak komputer atau buku pedoman
penggunaannya dengan alasan apapun, tanpa persetujuan
tertulis lebih dahulu dari pemegang/pemilik hak cipta atas
program/piranti lunak komputer atau buku pedoman itu, maka kita
telah melakukan tindak pidana/perbuatan melanggar hukum

2) untuk menyimpan naskah yang telah anda ketik tadi, klik file >save,

-
atau tekan ikon , atau tekan tombol Shortkey CTRL+S,

Shortkey: tombol cepat pada keyboard untuk menampilkan perintah,

biasanya berupa kombinasi dari beberapa tombol yang ditekan secara

bersamaan, misalnya tombol CTRL dengan tombol huruf S = Ctrl+S, tombol

Ctrl dengan tombol huruf O 2 Ctrl+O.
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Pada waktu membeli program/piranti lunak komputer, pastikanlah bahwa kita hanya

membeli program/piranti lunak komputer ASLI. Banyak produk bajakan yang

dikemas sedemikian rupa sehingga nampak sama dengan produk yang asli, namun

jauh berbeda dari segi mutunya.

3) Pada item “Save In” pilih My Document, > tekan ikon New Folder
untuk membuat folder baru, ketikkan latihan ms word.
4) pada item ” file name” ketik word-1a, ini adalah nama filenya, -

tekan tombol Save (enter)

Membuka File (open)

1) Pilih menu File > Open, atau tekan ikon = , atau tekan Ctrl+O,

2) pada item "Look In” pilih My Documents—>klik “latihan ms word” -
klik dua kali pada tulisan word-1a.

3) perhatikan apa yang terjadi

Menyimpan File dengan Nama Lain (Save As)

1) buka file word-1a, pada baris berikutnya ketikkan naskah berikut ini:

2) setelah selasai mengetik naskah tersebut, klik menu File->Save As,
kemudian pada item file name anda tulis word-1b

3) perhatikan apa yang terjadi

Menutup Dokumen
Ada dua cara yang biasa digunakan untuk menutup dokumen,

1) Tekan menu File,2>klik submenu Close, atau tekan ikon Close

Window (Lj) yang ada di pojok kanan atas. Perintah ini digunakan
untuk menutup dokumen yang sedang aktif.

2) Tekan menu File,~klik submenu Exit, perintah ini digunakan untuk
menutup program MS Word beserta seluruh dokumen yang sedang
dibuka.

Pengaturan Halaman (Page Setup)
Pengaturan halaman atau page setup diantaranya digunakan untuk
mengatur batas kertas, arah dokumen, jenis kertas, dan lain sebagainya.

Berikut ini langkah-langkah dalam pengaturan halaman.
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1) bukalah file word-1b
2) klik bar Page Layout

Insert Page Layout References Mailings R

Ly 3 Ij ¥= Ereaks =
= £50 Line Numbers -
Margins Orientation  Size  Columns .
- v - - be Hyphenation =

Page Setup

3) klik tanda panah ke bawah si belah kanan tulisan page setup (=) .

/Keterangan

o Margin digunakan untuk mengatur batas dokumen yang diukur dari tepi kertas
(kanan, kiri, atas, bawah)

o Orientation digunakan untuk mengatur arah dokumen (Potrait untuk
memanjang, Landscape untuk mendatar)

o Multiple pages digunakan untuk mengatur jumlah dan bentuk halaman pada

\ setiap lembar dokumen

~

)

4) ubah ukuran margins: top:4, bottom:3, left:4 dan right:3, perhatikan
tampilan previewnya.

5) Pada menu orientation klik portrait atau landscape sesuai kebutuhan.
Perhatikan tampilan previewnya.

6) Klik menu paper untuk memilih jenis kertas yang sesuai, Plihlah kertas
jenis A4 dengan mengklik tanda panah ke bawah di bawah tulisan

Paper Size
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Page Setup | ? ﬁj
Margins
Paper size:
= 8
width: |21 cm =
Height: [29.7 cm
Paper source
Eirst page: Other pages:
Auto Select Auko Select
Manual Feed Manual Feed
Tray 1 Tray 1
Tray 2 Tray 2
Tray 3 Tray 3
Presview
Apply tor | Selected sections |z| | Prink Opkions... |
| Set As Default | [ O ] | Cancel |

g. Memindahkan dan Menggandakan Data

ketiklah naskah berikut ini:

Di era yang serba modern ini, ilmu pengetahuan dan tehnologi
berkembang dengan pesat. Jika tidak mengikutinya, maka kita akan
menjadi seorang yang ketinggalan jaman atau sering disebut sebagai
orang yang gaptek (gagap teknologi). Sebagai manusia yang hidup
dalam dunia yang terus berubah, kita harus cepat tanggap terhadap

perubahan yang terjadi.

Salah satu produk dari ilmu pengetahuan yang terus berkembang adalah
komputer. Saat ini komputer menjadi barang yang begitu umum. Mulai
anak-anak sampai dewasa telah mengenal komputer bahkan sudah
menjadi mata pelajaran wajib di sekolah. Hampir semua perkantoran
sudah menggunakan komputer sebagai alat untuk mengolah data. Selain
mudah digunakan, rapi, data yang dihasilkan lebih akurat, dan bisa
meminimalkan terjadinya kesalahan. Komputer merupakan alat yang bisa

digunakan untuk membuat teks agar lebih bervariasi serta indah.
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Di samping sebagai alat pengolah data, komputer saat ini juga bisa

digunakan sebagai alat komunikasi.

1) blok seluruh kalimat dalam paragraph 1.

Bz
2) klik bar home —>klik copy atau tekan shortkey Ctrl+C
3) simpan kursor di bagian akhir paragraph ke-2

4) klik paste = atau tekan shortkey Ctrl+V , perhatikan perubahan yang
terjadi, seharusnya pada bagian akhir paragraf ke-2 akan terisi kalimat

yang sama persis dengan paragraf 1.

5) Untuk membatalkan perintah tadi, klik ikon undo atau shortkey
Ctrl+Z, perhatikan yang terjadi, seharusnya bagian akhir paragraf ke-2
akan kembali seperti semula ketika perintah paste belum dilakukan.

6) ulangi langkah a, kemudian klik ikon cut & atau shortkey Ctrl+X
7) simpan kursor di bagian akhir paragraph ke-2

8) klik paste & atau tekan shortkey Ctrl+V, perhatikan perubahan yang
terjadi, seharusnya seluruh kalimat pada paragraf ke-1 akan berpindah
ke akhir paragraf ke-2

9) Simpan dokumen ini dengan nama: Word 1-C

5. Format Dokumen

Format dokumen digunakan untuk melakukan pengaturan-pengaturan isi
dokumen. Ada beberapa fungsi yang bisa digunakan melalui perintah format
dokumen ini, diantaranya untuk pengaturan huruf, pengaturan paragraf,

pengaturan penomoran dan penandaan, serta pengaturan kapitalisasi huruf.

a. Pengaturan Huruf
Beberapa fungsi dari pengaturan huruf adalah untuk menentukan jenis
huruf, ukuran huruf, tebal tipisnya huruf, dan lain sebagainya. Berikut ini

langkah-langkah dalam pengaturan huruf.

1) buka dokumen Word 1-C
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2)

3)

4)

5)
6)

7
8)

blok seluruh isi dokumen dengan menggunakan mouse atau tekan
shortkey Ctrl+A.
Pada bar Home, arahkan mouse ke grup Font

File Home | Insert  Pagelayout  References  Mailings

i

2 Arial AN A Y

Paite .
« o Format Painter BI1

Clipboard Font

dari menu font, tekan tanda panah ke atas dan ke bawah, kemudian
klik pilih jenis huruf Monotype Corsiva.

klik huruf B (Bold).
dari item Size tekan tanda panah ke atas atau ke bawah, kemudian

klik satu kali pada tulisan 20.
perhatikan perubahan yang terjadi
Anda coba klik ikon-ikon lain pada grup Font tersebut dan perhatikan

apa yang terjadi

b. Pengaturan Paragraf

Fungsi dari pengaturan paragraf diantaranya adalah untuk mengatur

perataan paragraf (alignment dan mengatur jarak baris (spasi). Berikut ini

langkah-langkah dalam pengaturan paragraf.

1)
2)

3)

4)

ulangi langkah [1] [2] pada pengaturan huruf

arahkan mouse pada grup paragraph

IHume Insett  Pagelayout  References  Mailings  Review  Wiew  Addlns  Acrobs

, perhatikan perubahan yang terjadi.

b=

pilih ikon center

Klik ikon Line spacing ' , pilih Double, perhatikan perubahan yang

terjadi.
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5) Anda coba klik ikon-ikon lain pada grup Paragraph tersebut dan

perhatikan apa yang terjadi

6. Membuat dan Mengatur Tabel

Pada saat kita membuat suatu dokumen, kadang-kadang kita harus
memasukkan table untuk memperjelas naskah yang kita buat. Berikut ini
akan kita pelajari cara memasukkan dan mengatur tabel dalam suatu

dokumen MS Word melalui Menu Table.

Menu Table mempunyai beberapa sub menu yang dapat digunakan untuk
membuat dan mengatur table yang telah kita buat.

Berikut langkah-langkah kerjanya:

a. Membuat Tabel

1) Pilih tab Insert>Table O ,

2) tandai ke samping kanan 3 kotak, ke bawah 4 kotak dengan
menggerakkan mouse anda, kemudian klik satu kali.
wWid9-ul=
m Home Insert Page Layout References

2 1S B kel E
Cover Blank Page Table Picture Clip Shapes Smart
Page~ Page EBreak = Art w

Pages 3x4 Table io
. I
: I
- I
- I
N I
- I
- I
. I
; j Insert Table...
= _Ij Draw Table
= |§| Excel Spreadsheet
= [ QuickTables

Gambar 5. 5Membuat Tabel
b. Pengaturan Bingkai Tabel

1) buatlah table dengan jumlah kolomnya 5 dan jumlah barisnya 6.
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2) blok kolom ke-3 baris ke-4, Kklik ikon untuk pengaturan border, jika
anda mengklik tanda segitiganya akan muncul pilihan sebagai
berikut:

T d:? T i T -
s R C I
anlR LG I

3) Kklik pilihan ikon No Border(-- ), lihat apa yang terjadi.

4) sekarang blok semua sel yang ada table anda, kemudian klik salah
satu ikon pilihan tadi, perhatikan apa yang terjadi.

5) ulangi langkah d di atas sampai semua ikon pilihan telah anda coba.

lkon Outside Border ( [] ) Untuk memberikan garis batas pada pinggir Iuam

tabel

Ikon All Borders (Hﬂ) Untuk memberikan garis batas pada

keseluruhan cell pada tabel

lkon No Border () Untuk menghilangkan garis batas pada

keseluruhan cell pada tabel /

C.

Menyisipkan Kolom atau Baris pada Tabel

1) buatlah tabel dengan jumlah kolomnya 5 dan jumlah barisnya 5.

2)

tandai baris 1 sampai dengan baris 5 dengan huruf a, b, c, d, e.

a

b

c

d

e

3) simpan kursor di salah satu cell pada baris ke-3

4) klik kanan pada mouse-> insert >Insert Rows Below, apa yang

terjadi dengan tabel yang telah anda buat?
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Akan tersisip 1 baris baru di bawah baris ke-3 dari Tabel di atas.

K Untuk menambah 1 baris diatas cell yang kita pilih, gunakan perintah klik \
kanan—>Insert—>Insert Rows Above

= Untuk menambah 1 kolom pada tabel, gunakan perintah klik kanan—> Insert-=>Columns
to the Left/Right

= Cara cepat untuk menambah baris baru pada bagian bawah suatu tabel adalah dengan
meletakkan cursor pada cell terakhir kemudian tekan tombol Tabpada keyboard

\ )

d. Menghapus Kolom atau Baris pada Tabel

1) buatlah tabel dengan jumlah kolomnya 8 dan jumlah barisnya 5.
2) tandai baris 1 sampai dengan baris 5 dengan angka 1,2,3,4,5 juga
kolom 1sampai dengan 8 dengan angka 1,2,3,....... 8

3) simpan kursor pada baris ke-3 kolom 4

g b~ W N|

4) klik kanan pada mouse, > insert >Insert Rows below, apa yang

terjadi dengan tabel yang telah anda buat?

e. Merge dan Split Cells
1) buatlah table dengan jumlah kolom 8 dan jumlah baris 5
2) Dblok baris ke 3,4, dan 5 kolom 2

w| N|

I
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4)
5)
6)
7

klik kananpada mouse, - klik Merge cells, apa yang terjadi dengan
sel yang ada blok tadi? Cell pada baris ke 3, 4, dan 5 kolom 2 akan
tergabung menjadi satu cell.

klik undo

ulangi langkah ke-2

klik kananpada mouse, =>klik Split cells,

isi Number of columns: 5 dan Number of rows:2, klik OK/Enter, apa
yang terjadi dengan sel yang ada blok tadi?

f. Pengaturan Arah Tekt pada Tabel

1)
2)
3)

buatlah table dengan jumlah kolom 4 dan jumlah baris 5
gabungkan baris 1 sampai dengan baris 4 pada kolom ke-1
buat tulisan MICROSOFT WORD

MICROSOFT
WORD

4) Kklik kananpada mouse, pilih Text Direction,

5) pilih posisi arah tekt yang anda inginkan, tekan OK/Enter, perhatikan

apa yang terjadi.

g. Membuat dan Mengatur Word Art

Pada saat kita membuat suatu dokumen dengan MS Word, terkadang kita

harus menyisipkan tulisan yang indah dan menarik untuk dilihat. Cara

termudah yang dapat dilakukan yaitu dengan cara memasukkan Word

Art. Di sini kita akan mempelajari langkah-langkah memasukkan Word

dan pengaturannya. Adapun langkah-langkahnya sebagai berikut:
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1. buatlah dokumen baru, simpan dokumen ini dengan nama word

art

pilih Tab Insert, 2> pilih ikon WordArt,

pilih salah bentuk tulisan (style) yang anda kehendaki, klik kiri,
pada tulisan Your Text Here tulis INDONESIA, untuk font pilih arial
dengan size 24 bold, kemudian tekan OK/Enter. Perhatikan apa

yang muncul pada dokumen anda.

D. Aktivitas Pembelajaran

Ada beberapa kegiatan pembelajaran yang seharusnyaAnda lakukan untuk

memperdalam penguasaan materi pada materi pokok ini, yaitu:

1.

Langkah 1 :Bukalah program MS Word 2010 ketika mempelajari materi
ini

Langkah 2 : lkutilah semua petunjuk yang ada di materi dengan
mempraktekkan langsung pada program MS Word 2010

Langkah 3 : diskusikan dengan guru lain apabila ada hal yang kurang

jelas.

E. Latihan/Kasus/Tugas

1.

Ketiklah naskah berikut ini:

Pendidikan inklusi merupakan perkembangan terkini dari model
pendidikan bagi anak berkelainan yang secara formal kemudian
ditegaskan dalam pernyataan Salamanca pada Konferensi Dunia tentang
Pendidikan Berkelainan bulan Juni 1994 bahwa prinsip mendasar dari
pendidikan inklusif adalah: selama memungkinkan, semua anak
seyogyanya belajar bersama-sama tanpa memandang kesulitan ataupun

perbedaan yang mungkin ada pada mereka.

Model pendidikan khusus tertua adalah model segregasi yang
menempatkan anak berkelainan di sekolah-sekolah khusus, terpisah dari
teman sebayanya. Sekolah-sekolah ini memiliki kurikulum, metode

mengajar, sarana pembelajaran, system evaluasi, dan guru khusus. Dari
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segi pengelolaan, model segregasi memang menguntungkan, karena

mudah bagi guru dan administrator. Namun demikian, dari sudut pandang
peserta didik, model segregasi merugikan. Disebutkan oleh Reynolds dan
Birch (1988), antara lain bahwa model segregatif tidak menjamin
kesempatan anak berkelainan mengembangkan potensi secara optimal,
karena kurikulum dirancang berbeda dengan kurikulum sekolah biasa.
Kecuali itu, secara filosofis model segregasi tidak logis, karena
menyiapkan peserta didik untuk kelak dapat berintegrasi dengan
masyarakat normal, tetapi mereka dipisahkan dengan masyarakat
normal. Kelemahan lain yang tidak kalah penting adalah bahwa model
segregatif relatif mahal.

simpanlah naskah di atas dengan nama eva-1 dalam folder latihan ms
word.

lanjutkan dengan mengetik naskah berikut ini

Model yang muncul pada pertengahan abad XX adalah model
mainstreaming. Belajar dari berbagai kelemahan model segregatif, model
mainstreaming memungkinkan  berbagai  alternatif = penempatan
pendidikan bagi anak berkelainan. Alternatif yang tersedia mulai dari yang
sangat bebas (kelas biasa penuh) sampai yang paling berbatas (sekolah
khusus sepanjang hari). Oleh karena itu, model ini juga dikenal dengan
model yang paling tidak berbatas (the least restrictive environment),
artinya seorang anak berkelainan harus ditempatkan pada lingkungan
yang paling tidak berbatas menurut potensi dan jenis / tingkat

kelainannya. Secara hirarkis, Deno (1970) mengemukakan alternatif

sebagai berikut:

No Jenis Kelas

Kelas biasa penuh
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4.

Kelas biasa dengan tambahan bimbingan di dalam

Kelas biasa dengan tambahan bimbingan di luar kelas

Kelas khusus dengan kesempatan bergabung di kelas

biasa

Kelas khusus penuh

Sekolah Khusus

Sekolah khusus berasrama.

aturlah halaman naskah di atas dengan batas atas dan batas kanan 3 cm,

batas bawah dan batas kiri 4 cm.

5. simpanlah naskah tersebut dengan nama eva-2

F. Rangkuman

1.

Microsoft Word merupakan salah satu program aplikasi komputer
keluaran Microsoft yang digunakan untuk pengolahan kata
Bagian-bagian dari program MS Word antara lain area kerja, title bar,
menu bar, toolbar, ruler dan scrolbar.

Langkah pertama yang perlu dikuasai dalam bekerja dengan MS word
adalah membuat, menyimpan, membuka dan menutup dokumen.
Pengaturan halaman atau page setup diantaranya digunakan untuk
mengatur batas kertas, arah dokumen, dan mengatur jenis kertas.

Salah satu fasilitas yang disediakan dalam Program MS Word adalah

fasilitas pencetakan dokumen.
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6. Ada beberapa perintah yang ada dan perlu dipelajari dalam menu

clipboard yaitu perintah pemotongan (Cut), penggandaan (Copy), paste,
undo, dan redo.

7. Perintah-perintah yang ada pada menu Paragraph diantaranya perintah
pengaturan huruf (Font), pengaturan paragraf (paragraph), pengaturan
penomoran dan penandaan (Bullets and Numbering) dan pengaturan
kapitalisasi huruf (change Case).

8. Menu Tabel digunakan untuk membuat dan mengatur tabel pada suatu

dokumen.

G. Umpan Balik dan Tindak Lanjut
Cocokkanlah tugas yang telah Anda kerjakan pada bagian E dengan rambu-
rambu jawaban yang terdapat pada bagian H. Apabila tugas Anda sudah
sesuai dengan rambu jawaban, silahkan Anda lanjutkan ke kegiatan
pembelajaran berikutnya. Apabila hasilnya masih belum sesuai, sebaiknya
Anda perbaiki dulu tugas tersebut tersebut.
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KEGIATAN PEMBELAJARAN 6
PENGGUNAAN PERANGKAT LUNAK PENGOLAH

PRESENTASI

A. Tujuan
Materi Pokok yang akan Anda pelajari pada Kegiatan Pembelajaran 6 ini
adalah:
1. Langkah-langkah menjalankan MS PowerPoint 2010
2. Bagian-bagian pada MS PowerPoint 2010
3. Prinsip-Prinsip dalam Pembuatan Dokumen Presentasi

4. Latihan Pembuatan Dokumen Presentasi

B. Indikator Pencapaian Kompetensi
Setelah mempelajari materi pokok 3 tentang Penggunaan Perangkat Lunak
Pengolah Presentasi, diharapkan Anda dapat:
1. Menjelaskan Langkah-langkah menjalankan MS PowerPoint 2010
2. Menerangkan Bagian-bagian pada MS PowerPoint 2010
3. Menerapkan Prinsip-Prinsip dalam Pembuatan Dokumen Presentasi

4. Menguasai teknik Pembuatan Dokumen Presentasi

C. Uraian Materi

1. Pendahuluan
Ada beberapa perangkat lunak presentasi, salah satu yang populer
digunakan adalah PowerPoint. Perangkat lunak PowerPoint merupakan
perangkat lunak yang dikeluarkan oleh Microsoft sehingga program ini

sering disebut dengan Microsoft PowerPoint atau MS PowerPoint.

Pada dasarnya PowerPoint digunakan untuk membuat dokumen atau
media yang bisa ditampilkan untuk keperluan presentasi. Selain itu,

karena fasilitasnya yang lengkap, PowerPoint juga dapat digunakan
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untuk mendesain dokumen presentasi agar tampil menarik, dinamis dan

interaktif.

Pembuatan dokumen presentasi yang menarik, dinamis dan interaktif

memerlukan pengetahuan dan ketrampilan khusus dalam penggunaan

PowerPoint. Untuk itu, pada materi ini akan dibahas secara lengkap dan

mendalam mengenai teknik-teknik penggunaan PowerPoint 2010.

2. Bagian-bagian pada MS PowerPoint 2010

Ada beberapa bagian yang ada dan ditampilkan ketika Program

PowerPoint dijalankan, diantaranya:

dan lembar catatan.

Ribhon

ribbon, tab, Area kerja, daftar slide,

3 o !
/ Paste Mew
| E i1

Shapes Aman

]

Editing

Daftar
Slide

Shde Lof 1

Click to add title

Ares Kerja

HE A

Click to add notes

“Office Theme™ mEEN T

Gambar 5. 6MS Power Point 2010

S0% (—

3. Prinsip-Prinsip dalam Pembuatan Dokumen Presentasi

Seperti

mempunyai

Lembar
Catatan

telah dijelaskan pada bab sebelumnya, PowerPoint 2010

banyak pilihan dan fasiltas yang disediakan untuk

pembuatan dokumen presentasi. Guna mempermudah pembelajaran,

pada materi ini akan dijelaskan prinsip-prinsip yang utama dalam

pembuatan dokumen presentasi dengan menggunakan fasilitas-fasilitas

yang disediakan dalam PowerPoint.
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Pada prinsipnya, ada 6 (enam) hal pokok yang perlu dipelajari dalam

membuat dokumen presentasi, yaitu:
. Pembuatan dokumen baru
. Pengaturan komponen dan objek presentasi

a
b
c. Pengaturan tampilan Slide.
d. Pengaturan efek

e. Penyimpanan dan pencetakan dokumen
f.

Penayangan presentasi

a. Pembuatan Dokumen Baru
Ketika membuka program MS PowerPoint 2010, sebenarnya secara
otomatis akan tersedia dokumen MS PowerPoint 2010 baru yang
masih kosong, Anda tinggal bekerja pada dokumen tersebut dan
kemudian menyimpannya.
Apabila Anda sedang mengerjakan dokumen MS PowerPoint 2010,
dan kemudian ingin membuat dokumen baru, berikut ini langkah-

langkahnya:

1) Klik Tab File=> New.

2] e et MoookPoweomProdtAdmatonfaled |
PRI ore et Desion  Tanstons  Animations  SideShow  Review  View  Acobat
i seve
Available Templates and Themes
Bl swe
@ Home
&5 Open
3 Close E A 1I Fi )
ifo Blank Recent Sample Themes  Mytemplates  New
presentation plates templates exi
Recent =
Office.con plate
print 1 i ﬁ

Save & Send Agendas Award Calendars  Content  Designslides  Diagrams  Envelope: Fiyers
Help
2] Options ¥ [ = i, ©

£3 et

categories

2) pada Kotak Dialog yang muncul pilih Blank presentation
3) Kklik tombol Create, atau double klik pada gambar Blank

presentation.
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4) simpan dokumen presentasi tersebut dengan nama presentasi 1

b. Pengaturan Komponen dan Objek Presentasi

Setelah kita selesai melakukan langkah pembuatan dokumen dokumen
baru, selanjutnya kita dapat mulai mengisi dokumen presentasi dengan

komponen atau objek yang kita kehendaki.

1) Menambah Slide
Penambahan halaman baru (new Slide) pada Program
PowerPoint kita tidak dilakukan dengan menekan tombol Enter
seperti halnya pada Program MS Word. Ada beberapa cara yang
dapat kita lakukan untuk menambahkan slide baru pada
PowerPoint, yaitu:

2) Klik New Slide pada Tab Home

T_

Home Insett [Design Transiti

=]

I ety
Slide - | o) Fection +

Layout =
EReset

3) Atau tekan tombol CTRL+M pada keyboard

4) Memasukkan Text
Salah satu komponen utama yang diperlukan dalam suatu
dokumen presentasi adalah tekt. Kita dapat memasukkan dan
mengatur teks sesuai selera dengan fasilitas yang ada. Berikut
langkah memasukkan dan mengatur teks;
a) klik salah satu Layouts pada Tab Home untuk memilih tata

letak teks yang sesuai.
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5)

Rl e

T | Home Thsert Design Transitions

B = = Layout ~

Animations

Slide Shon Review

Office The me
Paste Mew

Clipboard
Slides Qutline

1 Title Slice

Title and Content

Section Header

T Content

Comparison

Title Only

Blank

Contentwith
Caption

b) misalnya kita pilih Title Slide

Ficture with
Caption

Click to add title

Click to add subtitle

c) Klik pada tulisan “Click to add title” lalu ketikkan teks yang

sesuai.

d) Bila telah selesai maka klik di luar area textbox

e) Untuk menambahkan kotak teks lain gunakan fasilitas Text

Box ( ) yang ada pada tab Insert

Memasukkan Link dan Tombol Navigasi

Program PowerPoint menyediakan kemudahan untuk membuat

link dan tombol navigasi. Kemudahan tersebut tersebut ada pada

fasilitas Hyperlink dan Action Button.

a) Hyperlink
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b)

Pada program PowerPoint, Hyperlink digunakan untuk

menghubungkan suatu tekt atau objek pada suatu slide

dengan slide lain, dengan file lain yang ada di komputer, atau

bahkan dengan file lain yang ada di internet. Langkah
memasukkan Hyperlink adalah sebagai berikut:

(1) pilih objek atau tekt yang akan diberi link.

(2) pilih tab Insert >Hyperlink, bisa juga dengan klik kanan
“>Hyperlink, atau dengan tekan tombol CTRL+K pada
keyboard.

(3) kotak dialog di atas berisi perintah dan pengaturan untuk
menghubungkan objek yang dipilih tadi dengan file atau

halaman lain

(4) klik perintah Existing Files or Web Pages () untuk
menghubungkan dengan file lain yang ada di komputer
atau file pada halaman web di internet

(5) klik perintah Place in This Document (‘ﬂ) untuk
menghubungkan dengan halaman lain yang ada pada

dokumen tersebut.

Action

Pada prinsipnya, Action Button merupakan tombol navigasi

yang berisikan perintah untuk menghubungkan satu slide

dengan slide yang lain. Berikut ini langkah-langkah dalam

penggunaan Action sebagai fasilitas navigasi .

(1) Pilih salah satu objek yang akan diberi perintah navigasi,

(2) pada tab Insert, pilih ikon Action

(3) kolom Hyperlink to: menunjukkan arah navigasi dari
objek yang kita pilih tadi apabila kita klik. Bawaan yang ada
tertera tulisan First Slide yang menandakan bahwa tombol
akan dihubungkan dengan slide pertama pada dokumen,
sesuaikan arah navigasi yang Anda akan tuju.

(4) klik OK atau tekan Enter
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c. Pengaturan Tampilan Slide

Ada dua teknik yang dapat dilakukan untuk mengatur tampilan slide,

yaitu dengan menggunakan grup Themes atau menggunakan

background style.

1)

2)

Menggunakan Themes
Themes merupakan fasilitas yangdigunakan untuk mengatur
tampilan slide dengan menggunakan tema yang ada pada
PowerPoint. Berikut ini langkah untuk menggunakan Themes;
a) pilih tab Design
b) pilih salah satu tema yang sesuai atau
c) Kklik kanan pada salah satu tema
(1) pilih Apply to All Slides untuk menggunakan satu tema
untuk semua slide yang ada
(2) pilih Apply to selected Slides untuk menggunakan
tema untuk slide yang dipilih saja

Cesign Transitions Animations Slide Showe Rewiew: Wiew Acrobat

[——

e 2] e ] ) [ B e [2 [~ |

Apply to All Slides

Apply to Selected Slides

» e eeereeemsseeeesommeseesmseesesmmseseeemseeseeomme e mmseeseeemmeseeemmsseseesmmeseeemmeeseeermmeeseetmmeeseemmeesresmmmeseseeemmseseeemmeeend| || TTTTemmTeesmmesenmssans s [
Setas Default Theme

Themes

Add Gallery to Quick Access Toolbar

0 Clirl, +A adA tavt

Menggunakan Background Styles

Background Styles digunakan untuk merubah tampilan latar dari
slide. Langkah pengaturan background styles adalah sebagai
berikut:

a) Pilih tabdesign—> Background styles
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|| 5T
> @

:| ﬂ F Efolo.rs " [ Backaraund styles -
: o |- -

Apply to Al Slides

[l Apply to Selected Slides

Add Gallery to Quick Access Toolbar

L i | [ I e

b) pilih salah satu warna yang sesuai atau

{Z] Format Background..,

c) klik kanan pada salah satu warna
(3) pilih Apply to All Slides untuk menggunakan satu warna
untuk semua slide yang ada
(4) pilih Apply to selected Slides untuk menggunakan
tema untuk slide yang dipilih saja

d. Pengaturan Efek

Ada dua jenis pengaturan efek yang ada pada PowerPoint, yaitu efek
untuk mengatur animasi pada objek atau teks (Animations) dan efek

untuk mengatur perpindahan slide (Tansitions).

1) Animations
Custom Animation dipergunakan untuk memberikan efek animasi
dan suara pada isi slide. Langkah penggunaan custom animation
adalah sebagai berikut:
a) Pilih tekt atau objek yang akan diberikan animasi
b) pada tab Animations, pilih salah animasi yang tersedia di
sana

e Mo i Bt At
m Home Insert Design Transitions Animations Slide Show Fewi e Wiewr Acrobat

* x X

Preview None

X K U K | W | %

Appear Fade FlyIn FloatIn split Wipe Shape Wheel 5

Preview Animation

¢) untuk pilihan animasi yang lebih banyak Anda dapat memilih
ikon add animation
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ey — 1 e
=@

N T 4 lf,% =30 animation Pane B Start On Click = Rentder &nimation
]-/z . AR } Trigger = O Duration:  02.00 s
Viheel = Effect Add _ .
T Options * | |Animation ¥ @ Delay: o000 2
Entrance -
. A -
Y 1 L -l
.4 T W Lo
Appear Fade Fly In FloatIn Split
# A
-~ W . ¢ =
Wipe Shape Wheel Random Bars  Grow & Turn
1 L3E.] . ~
ey " \,
o Zoam Sivel Bounce
A 4 Emphasis
- SEEAS R0
Pulse Color Pulse Teeter Spin Growgthrink
Desaturate Darken Lighten Transparency  Object Colar
X g X A A
Complemen.. Line Color Fill Calor Brush Color Font Color
u B B
( to a ' Underline Bold Flash Bald Revea Wiiave
Exit
e A 5 A
r K I 1 ¢
- ¢ g ISt
X Disappear Fade Fly Out Float Out Split -
.......... A ! Sk More Entrance Efrects.. 5
4
e F
ﬁ Maore Emphasis Effects... T
#E  More Exit Effects,., »

d) untuk melihat masing-masing efek, Anda dapat mencoba

semua pilihan yang ada di sana.

2) Transitions
Slide transition digunakan untuk memberikan efek pada saat

perpindahan slide. Langkah-langkahnya sebagai berikut:

a) pilih slide yang akan diberi efek
b) pada tab Transition pilih salah satu efek yang disediakan di

sana

511 = - ||
m Haome Insert Cesign Transitions Animations Slide Showe Review e Acrobat

h | B F @ @ 5

Marne Cut Fade Push Wipe Split Reweal Random Bars

Preview Transition to This Slide

c) untuk mengatur durasi dan efek suara, gunakan pilihan-

pilihan yang ada pada grup timing.
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DIk
[

W@

% él;; Sound: [Mo Sound] - Advance Slide
D Duration: oLon = R Mouse Click
Effect N
Options « | 9 Apply To A [ afterr 0m:00.00 2

Timing
d) Anda dapat mencoba semua pilihan yang ada di sana untuk

melihat semua efek yang ada.

e. Penayangan Slide (Slide Show)
Langkah untuk menayangkan slide (Slide Show) adalah sebagai
berikut:

DERRE

ﬁ Hame Insert Design Tranzitions Animations Slide Shoaw

Framm Fram Broadcast Custanm Set Up Hide Fehearse Record Slic
Beginning Current Slide  Rlide Show Slide Show = | Slide Show Slide Timings Showe =
start Slide Showe Set Up

1) pada tab Slide Show, pilih From Beginning untuk
menanyangkan slide dari awal presentasi, atau untuk lebih
singkatnya Anda dapat juga menggunakan tombol F5.

2) pilih From Current Slide untuk menanyangkan slide yang sedang
dipilih

3) pilihan-pilihan lain yang ada pada tab Slide Show tidak akan

dijelaskan di Modul ini

D. Aktivitas Pembelajaran

Ada beberapa kegiatan pembelajaran yang dapat Anda lakukan untuk

memperdalam penguasaan materi pada materi pokok ini, yaitu:

1. Langkah 1 : Bukalah program MS PowerPoint 2010 ketika mempelajari materi
ini

2. Langkah 2: lkutilah semua petunjuk yang ada di materi dengan
mempraktekkan langsung pada program MS PowerPoint 2010

3. Langkah 3 : diskusikan dengan guru lain apabila ada hal yang kurang jelas.
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E. Latihan/Kasus/Tugas

Untuk memperdalam pemahaman anda terhadap materi pokok 3, kerjakan

latihan dibawah ini:

1. Buatlah Dokumen Presentasi dengan nama: “Latihan PowerPoint 1!

2. Slide pertama menggunakan Themes:Radial, Transition: Fade

MEDIA PEMBELAJARAN

Gambar

3. Slide Kedua menggunakan Themes:Median, Transition: Wipe

Tujuan Pembelajaran

Menijelaskan:

o Pengertian media pembelajaran

0 Proses Pembelajaran

0 Manfaat Media Pembelajaran

0 Jenis-jenis Media Pembelajaran

4. Slide

Ketiga menggunakan

Themes:Foundry, Transition: Push
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Penggunaan media dalam pembelajaran di kelas
merupakan sebuah kebutuhan yang tidak dapat
diabaikan

Media pembelajaran merupakan salah satu komponen
pembelajaran yang mempunyai peranan penting
dalam kegiatan Belajar Mengajar.

Seorang siswa belum dapat dikatakan telah belajar
hanya karena ia sedang berada dalam satu ruangan
dengan guru yang sedang mengajar.

F. Rangkuman

1. MS Powerpoint merupakan salah satu program aplikasi komputer
keluaran Microsoft yang digunakan untuk membuat bahan presentasi

2. Komponen penting yang perlu dikuasai dari program MS Powerpoint 2010
antara lain Design, Themes, Transition, dan Animations

3. Ada beberapa cara untuk membuat dokumen presentasi, diantaranya:
dengan Blank Presentation, Sample Templates, dan Themes,

4. Komponen atau objek yang bisa dimasukkan dalam dokumen presentasi
diantaranya slide baru, tekt, wordart, chart, gambar, link, suara dan film

5. Teknik yang digunakan untuk memformat tampilan slide ada 2(dua), yaitu
dengan mengatur Desain Slide (Slide Design) dan mengatur background

slide.

G. Umpan Balik dan Tindak Lanjut

Cocokkanlah tugas yang telah Anda kerjakan pada bagian E dengan rambu-
rambu jawaban yang terdapat pada bagian H. Apabila tugas Anda sudah
sesuai dengan rambu jawaban, silahkan Anda lanjutkan ke kegiatan
pembelajaran berikutnya. Apabila hasilnya masih belum sesuai, sebaiknya

Anda perbaiki dulu tugas tersebut.
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KEGIATAN PEMBELAJARAN 7
PENGGUNAAN PERANGKAT LUNAK

PENGOLAH ANGKA

A. Tujuan
Materi Pokok yang akan Anda pelajari pada Kegiatan Pembelajaran 6 ini adalah:
1. Dasar-dasar MS Excel 2010
2. Teknik Penggunaan MS Excel 2010

B. Indikator Pencapaian Kompetensi
Setelah mempelajari materi pokok 6 tentang Penggunaan Perangkat Lunak
Pengolah Angka ini, diharapkan Anda dapat:
1. Menjelaskan Dasar-dasar MS Excel 2010
2. Menguasai Teknik Penggunaan MS Excel 2010

C. Uraian Materi

1. Pendahuluan

Microsoft Excel adalah salah satu perangkat lunak pengolah angka dari paket
Microsoft Office yangsering dimanfaatkan untuk keperluan menyimpan,
menghitung, dan mengelola data. Jenis data pada program MS Excel berupa
data angka (numerik), teks, dan waktu. Program ini juga dapat digunakan untuk
melakukanberbagai operasi matematika seperti menghitung jumlah
keseluruhan dan jumlah rata-rata. Program ini dapat juga digunakan untuk
analisis statistik dengan menggunakan grafik dan bagan.

Pada Materi Pokok ini, akan dibahas tentang langkah-langkah penggunaan
aplikasi Microsoft Excel antara lain: Pengenalan Dasar-dasar Microsoft Excel
dan Teknik penggunaan Microsoft Excel. Setelah mempelajari materi ini,
diharapkan Anda sebagai guru dapat memanfaatkan program Microsoft Excel

untuk membantu pelaksanaan penilaian, misalnya untuk membuat daftar nilai
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dan mengolahnya. Pada materi ini Program Microsoft Excel yang akan disajikan
adalah Microsoft Excel 2010.

Dasar-Dasar Microsoft Excel 2010

Pada bagian ini akan dibahas langkah-langkah membuka MS. Excel, membuat
dokumen baru, menyimpan, menutup, dan membuka kembali dokumen pada
MS. Excel.

a. Membuka MS. Excel
Ada beberapa cara yang digunakan untuk membuka aplikasi MS. Excel, tapi
cara yang paling umum adalah melalui menu Start, Berikut langkah-
langkahnya;
1) Pilih menu start
2) Klik menu All Programs
3) Pilih Microsoft
4) Klik Microsoft Office 2010

aintenance
. Microsoft Office
| [A] Microsoft Access 2010

|'4__'.| kAicrosoft Excel 2010

|I| bdicrosoft InfoPath Designer 2010
|I| kicrosoft InfoPath Filler 2010
@ blicrosoft OneMote 2010
| Microsoft Outlocok 2010
|E| Plicrosoft PowerPaint 2010
0 [B] Microsoft Publisher 2010
@ bdicrozoft SharePoint Waorkspace 207
(W] Microsoft Ward 2010
. Microsoft Office 2010 Tools
Fobile Partner
. Mero 7 Essentials
SharePoint
. Singing Tutor Duet 2.2 WYin 2k-XP
Startup
. Total Wideo Corverter

TransTool

» Al Programs
-

| Fearch programs and filss Fal |

c. Feature Microsoft Excel 2010
Setelah salah satu langkah di atas Anda lakukan, maka akan tampil buku

kerja (workbook) MS. Excel yang terdiri atas beberapa lembar kerja
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(worksheet). Berikut ini tampilan dan penjelasan feature-feature yang ada

program Excel.

1) File Menu
File menu berisi kumpulan perintah untuk pengoperasian program yang

standar, antara lain:

a)
b)
c)
d)
e)
f)
9)
h)

Save : Menyimpan dokumen

Save As : Menyimpan dokumen dengan nama lain
Open : Membuka dokumen

Close : Menutup dokumen aktif

New : Membuat dokumen baru

Print : Mencetak dokumen

Save & Send : Menyimpan dan mengirimkan dokumen

Exit : Keluar dari aplikasi

2) Workbook

Workbook atau buku kerja merupakan area kerja dalam MS. Excel.

Secara default, pada saat Anda membuat buku kerja yang baru, di

dalamnya terdiri atas beberapa lembar kerja (worksheet). Buku kerja

terdiri atas beberapa bagian, yaitu:

a)

b)
c)
d)

e)

f)

Cell : Ditunjukkan dengan Nomor Baris (Row Number) dan Nomor
Kolom (Column Number)

Function : Fungsi-fungsi yang dapat digunakan di Excel

Formula Bar memuat informasi mengenai isi sel yang sedang aktif
Range : Menampilkan posisi cell aktif

Vertical Scroll : Penggulung layar/lembar kerja secara vertical (ke atas
atau ke bawah)

Horizontal Scroll : Penggulung layar/lembar kerja secara horizontal

(ke kiri atau ke kanan)

3. Teknik penggunaan Microsoft Excel 2010

a. Menuliskan Data pada Lembar Kerja (Worksheet)
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Program MS. Excel mengkategorikan 3 jenis data yang dapat dimasukkan ke

dalam lembar kerja, yaitu:
1) Teks (Label)

2)

Pemasukkan data yang berjenis teks (label) berupa kombinasi dari angka,
spasi dan karakter-karakter non-numerik.

Contoh: Nama, Alamatl, Dua2nya, dan lain-lain.

MS. Excel secara otomatis akan mengatur teks yang diketikkan rata Kkiri,
untuk mengubah pengaturan ini dapat dilakukan melalui menu Format,

Cells dan Alignment

Angka (Numeric)

Jika Anda mengetikkan angka dengan pecahan desimal, pemisah desimal
ditulis dengan Titik (.). bukan koma (,), hal ini dikarenakan biasanya
pengaturan standar di control panel pada komputer kita menggunakan
English Setting

Contoh: 0.999
8.9234
Dst.

Langkah untuk memasukkan data baik teks maupun angka caranya

sebagai berikut::

a) Aktitkan atau sorot dahulu sel yang akan diisi dengan cara klik
dengan mouse atau keyboard sampai sel tersebut diberi bingkai.

b) Ketikkan data yang akan dimasukkan

c) Jika selesai tekan tombol Enter.
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Gambar 7. 1langkah memasukkan data

b. Mengatur Kolom dan Baris
Ketika buku kerja Excel pertama kali dibuka, akan tampil kolom dan baris
pada lembar kerja sesuai dengan default-nya. Program MS. Excel
memberikan kemudahan untuk melakukan pengaturan kolom dan baris sesuai

dengan kebutuhan pengguna.

1) Mengatur Lebar Kolom
a) Siapkan tabel seperti contoh di bawah ini:

No. Nama Barang Harga | Satuan Jumlah
1. | Spidol Whiteboard 8500
2. Kertas A4 80Gram 43000
3. | 3 Penghapus Whiteboard 5000
4. | Tinta Printer 35000
5. | Refill Spidol Whiteboard 2000

Tabel 7. 17Tombol Keyboard dan Fungsinya dalam MS. Excel

Catatan: Apabila ditemui ada teks terpotong tetap lanjutkan
pengetikan di sel sampingnya.

(1) Arahkan kursor ke bagian atas worksheet,

A B C D E

(2) arahkan pada bagian tepi kanan kolom yang ingin disesuaikan

1

lebar kolomnya sampai kursor berubah bentuk menjadi ,
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(3) klik dan drag kursor ke arah kiri atau kanan untuk mengubah lebar

kolom.
F9 - =
A B 4 cC D E

1 MO MAMNMA BARAMG HARGA SATUAM JUMNMLAKH
2 1 Spidol Whiteboe 8500
3 2 Kertas A4 S80Grr 42000
a 2 Penghapus Whit 5000
5 4 Tinta Printer 25000
5] 5 Refill Spidol Whi 2000
7

Untuk mengubah lebar kolom sesuai isi sel terpanjang secara cepat
dapat dilakukan dengan melakukan klik dua kali.

2) Mengatur Tinggi Baris
Untuk mengatur tinggi baris langkahnya hampir sama dengan langkah
mengatur lebar kolom, bedanya kursor diarahkan di sebelah Kkiri

worksheet, bukan di sebelah atas.

A

Kursor arahkan ke sini

Ul B W N -

c. Menghapus Kolom
Untuk menghapus kolom pada area kerja, dapat dilakukan langkah-langkah
sebagai berikut:
1) Arahkan kursor ke cell yang ingin dihapus
2) Klik ikon Delete
3) Klik ikon Delete Cells
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E Haome Insert Page Layout Formulas Data Review Wiewr Add-Ins Acrobat

£

Paste

o) I 00 BRI SR USSR (S R T

& Arial =11 - A AT General
By -
¥ B 7 U~ - Sy~ = $ v % o
Clipboard = - Font e Alignment Mumber
A B C
NO Nama Barang Harga
1|Spidol Whiteboard 8500
2 |Kertas A4 80Gram 43000
3|Penghapus Whiteboard | 5000
4|Tinta Printer 35000
Refill Spidol Whiteboard| 2000

|
0 ;00 Conditional  Fori
Yoo 5.0
> Formatting = as TableSSStvles ~

Shyley

3

D E

d. Menggabungkan Beberapa Sel (Merge Cell)

o @
galnsert~  E v :\_|7 g
T Delete||  [g] - FFJ‘ . :j
4% Delete Cells...
=& Delete Sheet Rows

' pelete sheet Columns

| Delete Sheet

Program MS. Excel menyediakan fasilitas untuk melakukan penggabungan

beberapa sel dengan cara menggunakan Merge & Center agar isi sel yang

bersangkutan berada di tengah-tengah hasil sel yang digabungkan, contoh:
Sebuah teks diisikan pada sel B2 “LATIHAN MERGER” akan digabungkan
beberapa sel dari B2:D2

A B & D

|LATIHAN f!n. ERGER Menjadi

Langkah-langkahnya adalah:

1.

2.

LATIHAN MERGER

isikan teks “LATIHAN MERGER” di sel B2

A B C D

2 |LATIHAN .IJ ERGER

blok sel B2 sampai dengan D2
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3.

A B C D

1

2 [LATIHAN MERGER I
3

klik ikon Merge & Center pada Tab Home

= %
=l g

Paste

Calibri

Clipboard
B2
I B

B 7

Insert Page Layout Formulas Data
-1 - A = == ¥
u-|lE- Al ===
Font Alignment
- Je | LATIHAN MERGER
C ] E F

|LaTiHAM MERSER

S R IR R R TR S

1 2

e. Teks Menggulung (Wrap Text)

Untuk membuat dalam sebuah sel

fasilias wrap text
Contoh:

l

INI CONTIH WRARTEXT

Menjadi

Adapun langkah-langkah yang dilakukan adalah:

1) Isikan teks pada B2 “INl CONTOH WRAP TEXT”
A B

IINI CGNTF:IJ. HWRAP TEXT

C

2) Pilih atau blok sel-sel yang akan digulung
3) Klik tab home

4) Klik Ikon Wrap Text pada grup Alignment
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e
General v
$ v %
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AR
kerge & Center
Merge Across

Merge Cells

Unmerge Cells

terisi beberapa teks dapat

Add-Ins

Acrobat

) Conditional Format
i35 Format as Table ~
(= Cell Styles =

Styles

Merge & Center

Excel

FERE

Excel
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\) Press F1 for more
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f.

General M

[
]
[l

L

N
! 3 Horne Ihsert Page Layout Farmulas Data Rewview ey A1
& Calibri 11 v A A 4

J By - _ $ v o9y 9
Paste ¥ B 7 U~ iie| dy~ é’ = = 0 LT

00 .0

[

k3
ek
4

Clipboard Font Aligrrnent Mumber
B2 - Fe | IMI COMTOH WRAP TEKS Wrap Text

A B C (] E F
1 Microsoft B

2 li
IINI CONTa].H WRAF TEKS ‘

Microsoft
1 2 1 Excel
2

\j Press F1 for more h

[ . T, T ST A

Penggunaan Rumus (Formula)
Program Excel disertakan dengan kemampuan mengolah data berdasarkan
rumus yang kita masukkan. Penulisan rumus tersebut harus diawali dengan

tanda sama dengan (=), Contohnya sebagai berikut:

SUM <0 X V| =azaad

A A

2 69{ 2 69
3 37 3 37
4 21 4 21
5 =A2+A3+A4 5 127

Gambar 7. 2Contoh rumus

PPPPTK TK DAN PLB BANDUNG
© 2016



Pada gambar di atas dapat dilihat penulisan rumus penjumlahan pada sel A5

dan hasilnya.

Sebenarnya, ada banyak sekali fungsi matematika yang dapatr ditulis
rumusnya dengan menggunakan Program MS Excel ini, tapi pada modul ini
hanya akan dibahas beberapa fungsi saja yang kemungkinan paling sering

digunakan oleh guru. Berikut ini penjelasan dari beberapa fungsi tersebut;

1) Fungsi SUM
Fungsi ini digunakan untuk mencari hasil dari penjumlahan beberapa sel
dan atau range.
Cara penulisannya:
=SUM(numberl,[number2],...)
Contoh:
=SUM(A1:A10) =jumlah sel A1 sampai dengan Al10

&
1| 3
7 5
3 7
4 6
5 4
6 12
7 3
3 10
3 12

10 13
11 =sum(m,mnjl

a .

2) Fungsi MAX
Fungsi ini digunakan untuk mencari nilai tertinggi/terbesar dari beberapa
sel dan atau range.
Cara penulisannya:
=MAX(numberl,[number2],...)
Contoh:
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3)

4)

=MAX(A1:A10)
=MAX(A1, A5:A10)

MIN

Fungsi ini digunakan untuk mencari nilai terendah/terendah dari beberapa
sel dan atau range.

Cara penulisannya:

=MIN(numberl,[number2],...)

Contoh:

=MIN(A1:A10)

=MIN(A1, A5:A10)

=MIN(numberl,[number2]

FUNGSI AVERAGE

Fungsi ini digunakan untuk mencari nilai rata-rata dari beberapa sel dan
atau range, cara penulisannya:

=AVERAGE(numberl,[number?2],...)

Contoh:

=AVERAGE(A1:A10)

=AVERAGE(A1, A5:A10)

/- Penulisan Nama Fungsi dan Formula tidak dipengaruhi hm

besar/kapital atau spasi MS.

e Penggunaan tanda (,) atau (;) bisa jadi berbeda antar komputer,
tergantung setting control panelnya

e Excel akan memberi panduan atau bentuk penulisan formula pada
saat mengetikkan tanda “=” sama dengan kemudian dilanjutkan

ll(ll

dengan nama fungsinya dan tanda kurung buka, akan tampil

seperti gambar di bawah ini:

[=sum(

\ | SUM(number1, [number], ...) | /

PPPPTK TK DAN PLB BANDUNG
© 2016




5) FungsilF
Fungsi ini merupakan salah satu fungsi logika. Fungsi IF digunakan untuk

menentukan nilai yang bergantung pada suatu kondisi yang mempunyai
nilai benar (TRUE) atau salah (FALSE). Cara penulisan fungsi IF adalah
sebagai berikut.

=IF(kondisi;nilai_jika_benar;nilai_jika_salah)

Contoh =IF(C4>=60;“Lulus”;*Tidak Lulus”)

Di atas adalah contoh rumus fungsi untuk mengetahui siapa saja siswa
yang lulus dan yang tidak lulus. Ketentuannya siswa yang “Lulus” adalah
siswa yang nilainya di atas atau sama dengan 60. Sedangkan yang
kurang dari 60 dinyatakan “Tidak Lulus”.

Adapun contoh langkah penggunaannya adalah sebagai berikut:

a) Masukkan daftar nilai siswa ke dalam worksheet seperti berikut:

I - I

A B C D
1 DAFTAR NILAI
2
3 NO|NAMA  |NILAI KETERANGAN
4 | 1|Budi 30
5 2|Dodi 45
6 | 3|lma 60
7 4|Doni 70
8  5|Dewi 35

b) Masukkan rumus fungsi IF seperti di atas pada cell D4

A B C D E F G
1 DAFTAR NILAI
2
3 NO|NAMA [NILAI  [KETERANGAN |
! 1|Budi BD} =IF{C4==60;"Lulus";"Tidak Lulus")
5 2|Dodi 45| [ IFlogical_test; [value_if true]; [value_if_false]) |
B 3[lma 60
7 4|Doni 70
8 S1Dewi 35

c) Tekan Enter, dan Copy formula tersebut untuk cell-cell berikutnya

d) Hasilnya akan seperti di bawah ini:
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D4 - Je | =IF[CA==t

A B C D
1 DAFTAR MILAI
2
3 NO|NAMA MILAI KETERANGAN
4 1|Budi 90| Lwlus
5 2|Dodi 45| Tidak Lulus
] 3|Ima B0 Lwlus
7 4|Doni 70(|Lulus
g 5| Dewi 35(Tidak Lulus
9 =
Simbol Operator Fungsi:
No. Simbol Fungsi
1. |> Lebih kecil
2. | >= Lebih kecil sama dengan
3. | < Lebih besar
4, | <= Lebih besar sama dengan
5 | <> Tidak sama dengan
6. |= Sama dengan

g. Pembuatan Grafik
Grafik adalah suatu penyajian atau pemahaman data dalam bentuk gambar.
Misalnya dalam bentuk garis (Line), batang (Columns/Bar), lingkaran (Pie), atau
gambar lainnya. Tampilan tabel dalam bentuk grafik (Chart) akan memudahkan kita
untuk membandingkan dan menarik kesimpulan dari data tersebut.
Berikut adalah contoh pembuatan grafik pada excel:

1) Buatlah tabel seperti di bawah ini:
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1
2
3
4
5
6
7
]

A B C D E
DAFTAR PERKEMBANGAN NILAI SISWA
NO |[NAMA |2010/2011 (2011/2012 |(2012/2013
1|Budi 78 79 80
2|Dodi 79 70 60
3|{Ima 70 70 71
4|Doni 80 88 90
5|Dewi 87 75 75
2) Blok tabel mulai dari sel B4 sampai E8
A B C D E
DAFTAR PERKEMBANGAN NILAI SISWA
NO [NAMA |2010/2011 (20112012 |2012/2013
1|Budi 78 79 80
2| Dodi 79 70 60
3|Ima 70 70 71
4|Doni 80 88 90
5| Dewi 87 75 75

3) Pada tab Insert pilih salah satu Charts yang tersedia, misalnya Column

1
2
3
4
5
i)
7
a8

4) Pilih salah satu jenis Charts Column yang sesuai

[ 9~ &= LATI
E Home Insert Page Layout Formulas Data Review View
= HE ) S A .o,
i j bdl 52 1P 2 G il X @ = &l | |
PivotTable Table | Picture Clip Shapes SmartArt S& U | |Column| Line Pie Bar  Area Scatter |
- Art - - - - - - - - C
Tables Illustrations 2-D Column
B4 - f« | Budi
f | Budi 4 m qD ‘
A B C D 1 q | |
1 DAFTAR PERKEMBANGAN NILAI SISWA e Clustered Column
2 Compare \.-'aIL_les across categories
3 NO |NAMA 2010',2011 2011',2012 201212013 Lmj by using vertical rectangles.
a4 1{Budi 78 = 30 Use it when the order of categories
" X is not important or for displaying
5 2|Dadi 79 70 60| | cylinds jtem counts such as a histogram.
6 3lma 70 70 71 i} - = N
7 [ slen s ) e 1Y) G0
g | s|pewi 87 75 B | — — —
g Cone
10 i [ A
! 2 i i M i A |’} j
11 gla| LAL | |4
12 p .
1 yrami
14 Jr J A J&,} |adh
i L |
15 Wb AL |80 |
16
il AN chart Types..
17
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5) Jika langkah Anda benar, akan muncul tampilan grafik seperti di bawabh ini:

EH 9 - c LATIHAN - Microsoft Excel | Chart Tools |
g Home Insert Page Layout Formulas Data Review View Design Layout Format
IS Calibri(Body) T 10 v A AT = = — ¥ -
53 Copy ~ =5
Paste B Z Uu- @ & - é - = | &£ 5= | [ Merge & Center - | B8 - g, 4 | %0 .00
Clipboard Font Alignment Mumber styl
Chart 2 - Fx
A B C D E F G H 1 ] K L M
1 | DAFTAR PERKEMBANGAN NILAI SISWA 100
7
3 NO [NAMA |2010/2011 |2011/2012 |2012/2013 | | °°
4 1[Budi 78 79 Bo| | 80
s | 2|pedi 79 70 60| | 70
& 3lima 70 70 7 | e
7 4|Doni 20 28 90 © W Seriesl
g | s5|Dewi 87 75, 75 B Series?
40 R
9 Series3
10 30
11 20
12 10
13 0
14 Budi Dodi Ima Doni Dewi

15

6) Coba Anda pilih Jenis Chart yang lain
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D. Aktivitas Pembelajaran

Ada beberapa kegiatan pembelajaran yang sebaiknyaAnda lakukan untuk

memperdalam penguasaan materi pada materi pokok ini, yaitu:

1. Langkah 1 :Bukalah program MS Word 2010 ketika mempelajari materi ini
2. Langkah 2
mempraktekkan langsung pada program MS Word 2010

Ikutilah semua petunjuk yang ada di materi dengan

3. Langkah 3: diskusikan dengan guru lain apabila ada hal yang kurang jelas.

E. Latihan/ Kasus /Tugas

Untuk memperdalam pemahaman Anda tentang materi ini, lakukan latihan di bawah

ini

1. Buka MS. Excel

Simpan dengan nama “Tugas”

3. Beri nama Sheetl, Sheet2 dan Sheet3 dengan nama Latihan 1, Latihan 2 dan
Latihan 3
4. pada sheet Latihan 2 masukkan data seperti di bawah ini

o =] = o E
1 DAFTAR MNILAI ULANGAMN HARILAMN
2 SEMESTER 1
3 TAHUN 20014/2015
A
5
MARAA
NO MIS NILAI  (KETERANGAM

m

PESERTA DIDIK

1 4231192

Al Susani

2 42311393

Budi Mugraho

=]

=] 4231178

Caca handoko

10

£ 4231170

Mlelody Aulia

11

=] 4231176

Rangga Hakim

1z

3] 4231182

Satya Arianto

13
14
15
16

HMilai Terbesar

Milai Terkecil

Milai Rata-rata

5. Dengan menggunakan formula, lengkapi nilai terbesar, terkecil dan nilai rata-

rata.

6. Dengan menggunakan rumus, isi bagian keterangan dengan ketentuan:
Jika NILAI = 2.67, maka KETERANGAN terisi “Tuntas”
Jika NILAI < 2.67, maka KETERANGAN terisi “Belum Tuntas”
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F. Rangkuman
1.

10.

11.

Ms Excel merupakan apliklasi pengolah angka merupakan perangkat lunak yang
digunakan untuk mengolah dokumen yang melibatkan perhitungan-perhitungan
baik sederhana maupun kompleks dengan menggunakan rumus.

Jenis tipe data pada MSEXxcel:

a. angka (numerik);

b. teks;

c. tanggal dan waktu (jam).

Menu pada aplikasi Microsoft Office Excel 2010 yang digunakan untuk
menangani dokumen disajikan dalam bentuk ikon-ikon yang ditampilkan dalam
beberapa tab pada ribbon.

Ikon-ikon pada masing-masing tab terbagi menjadi beberapa kelompok sesuai
kriteria tertentu.

Perintah-perintah yang sering digunakan dapat ditampilkan pada quick access
toolbar.

Untuk membuat dokumen baru pada Microsoft Office Excel 2007, tekan Ctrl + N.
Untuk menyimpan dokumen Microsoft Office Excel 2010, klik Menu File >Save
As >Excel Workbook. Pada dialog Save tentukan lokasi dan nama file kemudian
klik Save.

Fasilitas utama aplikasi pengolah angka adalah fungsi.

Fungsi pada aplikasi Microsoft Office Excel 2010 yang sering digunakan antara
lain conditional function (IF, AND, OR, dan NOT), statistical function (SUM,
AVERAGE) math function (MIN, MAX)

Untuk mencetak dokumen Microsoft Office Excel 2010, sesuaikan dulu setting

dokumennya agar sesuai dengan data yang akan dicetak.

. Umpan Balik dan Tindak Lanjut

Cocokkanlah tugas yang telah Anda kerjakan pada bagian E dengan rambu-rambu

jawaban yang terdapat pada bagian H. Apabila tugas Anda sudah sesuai dengan

rambu jawaban, BERARTI Anda sudah menguasai kompetensi pada materi ini,

apabila hasilnya masih belum sesuai, sebaiknya Anda perbaiki dulu tugas tersebut

tersebut.
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KUNCI JAWABAN

Kegiatan Pembelajaran 1

1. C. selama dan sesudah proses pembelajaran berlangsung

o M oD

D. standar yang telah ditetapkan
B. penilaian formatif

C. pembinaan

Kegiatan Pembelajaran 2

A. kemampuan dasar anak, kompleksitas, dan daya dukung

1. B. melaksanakan pembelajaran sesuai buku siswa

identifikasi, melakukan perencanaan, melaksanakan

2. B.
penilaian
3. C. adaptif

remedial,

melakukan

4. C. melakukan perbaikan pembelajaran sesuai dengan kesulitan peserta didik

tersebut

5. D. menambah wawasan atau memperluas pengetahuan dalam materi pelajaran

yang telah dipelajari

Kegiatan Pembelajaran 3

1. A. modus

o > 0N

D. rata-rata NH, NUTS, dan NUAS
D. deskripsi
C. 85,83

D. optimum

Kegiatan Pembelajaran 4

No

Nama Peralatan

Fungsi

Speaker

Komputer

Keyboard

AWIN|F

Monitor LCD

Lihat penjelasan pada Materi Periferal
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5

Printer

6

Mouse

Kegiatan Pembelajaran 5

Tugas Anda dinyatakan sesuai dengan bila:

4.

© N o o

Isi teks sama persis dengan yang ditugaskan

Jenis dan ukuran huruf yang digunakan sesuai dengan yang diminta
Menggunakan fasilitas WordArt pada penomoran di table

Batas halaman sesuai dengan ketentuan

Dokumen disimpan dalam folder dengan nama yang ditugaskan.

Kegiatan Pembelajaran 6

Tugas Anda dinyatakan sesuai dengan bila:

1.

Isi teks sama persis dengan yang ditugaskan

2. Jenis dan ukuran huruf yang digunakan sesuai dengan yang diminta
3.
4

Jenis Themes yang digunakan sesuai dengan yang ditugaskan

Menggunakan jenis transisi dan animasi yang sama dengan yang diminta.

Kegiatan Pembelajaran 7

53Tugas Anda dinyatakan sesuai dengan bila:

N o ok~ wDbh e

Nama dokumen sesuai yang ditugaskan

Nama sheet telah diubah sesuai dengan yang diminta

Data dimasukkan pada sheet yang diminta

Isi dan tampilan data sama dengan contoh

Batas halaman sesuai dengan ketentuan

Dokumen disimpan dalam folder dengan nama yang ditugaskan.

nilai terbesar, terkecil dan nilai rata-rata terisi tepat dengan menggunakan fungsi
MAX, MIN dan AVERAGE

Bagian keterangan terisi dengan keterangan yang tepat dengan menggunakan

rumus fungsi IF.
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EVALUASI

Pilinlah jawaban yang benar dengan cara memberi tanda silang (X) pada huruf A, B, C,

atau D yang mewakili jawaban yang paling benar!

1. Penilaian hasil belajar oleh pendidik dilakukan ....

A.

sesudah proses pembelajaran berlangsung

B. selama dan sesudah proses pembelajaran berlangsung
C.
D

. sebelum, selama dan sesudah proses pembelajaran berlangsung

sebelum dan sesudah proses pembelajaran berlangsung

2. Penilaian hasil belajar menggunakan Penilaian Acuan Kriteria, hal ini berarti

bahwa kedudukan relatif peserta didik dibandingkan dengan....

A.

kriteria Ketuntasan Minimal

B. standar yang telah ditetapkan
C.
D. peserta didik lain di dalam kelompok

peserta didik lain di dalam kelas

3. Penilaian yang bertujuan untuk menentukan kenaikan atau kelulusan adalah....

A.

penilaian harian

B. penilaian formatif
C.
D

. penilaian sikap

penilaian sumatif

4. Ketika ada peserta didik yang hasil penilaian KI3 nya di bawah KKM maka

langkah yang dilakukan guru adalah melakukan....

A.

remedial

B. pengayaan
C.
D

. kegiatan latihan

pembinaan

5. Kiriteria Ketuntasan Minimal di sekolah luar biasa didasarkan kepada....

A.
B.

kemampuan dasar anak, kedalaman materi, dan SKL sekolah

kemampuan dasar anak, harapan orangtua, dan SKL sekolah
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C.
D.

kedalaman materi, kemampuan dasar anak, dan harapan masyarakat

harapan anak, kemampuan dasar anak, dan kedalaman materi

6. Langkah paling tepat yang dilakukan guru bagi peserta didik yang memiliki

kecepatan menuntaskan kompetensi lebih cepat dibandingkan RPP yang

disusun adalah....

A.

memberikan materi tambahan yang lebih menantang

B. melaksanakan pembelajaran sesuai buku siswa
C.
D

. memberi materi yang sama dengan cara yang berbeda

memberi pembelajaran tambahan untuk materi yang sama

7. Urutan yang tepat dalam melaksanakan pembelajaran pengayaan adalah....

A.

B.

identifikasi, melakukan perencanaan, melaksanakan pengayaan, melakukan

penilaian

. melakukan perencanaan, identifikasi, melaksanakan pengayaan, melakukan

penilaian

melakukan penilaian, identifikasi, melakukan perencanaan, melaksanakan
pengayaan

melakukan penilaian, melakukan perencanaan, identifikasi, melaksanakan

pengayaan

8. Pembelajaran remedial perlu menggunakan berbagai metode pembelajaran dan
metode penilaian yang sesuai dengan karakteristik peserta didik, hal ini sesuai
dengan prinsip....

A. fleksibilitas

B. interaktif

C. adaptif

D. umpan balik segera

9. Ketika seorang peserta didik teridentifikasi mengalami kesulitan dalam
menguasai materi KD yang sedang berlangsung, tindakan paling tepat dilakukan
guru adalah....

A. segera melaksanakan tes dan melihat hasil tes tersebut

terus menyelesaikan materi sampai tuntas baru melakukan remedial
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C.
D.

melakukan pembelajaran remedial setelah peserta didik melaksanakan tes

melakukan perbaikan pembelajaran sesuai dengan kesulitan peserta didik

10. Program pembelajaran pengayaan dimaksudkan untuk....

A.
B.
C.

memberi pembelajaran tambahan untuk materi yang sama
memperkaya materi bagi peserta didik yang kurang menguasai materi
mengisi waktu yang dimiliki peserta didik yang telah menyelesaikan materi

sebelum waktunya selesai

. memperluas pengetahuan dalam materi pelajaran yang telah dipelajari

11. Hasil akhir penilaian kompetensi sikap diperoleh dengan melihat pada....

A.

modus

B. mean
C.
D

. maximum

median

12. Hasil akhir penilaian kompetensi pengetahuan diperoleh dengan melihat pada....

A.

nilai harian

B. nilai ulangan tengah semester
C.
D. rata-rata dari NH, NUTS, dan NUAS

nilai ulangan akhir semester

13. Laporan capaian kompetensi peserta didik dilaporkan kepada orangtua peserta
didik dalam bentuk....

A
B. nilai 1-100
C.

D. deskripsi

nilai 1-4

huruf A-D

14. Perhatikan tabel hasil rekapitulasi penilaian pengetahuan berikut.

UTS | UAS NILAI KONVERSI
KD Tema | Tema | Tema | Tema AKHIR NILAI
1 2 3 4
3.1 70 ; 60 70 | 60 | 70
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UTS | UAS | NILAl | KONVERSI
KD Tema | Tema | Tema | Tema AKHIR NILAI
1 2 3 4
3.4 ; 90 85 ; 90 | 80
3.5 60 80 ] 70 | 80 | 80

Berapakah nilai akhir yang diperoleh untuk KD 3.1?

A. 60,00
B. 65,75
C. 65,55
D. 66,25

15. Seorang peserta didik dinyatakan memenuhi KKM untuk pengetahuan jika nilai
akhir yang diperoleh adalah....

A. > 266
B. >267
C. >2,66
D. > 2,67

16. Berikut ini adalah fungsi dari sistem operasi, kecuali...

A. melakukan kontrol dan manajemen hardware

melakukan operasi-operasi dasar komputer

B
C. mengatur kestabilan arus listrik
D

menjalankan software aplikasi.

17. Berikut ini sistem operasi yang dikeluarkan oleh Microsoft, kecuali...
A. Microsoft Office 2000

B. DOS
C. LINUX
D

Windows Vista

18. Sistem operasi yang merupakan GPL (General Public Licence) adalah...
A. Windows 2000

UNIX

B
C. Macintosh
D

Linux
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19.

20.

21.

Berdasarkan bahan pencetak hasilnya, tiga jenis printer yang umum digunakan adalah...
A. Printer Dot Matrik, Printer Ink Jet dan Printer Laser jet

B. Printer Dot Laser, Printer Ink Jet dan Printer Laser jet
C. Printer Dot Matrik, Printer Laser Ink dan Printer Laser jet
D. Printer Dot Matrik, Printer Ink Jet dan Printer Laser Ink

Salah satu fasilitas dari sistem operasi Windows yang sering digunakan untuk
melakukan manajemen file adalah...

A. Windows Update

B. Windows Accesories

C. Windows Catalog

D. Windows Explorer

Berikut ini contoh dokumen yang dapat dibuat dengan menggunakan program MS Word,
kecuali...

A. Surat
B. Skripsi
C. Buku

D. Animasi

22. Papan yang menampung Tab-tab seperti; File, Home, Insert, dan Page Layout

disebut...

A. Title Bar
B. Menu Bar
C. Ribbon
D. Ikon

23. Perintah yang terdapat pada Tab file antara lain...

A. New, Open, Save, Find
B. New, Open, Save As, Print
C. New, Save, Save As, Tabs

D. Open, Save, Print, Split
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24. Grup Font, Clipboard, dan Paragraph terdapat pada Tab...
A. File
B. Insert

C. Home
D. View

25. Fungsi perintah Text Direction adalah...
A. untuk mengatur arah text
B. untuk mengatur ketebalan tekt
C. untuk mengatur paragraf
D

. untuk mengatur tabulasi pada suatu teks

26. Ikon yang digunakan untuk menggandakan suatu tekt atau objek tertentu

adalah...
A. K -
B

C.

D &

27. Fungsi ikon [& adalah untuk...
A. mencari dokumen yang berisi teks tertentu
B. mencari tekt tertentu
C. melihat susunan paragraf pada dokumen
D

melihat tampilan dokumen yang akan dicetak

28. Perintah yang digunakan untuk menyimpan dokumen dengan nama atau tipe
yang baru adalah...
A. File>Save
B. File>Save As...
C. File>Save as Web Page
D. File->Close
29. Pilihan orientation digunakan untuk membuat suatu dokumen berbentuk

mendatar adalah...
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30. Perintah yang digunakan untuk menutup dokumen MS Word yang sedang aktif

oo ® >

Potrait

Landscape
Letter

Normal

adalah...

A. File>Close

B. File>Recent
C. File>Save

D. File>Save As

31. Ikon untuk melakukan perintah paste adalah...

Ep
A
g. B

32. Perintah untuk memotong suatu tekt atau objek tertentu adalah...
A.

33. Pilihan yang bisa digunakan untuk pengaturan garis batas pada suatu halaman

B
C.
D

&

Copy
Cut

Paste
Redo

adalah...

A. Margins

B. Orientation

C. Shading

D. Page Shading
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34. Apabila kalimat "SMA Negeri Batujajar” dikenai perintah format->Change
Case>UPPERCASE, akan menjadi...

A.

B.
C.
D.

SMA NEGERI BATUJAJAR
sma negeri batujajar
sma NEGERI bATUJAJAR

Sma Negeri Batujajar

35. Tanda L menunjukkan ikon...

A.

B
C.
D

All Borders
Outside Border
No Border

Bottom Border

36. Perintah untuk menambahkan baris pada suatu tabel adalah...

A.

B
C.
D

Table->Insert>Table
Table->Insert->Column to the Left
Table->Insert->Column to the Right
Table~>Insert->Rows Above

37. Tombol pada keyboard yang dapat digunakan untuk menambah baris pada suatu

tabel adalah...
A. tombol Shift
B. tombol Enter
C. tombol Tab
D. tombol F1

38. Sub menu yang digunakan untuk menggabungkan beberapa cell pada suatu

tabel menjadi satu cell adalah

A.

B
C.
D

Merge Cells
Split Cells
Draw Table
Delete Table
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39. Di bawabh ini beberapa istilah dalam memulai membuat presentasi awal

menggunakan PowerPoint, kecuali...
A. Blank Presentation
B. From Outline
C. From Design Template
D.

From Exiting Presentation

40. Jika kita memulai membuat presentasi dengan bantuan Theme yang disediakan
oleh Power Point, maka menggunakan fasilitas...
A. Recent templates
B. Blank presentation
C. Sample templates
D. My templates

41. Agar presentasi lebih menarik, pada PowerPoint objek dapat dibuat bergerak,
untuk menggerakkan objek tersebut bisa dengan menggunakan fasilitas....
A. Slide Transition

B. Animation
C. Action Settings
D. Set Up Show

42. Untuk menampilkan atau menjalankan file presentasi adalah
A. Kilik slide show->Monitor
B. Kilik slide show->Rehearse Timing
C. Kilik print preview
D. Kilik slide show—>From Beginning

43. Fungsi dari perintah Animation adalah...
A. menambah dan mengatur efek animasi pada suatu objek dalam slide
B. mengatur lamanya waktu penayangan slide-slide.
C. menayangkan slide-slide presentasi dimulai pada slide pertama.
D

menambah dan mengatur efek pada saat perpindahan slide.

44. Fungsi ikon — adalah untuk...
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45,

46.

47.

48.

49.

menambahkan slide baru

mengatur desain pada suatu slide
mengatur efek dan desain slide

oo ® >

mengatur latar slide

Jika pada name box tertulis AA24 maka sel aktif terletak pada ....
A. baris AA kolom 24
B. baris A2 kolom A4
C. baris 24 kolom AA
D. baris A4 kolom A2

Secara default, jumlah lembar kerja pada aplikasi Microsoft Office Excel 2007
adalah ....

Al

B. 3

C.5

D.7

Daftar Charts pada aplikasi Microsoft Office Excel 2007 dapat dilihat pada....
A. tab Home

B. tab Formula

C. tab Insert

D. tab Data

Fasilitas utama aplikasi pengolah angka adalah ....
A. spelling and grammar

B. chart

C. find and replace

D

formula

Fungsi untuk penjumlahan MS Excel2010 adalah....

A. IF
B. SUM
C. AVERAGE
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D. COUNTIF

50. Untuk menentukan nilai berdasarkan kriteria tertentu pada aplikasi Microsoft

Office Excel 2010 digunakan fungsi ....

A. IF

B. SUMIF

C. AVERAGE
D. COUNTIF
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PENUTUP

Perluasan wawasan dan pengetahuan peserta berkenaan dengan substansi materi ini
penting dilakukan, baik melalui kajian buku, jurnal, maupun penerbitan lain yang relevan.
Disamping itu, penggunaan sarana perpustakaan, media internet, serta sumber belajar
lainnya merupakan wahana yang efektif bagi upaya perluasan tersebut. Demikian pula
dengan berbagai kasus yang muncul dalam penyelenggaraan pendidikan khusus, baik
berdasarkan hasil pengamatan maupun dialog dengan praktisi pendidikan khusus, akan

semakin memperkaya wawasan dan pengetahuan para peserta diklat.

Dalam tataran praktis, mengimplementasikan berbagai pengetahuan dan keterampilan
yang diperoleh setelah mempelajari modul ini, penting dan mendesak untuk dilakukan.
Melalui langkah ini, kebermaknaan materi yang dipelajari akan sangat dirasakan oleh
peserta diklat. Disamping itu, tahapan penguasaan kompetensi peserta diklat sebagai
guru anak autis, secara bertahap dapat diperoleh.

Pada akhirnya, keberhasilan peserta dalam mempelajari modul ini tergantung pada
tinggi rendahnya motivasi dan komitmen peserta dalam mempelajari dan mempraktekan
materi yang disajikan. Modul ini hanyalah merupakan salah satu bentuk stimulasi bagi
peserta untuk mempelajari lebih lanjut substansi materi yang disajikan serta penguasaan

kompetensi lainnya.

SELAMAT BERKARYA!
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GLOSARIUM

Action Button: adalah tombol navigasi yang berisikan perintah untuk
menghubungkan satu slide dengan slide yang lain.

Active Cell:Posisi sel yang sedang aktif atau dilihat
Active Sheet: Posisi Sheet yang sedang aktif atau dilihat

Alt (Alternate): Tombol yang dapat berfungsi bila ditekan bersamaan dengan

tombol lain, biasanya untuk memilih perintah pada menu

Animation Scheme: fasilitas untuk pengaturan efek-efek animasi dan suara

secara otomatis pada suatu slide berdasarkan skema yang disediakan.

Animation: fasilitas yang dipergunakan untuk memberikan efek animasi dan

suara pada isi slide.

Area kerja : suatu bidang untuk menampilkan dan mengolah tekt, gambar atau

objek lain yang telah dimasukkan atau diproses.
Average Fungsi untuk mencari nilai rata-rata

Backspace Tombol pada keyboard yang berfungsi untuk mengapuskarakter

disebelah kiri pointer atau karakter yang sedangterpilih (blok)

Bullets and Numbering: perintah untuk mengatur penomoran dan penandaan

suatu baris.

Cell Perpotongan antara kolom dengan baris

Cells: isi tabel

Change Case: perintah untuk mengatur kapitalisasi tekt.
Chart Fasilitas untuk membuat grafik

Chart Type Jenis grafik

Columns: kolom-kolom pada tabel

Copy: perintah untuk menggandakan isi dari dokumen
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Cursor Penunjuk atau indikator posisi pada monitor yangdioperasikan

menggunakan mouse/touchpad
Cut: perintah untuk memotong isi dari dokumen

Delete Tombol pada keyboard yang berfungsi menghapus 1 karakter huruf

sebelah kanan kursor

Design Templates: fasilitas untuk merubah tampilan pada suatu slide dengan

template-template yang ada.
Desktop Tampilan utama pada sistem opereasi windows

Drag: salah satu perintah pada mouse untuk memilih dan menggeser suatu

objek tertentu.

Drive lIstilah penamaan ruang-ruang dalam mediapenyimpanan
Enter Tombol pada keyboard untuk melakukan proses ataumasuk
ESC (escape) Tombol pada keyboard untuk melakukan pembatalan

Excel Aplikasi untuk mengolah baris dan kolom yang dilengkapi fitur

perhitungan, rumus, penyajian data dan grafik.
Exit Perintah untuk keluar dari aplikasi yang sedang dibuka
File Name Nama file

Folder lIstilah suatu wadah/tempat untukmenyimpan/mengelompokan file atau

foler lagi
Font Huruf
Font: perintah untuk mengatur huruf yang digunakan

Format(pada penyimpanan) Perintah untuk membentuk sectorpada disket atau

harddisk sehingga dapat digunakanuntuk menyimpan data

Format Cells Fasilitas untuk melakukan perubahan format pada excel
Formula Bar Bagian dari excel yang mencantumkan isi dari sel aktif
Formula Rumus yang berisi fungsi dengan ketentuanpenggunaannya
Function Perintah untuk melakukan suatu proses dan membentukFormula

PPPPTK TK DAN PLB BANDUNG
© 2016



General Public Licence (GPL) : software yang dapat dikopi secara bebas tanpa

harus membayar kepada pemegang lisensi, dengan catatan source code harus
selalu disertakan dalam penyebarannya.

Harddisk Media penyimpanan yang berupa disk dengan kapasitas yang besar
Hardware Perangkat keras penunjang sistem komputer
Icon (ikon) : simbol-simbol berisi perintah tertentu yang terdapat pada toolbar.

Insert Sisipan; salah satu tab menu yang berisi fasilitas untuk melakukan

penyisipan
Install Memasang perangkat lunak pada sistem operasi
Kapitalisasi: besar atau kecilnya huruf yang digunakan

Kernel: Bagian dari sistem operasi yang bertugas untuk melakukan tugas-tugas

inti dan umum.

Keyboard Sebuah alat input yang mengkonversi huruf, angka, dan karakter lain

menjadi sinyal digital yang dapat dibaca oleh processor
Laserjet Salah satu jenis printer yang menggunakan teknik menaburkan serbuk

Link Merupakan teks di dalam halaman web yang dapat diklik dan menuju ke

halaman lainnya

Macintosh (Mac) Salah satu jenis komputer personal yang dikembangkan oleh

Apple
Margin Jarak antara tepi pengetikan dengan tepi halaman kertas

Memory Kata lain dari RAM; merupakan bagian dari computer yang berfungsi

sebagai tempat penyimpanan informasi yang harus diatur

Menu Bar : papan yang menampung menu File, Edit, View, Insert, Format,

Tools, Table, Window, dan Help.

Menu bar Merupakan elemen kontrol berbentuk graphis (gambar) yang berisi

drop down menu
Merge Cells Menggabungkan beberapa sel

Minimize Tombol untuk menyimpan aplikasi aktif ke dalam taskbar
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Minimum Salah satu fungsi untuk mencatri nilai terendah/terkecil

Mobile Istilah suatu perangkat yang dapat dibawa kemana saja dengan mudah

Mouse Sebuah alat input yang digunakan untuk memanipulasi objek yang

terlihat pada layar computer

Multimedia Menggunaan komputer untuk menyajikan dan menggabungkan teks,

suara, gambar, animasi dan video

Multi-tasking Operating System : sistem operasi yang dapat digunakan untuk
menjalankan beberapa aplikasi secara simultan pada waktu yang bersamaan.

New folder Fasilitas/perintah untuk membuat folder baru
New Menu untuk membuat dokumen baru

New tab Halaman baru untuk membuka halaman web di dalam jendela yang

sama.

New window Halaman baru untuk membuka halaman web di dalam jendela

yang berbeda.

Number Berupa nilai/angka

Page Setup Fasilitas untuk melakukan konfigurasi dokumen
Paragraph: perintah untuk mengatur suatu paragraf

Paste: perintah untuk memunculkan dan menempatkan objek hasil pemotongan

(cut) atau penggandaan (copy)

PC Personal Computer; istilah untuk komputer desktop (adaCPU-monitor-

keyboard-mouse yang terpisan dan terhubung melalui kabel)

Powerpoint Aplikasi untuk membuat dan menyajikan presentasi yang dilengkapi

dengan fitur pemformatan presentasi, template dan animasi
Printer Perangkat output yang memiliki fungsi mencetak berkas

Prosessor Pusat pengendali komputer yang didukung dengankomponen-

komponen lain

Quick Access toolbar Bar yang berisi ikon-ikon yang sering digunakan
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e RAM Random Access Memory; merupakan sebuah perangkat keras komputer

yang berfungsi sebagai tempat penyimpanan data sementara
e Range Beberapa sel yang terpilih

e Recycle Bin: satu folder untuk penyimpanan sementara file-file yang telah
dihapus.

e Rename Mengganti nama file/folder

¢ Ribbon Adalah kontrol baru yang mengganti penggunaan menu dan toolbar
e Row Number Daftar penamaan kolom

e Rows: baris pada tabel

e Save As Melakukan penyimpanan dengan nhama yang berbeda

e Save Melakukan penyimpanan

e Screen Media yang digunakan untuk menampilkan hasil keluaran

e Scroll Bars Tombol untuk menggulung layar ke atas dan ke bawah (vertikal)

juga ke kiri dan ke kanan (horizontal)

e Scrool Bagian dari mouse yang berupa roda; menggulung tampilan vertikal-

horizontal

e Search Engine Sebuah situs di dalam internet yang digunakan untuk mencari

suatu informasi tertentu

e Send Sebuah layanan pada e-mail yang berfungsi untuk melakukan pengiriman

e-mail yang telah dibuat

e Shortcut Jalan pintas; fasilitas yang disediakan oleh windows berupa ikon untuk

mengakses file/folder secara cepat

e Shortkey Tombol pintas dari suatu fasilitas dengan menekan tombol pada

keyboard
e Slide Area Tempat untuk bekerja dalam mengolah isi slidepresentasi.

e Slide Istilah dokumen pada power point yang berupalembaran-lemaran dokumen

yang akan diproyeksikan

|| PPPPTK TK DAN PLB BANDUNG
© 2016




Slide Transition: fasilitas yang digunakan untuk memberikan efek animasi pada

saat perpindahan slide.

Software Perangkat lunak yang berfungsi sebagai sarana interaksipengguna

dengan komputer
Spacebar Menambahkan spasi

Start menu lkon menu awal berisi semua program yang sudah terpasang

dikomputer
Statistical Salah satu kategory dari fungsi di excel

Status Bar Bagian yang menampilkan informasi standar mengenai dokumen

yang aktif

Storage Perangkat yang menyimpan data, program atau output untuk digunakan

lebih lanjut
Tab Tombol pada keyboard yang berfungsi untum memberi tabulasi/jarak

Taskbar Bar (batang) horizontal yang terdapat pada tepi bawah (setingan
standar) desktop yang fungsinya untuk memulai (menjalankan) dan memonitor

atau mengatur aplikasi desktop yang sedang berjalan
Text Box Berupa sebuah kotak yang dapat disisipkan teks di dalamnya
Theme Suatu tata letak yang telah ditentukan/disediakan sebelumnya

Title Bar : papan baris yang terletak di bagian paling berisi nama dokumen,

nama program (Microsoft Word) dan tombol Minimaze, Restore, serta Close.
Toolbar : suatu papan yang berisi perintah atau ikon-ikon tertentu.

Tools Peralatan berupa ikon

Transitions Efek pada power point berupa pergerakan antar slide

Unix Salah satu sistem operasi

User Istilah dari pengguna dari computer

Value Nilai

View Bar Berisi tombol untuk mengatur besar kecilnya tampilan Slide.
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e View Fasilitas untuk merubah tampilan atau melihat dalam tampilan lain

e Windows Explorer Fasilitas pada sistem operasi Windows yang berfungsi untuk

mengelola file dan folder
e Windows Salah satu sistem operasi

e Word Aplikasi untuk mengolah kata yang dilengkapi dengan fitur untuk

pemformatan kata.

e WordArt: fasilitas yang digunakan untuk membuat suatu tekt dengan tampilan
yang berbeda dan lebih indah daripada tekt biasa.

e Workbook Lembar kerja pada excel
e Workspace Area untuk mengolah teks pada Ms. Word

e Wrap Text Menggulung teks apabila lebar sel tidak mencukupi
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